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END USER LICENSE AGREEMENT [EULA]

Falcon (henceforth ‘the Product’) is licensed to you as
the end user. Please read this agreement carefully. You
cannot transfer ownership of these sounds and software
they contain. You cannot re-sell or copy the Product.

LICENSE AND PROTECTION

1. LICENSE GRANT

UVI grants to you, subject to the following terms and
conditions, a non-exclusive, non-transferable right to use
each authorized copy of the Product.

The product is the property of UVI and is licensed to
you only for use as part of a musical performance, live or
recorded. This license expressly forbids resale or other
distribution of the sounds and software included in the
Product or their derivatives, either as they exist on disc,
reformatted for use in another digital sampler, or mixed,
combined, filtered, resynthesized or otherwise edited,
for use as sounds, multi-sounds, samples, multi-samples,
wavetables, programs or patches in a sampler, microchip
or any hardware or software sample playback device.
You cannot sell the Product content or give it away for
use by others in their sampling or sample playback
devices. In the event UVI terminates this agreement due
to your breach, you agree to return the original and all
other copies of the software and documentation to UVI.
UVI reserves all rights not expressly granted to herein.

2. PROTECTION OF SOFTWARE

You agree to take all reasonable steps to protect the
product and any accompanying documentation from
unauthorized copying or use. You agree not to modify
the product to circumvent any method or means adopted
or implemented by UVI to protect against or discourage
the unlicensed use of copying of the Product.

3. OWNERSHIP

As between you and UVI, ownership of, and title to, the
enclosed digitally recorded sounds (including any copies)
are held by UVI. Copies are provided to you only to
enable you to exercise your rights under the license.

4. TERM

This agreement is effective from the date you open this
package, and will remain in full force until termination.
This agreement will terminate if you break any of the
terms or conditions of this agreement. Upon termination
you agree to destroy and return to UVI all copies of this
product and accompanying documentation.

5. RESTRICTIONS

Except as expressly authorized in this agreement, you
may not rent, sell, lease, sub-license, distribute, transfer,
copy, reproduce, display, modify or time share the
enclosed product or documentation.

6. HARDWARE

Accompanying USB flash media is only guaranteed

in it’s original state, as an installation medium for the
Product. Any variance from this use including but not
limited to deleting, altering or adding data, reformatting
the media or any physical alteration of the device will
void its warranty. If the media is found to have a physical
or manufacturing defect please contact our support
department (http://www.uvi.net/contact-support).

©2016 UVI. All rights reserved. All trademarks are the
property of their respective owners.


http://www.uvi.net/contact-support
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FALCON

Falcon is multi-timbral hybrid instrument, bringing together an extensive collection of
oscillators, effects, modulators and event processors and delivering them in a workflow-
adaptive and highly-scriptable environment.

SYNTHESIS

Falcon offers 15 highly-optimized oscillators covering the spectrum of modern sampling
and synthesis techniques. Sample-based oscillators include IRCAM Granular, IRCAM Multi
Granular, IRCAM Scrub, IRCAM Stretch, Sample, Slice and Stretch. Synthesis oscillators
include Analog, Analog Stack, Drum, FM, Noise, Organ, Pluck and Wavetable.

EFFECTS

Over 80 high-quality effects are at your disposal, categorized for easy navigation: Delays,
Reverbs, Modulation, Filters, Equalizers, Amps and Stereo, Drive and Distortions, Dynamics,
Analysis and more. UVI’s rich heritage of effect design is in full force with sophisticated
delays, versatile reverbs (including the Sparkverb algorithm and a CPU-optimized
convolution reverb), compressors, vinyl, reamping effects and more. Add effects at the patch
level, as sends or even per note.

MODULATION

Rich sound means motion and Falcon can create it
whenever and however you need it. AHD, Analog
ADSR, Attack Decay, DAHDSR, Drunk, LFO, Multi
Envelope and Step Envelope modulation generators
all come standard and cv in the Falcon environment.
Create variation over time or on demand, drive your
oscillators, effects or even other modulators, then
add the most important parameters to the macro
panel for clear and intuitive performance control.

EVENTS

Falcon’s Event processors provide control and
analysis of the pre-synthesis phase of your sound,
from manipulating incoming MIDI data to creating

it algorithmically. Utilize factory processors such as
an advanced Arpeggiator, Micro Tuner, Chorder,
Harmonizer, Strum simulator, MIDI Player, Unison
and Shepard effects, or code your own from scratch
with the powerful Lua scripting language.

INTERFACE

From editing at the component level to mixing

and realtime performance of multiple instruments,
Falcon’s interface was designed to be both
ergonomic and adaptable. Due to the nature

of instrument design and interactive music
performance, projects can quickly become large
and multifaceted. Falcon’s Ul was structured to help
mitigate that complexity and allow you to quickly
focus regardless of the level of detail.

PERFORMANCE

Falcon was designed with a rich performance
toolset including full Open Sound Control (OSC)
implementation, host automation, flexible MIDI and
audio routing, MIDI learn, key range and velocity
range controls, keyswitching and more. Whether
you're working with a single instrument or an
ensemble, in a DAW or standalone, Falcon gives
you the control you need to create dynamic and
captivating performances.

SOUNDS

Falcon comes with an incredible collection of
presets created by some of the world’s most
recognized sound designers, but there’s much
more to discover. Falcon is fully-compatible with all
UVI and UVI-Powered soundbanks, opening up a
world of over 200 instruments from a growing list of
companies like AcousticSamples, GospelMusicians,
VI Labs and VirHarmonics.

SCRIPTING

Falcon implements custom scripts throughout its
architecture allowing you to create everything
from custom Event processors to professional-
level skinned instruments with the powerful and
lightweight Lua scripting language. Don’t know
anything about scripting? Don’t worry, Falcon has
a built-in visual editor for creating fully customized
macro-driven interfaces.
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COMPATIBILITY
« Audio Unit

. VST

« AAX

- Stand Alone

MINIMUM SYSTEM REQUIREMENTS
+ Intel CPU

« 2 GB of RAM+

. 1GB of Disk Space

- MAC OS X 10.7+

« Lok Account (Free)

WINDOWS

COMPATIBILITY
. VST

. AAX

- Stand Alone

MINIMUM SYSTEM REQUIREMENTS
» Core 2 Duo or faster

« 2 GB of RAM+

. 1GB of Disk Space

- Windows 7+

« Lok Account (Free)

LICENSE

AUTHORIZATION

Your license allows for unlimited installation and up to 3
concurrent authorizations of Falcon on any combination
of computer hard drives or iLok dongles.

MANAGEMENT

License management is a simple drag-and-drop process
done through the free iLok License Manager client app.
Visit iLok.com to download the latest version or sign up
for a free account.


http://www.ilok.com
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CHANGE LOG

FALCON 1.1.0

- add Thorus: A new Chorus FX with up to 8 voices

- add Sample controls (start, detune, key follow), Noise sustain and
Stereo control to Pluck oscillator

- add phase and different oscillator tuning controls in FM oscillator
- add M/S Maximizer in Effect Rack presets

- add Fuzz4 in Effect Rack presets

- add script for MPE devices (LinnStrument, Roli Seabord, ...)

- add Copy/paste from clipboard for module preset in module menu to
easily copy FX settings among instances

- CPU improvements in some FXs

- fix regression with Double Drive and UVI Drive introduced in 1.0.7
- fix possible crash when loading IR in Convolver or IR Reverb

- fixes in MicroTuner

- fix issue related to sample markers when changing oscillator type
- Effect Rack is now featured in its own folder in Modules tree

- fix crash when receiving a very large amount of MIDI events

- allow to disable label or macro value display by right clicking on it in
Edit mode

- fix Offset reload in Editon mode matrix mod connections

- other minor fixes

FALCON 1.0.7

- fix regression with legato multi point envelope introduced in 1.0.4

- fix issue with Guitar Boxes under Reaper

- allow edit of oscillators in multi selection

- fix possible crash when deleting mapper

- fix noise when activating filters in UVI Drive and Double Drive

- fix crash when adding Granular oscillator using Tree view

- fix crash when adding MIDI player in Edit view

- fix sample start handling in Sample oscillator

- allows right click on module tab to change their type (similar to long
press behavior)

- fix potential crash in script processor when launching lots (100000+) of
asynchronous commands

- fix possible issue with Mono Retrigger mode

- rotary FX improvements

- fix for scala keyboard mapping (.kbm) with O size

FALCON 1.0.6

- fix crash in script in case of script errors

- add free running option for each oscillator in Analog Stack (see
Inspector)

- fix possible crash with selection and edit all oscillator function

- smoothed random LFO do not smooth the first outputed random value
- fix modulation handling on Drunk initial value

- fix regression in forward xfaded loop introduced in previous build

- fix possible stucked notes with scripted instrument in Digital Performer
- fix possible issue in Analog ADSR with very small attack time

FALCON 1.0.5

- fix regression introduced in 1.0.4 with some scripts
- fix potential crash in xfade + alternate sample loops
- optimize patch encoding

FALCON 1.0.4

- fix speed modulation on multi point envelope

- allow to duplicate Oscillators, FX and EventProcessors by pressing Alt
key when Drag’n’droping their module name

- fix S&H LFO with null speed

FALCON 1.0.3

- allow to set omni on only one MIDI port

- fix batch oscillator type changes with custom start/stop markers
- fix regression regarding sample loading/purge in scripts

- add Pre/Post insert flag on auxes

- fix graphic issue on OSX pre 10.11

FALCON 1.0.2

- fix possible issue with cross-faded alternate looping in Sample
oscillator

- WavekEditor sample auditioning now work like a play/stop toggle

- add Reveal in Explorer/Finder in treeview browser

- remember last Audio Config in Standalone app

- allow to change the default VST AudioConfig for VST Hosts that don’t
implement setSpeakerArrangement

- allow using return key to go back to parent folder in right-panel
browser

- fix potential crash when dragging stuff on the keygroup mapping view
when collapsed.

- fix issue with non Latin character in MIDI panel on OSX

- fix possible crashes in rare cases when connecting modulation

- allow to duplicate a Part using right click menu on it

- add new Script Event Modulation module which allows polyphonic
script driven modulation source

- improve randomness in noise oscillator

- allow to modulate Layer glide time

- add an offset to connection in edition mode (Macro and MIDI learn) as
well as support for mappers

- add sorting to key and velocity columns in Keygroups list

- Chaos LFO waveforms now handle Phase parameter

- add Stereo switch in Noise oscillator

- fix brown noise volume issue

- toggling shift key while moving loop points will move both points
accordingly to the loop length

- fix automation names in AAX when assigning automations

- fix tempo update in Slice oscillator when changing bar/beat settings

FALCON 1.01

- fix right-column file browser scrollbar visibility when the tree width
becomes larger than the available size

- better auto naming behavior when binding macros to host automation
slots: the host automation name now uses the macro display name

- allow manual renaming of host automation slots

- add Legato mode in IRCAM Stretch allowing to start new voices at the
position of currently playing voices. Similar to Legato in regular stretch.
- fix tie mode in arpeggiator in special case

- added master gain parameter to Big Pl Tone

- fix issue with Places

- improved support for different kinds of “wt” file import

- display connected MIDI modulation source in TreeView

- fix potential crash in Multipoint envelope while deleting loop points
while the envelope is running and the loop point is being played.

- added selection indicator in XpanderFilter mode menu

- fix potential crash in IRCAM Multi Granular when using reversed grains
- fix parameter automation display names in AU

- fix TreeView browser state serialization

- fix ratio modulation display

- added support for browsing user wavetables folder located in
$(documents)/UVI/Falcon/User Data/Wavetable/

- added support for browsing pluck user excitations folder located in
$(documents)/UVI/Falcon/User Data/Pluck/

- added support for browsing user Impulse Responses folder located in
$(documents)/UVI/Falcon/User Data/IR/

- allow ‘.’ as note name separator in automatic sample import

- fix issue when trying to modulate Organ Harmonic parameter

- fix potential errors in script processor when using midi port D






@ INSTALLATION » STEP 1: REGISTER YOUR SERIAL NUMBER

REGISTER b acot - @ lemp)

E-mail address

ok o oror o reetetation 1. LOGIN TO YOUR ACCOUNT ON UVI.NET

» Your serial number will be included in Password
a purchase confirmation email

« You can see a list of the products
you’ve registered and their serial
numbers anytime at uvi.net/my-
products

Support I3 Your Username ~ i (empty)

@ My Products

@ Product Registration

2. NAVIGATE TO THE "PRODUCT REGISTRATION" PAGE @ orcer Hstony

o Personal Settings
ST Addresses

:sis in this suite Sign Out

iimard Canuantial

UV e

m Store Soundware Software Artists Support

Home » My Account » Product Registration

3. ENTER YOUR DETAILS AND CLICK ‘REGISTER’ Product Registration

A new license will be deposited in your iLok account Serial Norbar ‘

)
iLok User ID ‘ ‘

X



http://www.uvi.net/
http://www.ilok.com/
http://www.uvi.net/my-products
http://www.uvi.net/my-products

@ INSTALLATION » STEP 2: ACTIVATE YOUR LICENSE

ACTIVATE

. The iLok License Manager client app

is required for activation, download
the newest version at ilok.com

« Your license allows for up to 3

concurrent activations on any
combination of computer hard drives
or iLok dongles

. Activations can be moved between

devices freely, at any time

. To see how many authorizations you

have left simply select the license
in iLok License Manager and click
‘Show Details’

. To deactivate an authorization,

right-click it and select ‘Deactivate’.
This will return the license to the
‘Available’ tab.

LAUNCH [LOK LICENSE MANAGER

LOGIN TO YOUR ACCOUNT

CLICK THE "AVAILABLE" TAB

DRAG THE LICENSE TO A COMPUTER OR ILOK

CLICK “OK™ TO CONFIRM ACTIVATION

Live N iLE-g @

8 00

i L'j K License Manager

800

i Llj K License Manager All Licenses (304]  AvalfRle (1) JAllActivations (261)  Unavailable (42) Q
A

800

i Llj K License Manager All Licenses (304)  Avallable (1)~ All Activations (261)  Unavallable (42) Q

*

i L'j K License Manager

Confirm Activation

You are about to activate 1 license(s) on "UVI iLok (0015F687)". Would
you iie to continue?

Pressing OK will move license usage rights to "UV1 iLok (0015FES7)".

Cano(l 0[

D UVI Computer
g 0 Acivations

mmmn UVIiLok wotsrsaz)
0 Activations

10
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INSTALLATION » STEP 3: INSTALL FALCON

INSTALL

« You can download your products at

any time through uvi.net/my-products

1.~ DOWNLOAD YOUR SOFTWARE AT
UVI.NET/MY-PRODUCTS

2. RUNTHE INSTALLER

SERIAL NUMBER 2 d
i

NFRUVIFC-E380ACD

DOWNLOAD LINKS

.

SERIAL NUMBER
iLo

NFRSC33-DA4CD60B

DOWNLOAD LINKS

.

— Falcon-1.0.0-rc.3

() FALCON

1"


http://www.uvi.net/my-products
http://www.uvi.net/my-products

INSTALLATION » STEP 4: AUDIO & MIDI DEVICES (STAND ALONE

CONFIGURE 1/0

1.~ LAUNCH FALCON

9.

Audio and MIDI Settings... %

If you plan to use Falcon in stand
alone mode you may need to select
which MIDI inputs and Audio outputs

you want Falcon to use. This only 2. SELECT "AUDIO AND MIDI SETTINGS...
needs to be done the first time FROM -l-HE MENU

you launch Falcon, or if you make
changes to your hardware (such
as changing your audio interface

or controller keyboard), as these
settings will be saved and reloaded
the next time you start Falcon. 3

SELECT THE DESIRED AUDIO AND MIDI DEVICES...

If you intend to use Falcon primarily

as a plugin you can skip this step, as ® Audio and MIDI Settings ® Audio and MIDI Settings ® Audio and MIDI Settings
)
Audio Device Routing MIDI Devices Audio Device Routing MIDI Devices Audio Device Routing MIDI Devices

the audio and MIDI settings will be

i XMOS USB 2.0 Audio Out v Main Out Left Analogue 1 Mo Port A
defined by your host DAW. e Porc s
oue 2 Lekt PareC
512 hd Out 2 Right Port D IAC Driver IAC Bus 2 v

oue 3 Lef

T

oue s Lot

T

oues Lefe

T

out 6 Left

T

out 7 Lekt

out 7 ight

oue B Lat

oue 8 Righ

oue s Let

out 9 Righ

g
AUDIO DEVICES ROUTING MIDI DEVICES

Select the desired audio interface, sample rate
and buffer size from the menus. If you don'’t see
your device listed, make sure it’'s powered on
and hit ‘Refresh Audio Devices'’.

Falcon can address up to 17 stereo outputs.
Use this panel to link Falcon’s outputs with
those of your audio interface.

Falcon can listen to 4 MIDI devices. Use this
panel to link Falcon’s inputs with the MIDI
sources available on your system.



INSTALLATION » STEP 5: ADDING SOUNDBANKS (OPTIONAL)

LOAD SOUNDBANKS

UVI Powered soundbanks are high-
quality sound and instrument libraries
available from UVI and third-party
developers. Soundbanks are fully
supported and seamlessly integrated
in Falcon.

To use soundbanks in Falcon you
just need to tell it where to find them.

NOTE: Falcon includes two
soundbanks (Falcon Factory.ufs,
and Falcon Tutorial.ufs), follow these
instructions to make them available
to Falcon.

LAUNCH FALCON

OPEN “PREFERENCES’

CLICK THE "SOUNDBANKS™ PAGE

CLICK THE ... BUTTON AND SELECT
THE FOLDER THAT CONTAINS YOUR
SOUNDBANK (.UFS) FILES

RESTART FALCON, SOUNDBANKS WILL
BE AVAILABLE IN THE BROWSER

9.

Save Program Samples
Preferences [k

Small size
Big size
Fit screen size

Falcon Preferences

General Streaming. SoundBanks 0sC

sssss h path

Volumes/Projects/Sound/Samples/Acousticsamples ¥ ..

/Volumes/Projects/Sound/Samples/ViLabs
/Volumes/Projects/Sound/Samples

L i

: f%

13






(2) STRUCTURE

Structure

N¢ Multi

)

al Modulators J

)
( fx Effects
(
(

71 Events

)

—

File Management

& Multi (.uvim)

——

—

- 4 Part > # Program
[fx Effects J (fx Effects J
(-Ill Modulators J (.nll Modulators J
(J’.l Events J (IJ Events J

& Program (.uvip)

—

—— > ¥ Layer — > ¥ Keygroup
[fx Effects J (fx Effects J
(-Ill Modulators J (.nll Modulators J
(J’.l Events J (J’.l Events J

-------------------- ¥ Oscillators

Contr0|S|gna|F|OW n 'lll 000000000000000000000000000000000000000000000000000000000000000000000000000000000}

Audio Signal Flow e i M

FALCON is a hierarchy of components, structured

so that you can focus on the high-level arrangement

or drill down to deeper levels as you prefer.

Each instance of Falcon contains:
. one MULTI, which contains ...
. one or more PARTS

Each of those PARTS then contains:
. one PROGRAM, which contains ...
. one or more LAYERS, each which contains ...

- one or more KEYGROUPS, each which contains ...

. one or more OSCILLATORS

Each level of this hierarchy has a rich variety of
options for crafting your sound, using:

MODULATION control signals, such as LFOs,
envelopes, and MIDI controllers

AUDIO EFFECTS, such as filters, delays, and reverb
MIDI EVENT PROCESSORS, such as arpeggiators,
micro tuners, and script processors
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INFO EFFECTS
¥ 2 PROGRAM NEW PROGRAM

dB range O
) teas2dn O 131ms

> ®LAvERSS) LAYERT @« ada&
P & KEYGROUP(S) KEYGROUP1 @ fx

¥ A OSCILLATOR(S) (O]
Coarse Fin ! - Note Trigger
() (&) wn (W) 0 (@)
osc [ ek x|+

ms:::um:w:?m Shape o,.....u.. @:;’-
e ® ® @ O @

o
0.00% 013 50.00% 0.00  20,00kHz 20.00dB

MAPPING * Root: €3 Key: C2G3 Vi 1127 Vol: 0.00dB  Pan: Center Fine Tune: 0 Cents
ull MODULATION OSCILLATOR > HARMONIC RATIO

[Pat2 "% ¥ 2 PROGRAM RAVENSCROFT 275 @ fx 1

“ @ -®) — L

FX () sBaNDEQ X () GANMATRIX X (U IREVERE X
EVENT (1) SCRIPTPROCESSOR X 4

¥ ® LAYER(S) REL1 @ fx 7 ah
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OSCILLATORS

One of Falcon’s greatest strengths
is its ability to freely layer
oscillators to create elaborate
hybrid instruments that capitalize
on the unique features of both
sample-based and algorithmic
sound creation. There are no
preset limits on the quantity

or type of oscillators you can
use, you're limited only by your
computers processing power
and imagination.

OSCILLATORS

An oscillator is the basic building block of a Falcon
program. Oscillators generate the initial sound, which
is then modulated, transformed, and combined with
other oscillators into a full program. An oscillator can
be one of two types: synthesis or sampling.

SYNTHESIS

Synthesis oscillators produce purely synthesized
sounds — no audio sample is triggered. The
synthesis oscillators provided are capable of a wide
variety of sounds, from classic virtual analog synths
to drum modeling to string synthesis.

SAMPLING

Sampling oscillators play back an audio sample.
Each of the sampling oscillators is suited for
different types of audio samples and different
playback needs, from traditional pitch and speed
transposition to slicing drum loops to granular pitch
adjustments.

For in-depth details on each oscillator type, see:
[Appendix A > Oscillators]
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MODULATORS

Falcon includes 8 modulation
generators including AHD, Analog
ADSR, Attack Decay, DAHDSR,
Drunk, LFO, Multi Envelope

and Step Envelope. Modulation
generators can be instanced at
any level in a patch allowing them
to control nearly any parameter, be
it on an oscillator, effect or even
on another modulator. This system
allows you to paint motion into
your sounds almost effortlessly,
from subtle variation over time to
complex on-demand sequences.
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A Multi Envelope modulator provides unlimited breakpoints with complex curve control and interpolation options

MODULATORS

Modulators are signal generators that modify a control’s
value. Modulators don’t affect the audio or MIDI signal
directly; rather, they adjust the values of Falcon’s
controls. There are two main categories of modulation
sources: internal and external.

INTERNAL

Internal modulation sources originate from within the
Falcon multi or program. This includes a variety of
different types of envelopes and LFOs, which can be
created at every level of Falcon’s hierarchy: master, part,
program, layer, and keygroup.

Additionally, macros are a special type of internal
modulation. When a control is assigned to a macro, a
macro control appears on the Info tab. When the macro
control is adjusted, so is the control assigned to it. A
control can be assigned one-to-one to @ macro, as a
shortcut for a commonly used control in the program, or
multiple controls can be assigned to a single macro, for
complex transformations of multiple controls by adjusting
a single knob or button.

EXTERNAL

External modulation sources originate beyond the Falcon
instance. External sources include MIDI messages,

such as continuous controllers (CCs), pitch bend,
velocity, aftertouch, and others. Some pre-defined
external sources are also available, such as sources that
randomize or alternate values.

Additionally, when using Falcon as a plug-in, you can
assign a control to be linked to the host program’s
automation controls. Host automation extends Falcon’s
available modulation options by tapping into the host’s
modulation and automation capabilities as well.

For more information on using modulations, see:
[Interface > Main > Modulation Editor]

For in-depth details on each modulation type, see:
[Appendix A > Modulators]

20



COMPONENTS » EVENT PROCESSORS

EVENT PROCESSORS

Falcon’s Event section provides
control over pre-synthesis data,
namely the manipulation, analysis
or generation of MIDI. Event
processors can do anything from
arpeggiating incoming notes or
strumming them like a guitar to
applying micro tunings, playing
back MIDI files or creating
generative sequences.

EVENT PROCESSORS

Event processors are MIDI signal processors.
This includes well-known processors such as
arpeggiators and micro-tuners, to complex,
customized processing with the script processor.

SCRIPT PROCESSORS

Script Processors are a unique subset of Events
Processors which allow Falcon’s functionality to

be extended with the Lua language. Factory Script
Processors include the Chorder, Harmonizer,
Unison, Ensemble and many more. Load any Script
Processor and click the ‘Edit Script’ button to take a
look at how they work. Experiment with modifying
them or write your own, Script Processors provide
both an extremely powerful way to interact with
existing instruments and a sophisticated code-
driven approach to sound design.

For more information on event processors, see:
[Interface > Main > Events Tab]

For in-depth details on each event processor type,
see: [Appendix A > Events]
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An advanced arpeggiator provides deep control over note sequences
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function arpeg(arpId_)
local index = @
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Vel ¥ local beatTime i}
while arpld_ == arpld do
local e = heldNotes [#heldNotes]
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if linked[pos+1].value == true then
stepSize = stepSize + 1
else
break
end
end
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local e_ = {}
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Falcon’s Script Processors provide a powerful way to create your own custom tools
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TOOLBAR

The toolbar is displayed at the top
of the window and is always visible
in Main, Mixer, and Performance
views. Most controls in the toolbar
apply globally to the entire Falcon
instance.

(%) FALCON e Wave Slave
1 p

MAIN MENU

The main toolbar menu contains commands for loading/
saving files and configuring Falcon. The menu is divided
into four sections; details about the commands in each
section can be found on the following:

« [User Presets]

+ [Preferences]

« [Toolbar > Window size]

MULTI MANAGEMENT

The name of the CURRENT MULTI is displayed in the
toolbar. Double-clicking the name will open the multi
File Browser. For more information on loading multis,
see: [User Presets > Multis] and [Interface > Main > File
Browser].

The NEXT MULTI / PREVIOUS MULTI buttons load
the next or previous multi in the same directory as the
current multi. The Next button will also advance into
subdirectories and load the next multi there, if any.

MAIN

MIXER

|

3

PERF

(= TAP 12000 & ® > ' ]
4 5
CHANGING THE VIEW

The MAIN, MIXER, and PERF buttons change the
primary view of the Falcon window. See [Interface >
Main], [Interface > Mixer], and [Interface > Performance]
for more information.

The left and right sidebars can be individually hidden or
shown with the SHOW/HIDE SIDEBAR buttons. The left
sidebar displays the PARTS EDITOR, TREE EDITOR,
and LIST EDITOR; the right sidebar displays the PRESET
BROWSER.

NOTE: The left sidebar is displayed in Main view only. In
Mixer and Performance views, the left sidebar will not be
displayed even if the button is enabled.

TEMPO AND TRANSPORT CONTROLS

Falcon’s current TEMPO is displayed in the toolbar. You
can edit the tempo here as well, from 10 to 400 bpm,
by double-clicking to enter a value or by clicking and
dragging the value up and down. NOTE: When Sync To
Host is enabled, the Tempo cannot be edited manually.
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TOOLBAR

@FALCON P Wave Slave MAIN  MIXER  PERF

If you would like to tap to enter the tempo rather than
typing in a value, use the TAP button. For best results,
tap repeatedly at a consistent tempo.

Enabling SYNC TO HOST will cause Falcon to follow an
external tempo source — the host application’s tempo
when using Falcon as a plug-in inside a host application,
or MIDI Beat Clock when using Falcon as a standalone
application. Additionally, enabling AUTOPLAY will cause
Falcon to play and stop along with the host application.
When using Falcon as a standalone application, the
AutoPlay button is not displayed. For details on part
auto-play, see also [Interface > Main > Parts > Auto Play].

The PLAY and STOP buttons are used to manually start
and stop Falcon’s playback. When AutoPlay is enabled,
the Play and Stop buttons also activate to show the
current state of the host application’s transport.

(mfllm | TAP 12000 & ® ‘ > . { ]
6 71| 8 9
GLOBAL TUNE AND VOLUME

GLOBAL TUNE adjusts the tuning for all parts, using the
A above Middle C as a reference. Global Tune defaults to
440 Hz, and is adjustable from 420 Hz to 460 Hz.

GLOBAL VOLUME adjusts the output volume for the
Main Outs.

WINDOW SIZE

To adjust the size of the Falcon window, open the
Toolbar menu and choose Small size, Big Size, or Fit
screen size.

ki

Preferences
Small size

Big size

Fit screen size
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EDIT » LAYER

8

% LAYER(S)

. cain (™ n "% "poly v

THE LAYER EDITOR
GAIN and PAN set the output level and stereo
placement for the selected layers.

PLAY MODE determines what happens when additional
notes are triggered while another note is held. In POLY
modes, multiple notes can be played at once, in MONO
modes only the last triggered note will be played.

Additionally, with POLY PORTAMENTO or MONO
PORTAMENTO there is a glide from the previous note
to the current one. The duration of the glide is set by
GLIDE TIME. PORTAMENTO MODE chooses whether
the time is always the same (Constant Time), or whether
the time is proportionally longer based on the spread
between the two notes (Proportional Time). In MONO
PORTAMENTO SLIDE mode, the next note always starts
from the pitch of the previous note and glides to the new
pitch, even if the next note is played after the previous
note is released.

UNISON VOICES sets the number of voices triggered
with each note received. When using multiple voices,
the Unison modulation sources (found under External >
Other) can be used to modulate parameters per voice,
such as Keygroup Pitch or Pan, for a dynamic sound.

3

@ fx 11 J4l

£

Constant Lt 1 0 W il

CUSTOM POLYPHONY sets the maximum polyphony
for the layer. A setting of zero is a special value that
indicates that there is no layer-specific limit.

The VELOCITY CURVE sets the mapping of incoming

velocity values. The default is NORMAL (1:1 mapping).

To change the velocity curve, right-click and choose one

of the presets:

- CONSTANT: The same velocity is always triggered,
regardless of the incoming velocity. To set the value,
double-click and enter a velocity value.

- MAX: A constant velocity of 127

- HARD: Remapped so that higher velocities are triggered
NORMAL: Default, 1:1 mapping

- SOFT: Remapped so that lower velocities are triggered

The curve displays incoming velocities on the X axis,

and triggered velocities on VY. For finer adjustment of the

velocity curve, hold the Shift key and drag the curve up

or down. You can also double-click and enter a value:

- Values between -1 and zero cover the range between the
Hard and Normal presets

» Values between zero and +1 cover the range between
the Normal and Soft presets

- Values between +1 and 127 set a constant velocity
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INTERFACE » MAIN» EDIT » KEYGROUP

S KEYGROUP(S)
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THE KEYGROUP EDITOR
GAIN and PAN set the output level and stereo
placement for the selected keygroups.

TRIGGER MODE determines what event triggers the
keygroup to play back:

ON: Keygroup is triggered by note on; this is the default.
OFF: Keygroup is triggered by note off.

- OFF + E: Keygroup is triggered by note off, and the

current level of the amplitude envelope will be used as
the initial amplitude.

OFF + V: Keygroup is triggered by note off, and the note
off velocity will be used as the initial amplitude.

OFF + VE: Keygroup is triggered by note off, and both
note-off velocity and the amplitude envelope will be
applied to determine the initial amplitude.

Off + E, Off + V, and Off + VE modes are helpful for
matching the amplitude of a release sample with the
samples that preceded it.

TRIGGER SYNC determines how the keygroup is played
back once triggered:

IMMEDIATE: The keygroup is triggered immediately
NEXT BEAT: The keygroup is triggered at the beginning
of the next full beat

@ fx llll

Immediate ® crome

« NEXT BAR: The keygroup is triggered at the beginning
of the next full bar

The Next Beat/Bar options are useful when triggering
keygroups with tempo-synced effects such as
arpeggiators, or a keygroup containing a tempo-synced
loop.

The EXCLUSIVE GROUP is a way of indicating
keygroups which should be mutually exclusive. The
classic use case is a group of hi-hat sounds, where a
closed hi-hat should cutoff any open hi-hat sounds.
There are 32 separate exclusive groups available per
layer. A setting of zero is a special value that indicates no
exclusive group assignment.

When LATCH is enabled, notes are held (or “latched on”)
indefinitely when they are triggered; to release the note,
play the same note again.
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EDIT » OSCILLATOR
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THE OSCILLATOR EDITOR

A keygroup contains one or more oscillators. With EDIT
ALL OSCILLATORS enabled, the parameters described
below will be edited simultaneously for all oscillators in
the keygroup. To edit each oscillator individually, disable
Edit All Oscillators and select the desired oscillator tab.

The COARSE TUNE and FINE TUNE controls set the
oscillator’s pitch in semitones and cents. These controls
are for static adjustments, and cannot be modulated.
The PITCH control, however, can be modulated, and is
adjustable over a wide range (¥4 octaves). Typical usage
might be: FINE TUNE to pitch-correct a sample that’s
slightly out of tune, COARSE TUNE to shift the pitch a
few keys up or down the keyboard, PITCH to modulate
the oscillator’s pitch with an LFO or envelope

GAIN and sets the output level for the selected
keygroups.

NOTE TRACKING determines how incoming notes are
transposed. At 100%, each note is transposed relative
to the root key 1:1. At 200%, transposition is double; for
example, if the root key is G4 and an G#4 is played, the
note will be transposed as if an A4 was played.

) e v

Default -

Negative values invert the transposition; for example, if
the root key is G4 and a G#4 is played, at -200% the note
will be transposed as if an F4 was played. For a constant
pitch regardless of the note triggered, use 0%.

If there are multiple oscillators in the keygroup, the

TRIGGER MODE chooses which will be triggered:

« ALL: All oscillators in the keygroup are triggered
simultaneously with every note.

« CYCLE: Oscillators are triggered individually, “round
robin” style. The first oscillator will be triggered on the
first note, the second oscillator with the second note, and
so on, always in the same order. With oscillators A, B,
and C, the order will always be A-B-C, A-B-C, etc.

- RANDOM CYCLE: Same as Cycle, but the order is
randomized within each cycle. Each oscillator will always
be triggered once per cycle. Additionally, the first note
of a cycle will never be the same as the last note of the
previous cycle, so there won'’t be any direct repeats. With
oscillators A, B, and C, the order might be B-A-C, A-C-B,
then C-B-A.

- RANDOM: One random oscillator is triggered
individually. With oscillators A, B, and C, the order might
be A-C-C-B-A-B-B-C-A.
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EDIT » MAPPING
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THE MAPPING EDITOR

The Mapping Editor displays the arrangement of the
program’s layers and keygroups. Programs can contain
anywhere from a single keygroup in a single layer
assigned to the entire key range and velocity range,
to many layers each with dozens of keygroups that are
assigned to very small ranges.

Above the piano keyboard, the key range is displayed

horizontally and the velocity range is displayed vertically.

Each keygroup appears as a block covering its key and
velocity range. When a program has multiple layers, the
layers are stacked on top of each other.

Pressing a key on the piano keyboard will trigger the
note; if a keygroup is assigned to that key, it will be
played back. Higher velocities are triggered by pressing
the key closer to the bottom; lower velocities are
triggered by pressing close to the top.

To view the mapping area in greater detail, zoom in or
out horizontally using the + and - buttons in the lower
right, or resize it vertically by dragging the Mapping
Editor toolbar up or down.

0.00dB

Center

0 Cents

WR2-2315-G3.wav

To adjust a keygroup’s key range or velocity range,
select the keygroup then click and drag any edge.

Hold the Command key (Mac) or Control key (Windows)
before you start dragging the keygroup edge to fade the
key or velocity range. The beginning of the fade will be
indicated by a dashed line within the keygroup.

The toolbar above the mapping area displays details

for the selected keygroup, such as its root key, key
range, velocity range, and more. These fields can all be
edited in the usual manner: double-clicking to enter text,
scrolling, and so on. You can also select and edit multiple
keygroups at once.

Additional commands are available under the menu,
available by pressing the menu button towards the left
end of the toolbar. TIP: The same menu is also available
by right-clicking in the mapping editor.
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There are two additional options for helping navigate the Sample Drag'n'Drop
mapping editor: HIGHLIGHT PLAYED KEYGROUPS, Mapping method Destination
and MIDI SELECT. These options can be toggled on White Keys v  New layer v

or off with the buttons at the right end of the toolbar.
When Highlight played keygroups is enabled, keygroups
are visually highlighted as they are triggered. With MIDI
select enabled, keygroups are selected as they are
triggered.

map samples on white keys

Additionally, if you hold the Alt/Option key while dragging
in samples, a custom import dialog is displayed. Choose
the MAPPING METHOD, such as “NOTE NAME” or
“BLACK KEYS”, many of which determine details about
the sample from its file name or other metadata. The
selected mapping method displays a description with
details about how it will determine each file’s assignment.
The layer for the imported samples is chosen with

the DESTINATION LAYER selector. Samples can be
imported to one of the existing layers, or to a new layer.

To edit a keygroup, select one or more keygroups
then right-click to display a contextual menu of editing
commands (described below).

IMPORTING SAMPLES AS KEYGROUPS

Samples can be easily imported as keygroups by drag
and drop from the sidebar browser or your desktop.
You can drag a single sample, or multiple samples at
once. The vertical placement of the sample as you drop
it is a quick shortcut for the new keygroup’s key range
assignment — the closer you drop the sample to the top
of the velocity range, the larger key range the keygroup
will span.
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Undo: Samples Drag'n'Drop
Redo

Duplicate Selected Keygroup
Cut Selected Keygroup

Copy Selected Keygroup
Paste Keygroup

Apply Keygroup Template
Delete Selected Keygroup
Paste Keygroup to

Move Keygroup to

Select All
Deselect All
Invert Selection

Create Keygroup
Create Keygroup in New Layer

Extend Left

Extend Right

Extend Top

Extend Bottom

Auto Fade overlapped keygroups
Auto Extend Key Ranges

Auto Extend Velocity Ranges

Auto Reduce Key Ranges

Resolve Overlapping Key Range
Resolve Overlapping Velocity Range

Move Keygroup To Front
Move Keygroup To Back

Edit Layer Rules

Set Keygroup name as sample name
Find missing samples
Select missing samples




@

INTERFACE » MAIN» EDIT » MAPPING

EDIT » MAPPING

EDITING KEYGROUP RANGES

The EXTEND commands extend the keygroup’s range

in the chosen direction (right, left, top, or bottom) until
another keygroup boundary is encountered, or it reaches
the maximum value. The Auto Extend options are similar,
but extend in both directions: left and right for AUTO
EXTEND KEY RANGES, or top and bottom for AUTO
EXTEND VELOCITY RANGES. A keygroup can also be
reduced to only its root key, with AUTO REDUCE KEY
RANGES.

For keygroups that overlap keys or velocities, choose
RESOLVE OVERLAPPING KEY RANGE or Resolve
Overlapping Velocity Range to adjust the ranges of
the keygroups so they no longer overlap. Alternatively,
the ranges of the keygroups can remain the same, but
key or velocity fades can be applied with AUTO FADE
OVERLAPPED KEYGROUPS.

If you would like to simply change which keygroup is
displayed on top of the other, without adjusting their fade
or ranges, choose MOVE KEYGROUP TO FRONT or
MOVE KEYGROUP TO BACK.

KEYGROUP SAMPLES
For keygroups with sampling oscillators, it can be helpful
to use the SET KEYGROUP NAME AS SAMPLE NAME

command to give the keygroups more meaningful names.

If a program’s samples can’t be located, the samples will
be marked as missing. SELECT MISSING SAMPLES

will select any keygroup that contains an oscillator with

a missing sample; FIND MISSING SAMPLES checks for
missing samples and displays an error window listing any
missing files. From there, you can choose to ignore the
missing samples, or open the file browser to locate them.

LAYER RULES

Layer Rules provide a way to Move Keygroup To Back
dynamically change how a Edit Layer Rules

program’s layers are triggered. Set Keygroup name as sample name

Find missing samples

For example, you might want e

to switch between legato and

stacatto articulations, or cycle through multiple variations
of the same note to provide a more realistic performance.
Choose EDIT LAYER RULES from the Mapping Editor’s
menu to open the Layer Rules Editor.

The rules are displayed on the left, and a list of layers is
displayed on the right. First, right-click and add a ROOT
RULE. Next, right-click and add a SUB-RULE, one for
each layer or group of layers that you would like to be
affected by the rule. Then select each sub-rule, and
choose the desired layers from the list of target layers on
the right.

Now choose a RULE TYPE for the root rule, such as
Key Switch. Each sub-rule can now be assigned to the
specific criteria which will trigger that layer. For example,
with a Key Switch rule and two sub-rules, the first sub-
rule might be assigned to CO and the second to DO.

The rule types are:
Key Switch, Pitch Bend, Speed, Note Duration, Cycle,
Random, Legato, Random Cycle, MIDI CC

Sub-rules can be added to sub-rules, to create further
branches in the layer triggering logic.

TIP: Falcon’s Script Processor module can also be used

to dynamically change playback styles. For more details,
see [Appendix B: Scripting in Lual.
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THE MODULATION EDITOR

The Modulation Editor displays modulation assignments
and sources and is the central location for editing
modulation generators.

When you select a parameter, the node and name of
the parameter is displayed in the Modulation Editor.
For example, when the layer gain knob is selected, the
Modulation Editor displays “Layer > Volume”.

The top half of the Modulation Editor displays any
MODULATION ASSIGNMENTS for the selected
parameter.

The bottom half of the panel displays a MODULATION
SOURCE EDITOR for the selected modulation source.

The modulation source editor can be shown or hidden
with the button on the right side of the Modulation Editor
header.

UNDERSTANDING MODULATION SOURCES
A modulation source generates a control signal that is
used to modify other controls — on its own, it doesn’t

all —
S5UB: Mone
Default -

Vel = Attack I Dynamic Trigger Mode

Vel = Decay | Velocity 1 Retrigger ¥

Key = Attack |

Trigger
Key = Decay | 20.00 dB 99

directly affect Falcon’s output. A modulation source
must be assigned to modulate another control to have
an effect. The location in Falcon’s hierarchy where you
create the modulation source determines its availability
as an assignment choice.

Modulation data flows from the top (Master level), down
through Part, Program, Layer and Keygroup levels to the
bottom (Oscillators). Therefor, a modulation generator
instanced at the Master level can target any parameter
within a given Falcon instance, and conversely a
modulation generator instanced at the Keygroup level
can only see target parameters within its own Keygroup.

NOTE: Master and part modulation sources aren’t
recommended to be assigned to program, layer, or
keygroup controls as programs can be saved and
recalled separately from the containing multi, and could
result in missing modulation sources. If you work with any
modules instanced above the Program level make sure
that you save your work as a Multi (.uvim) file in order to
maintain the integrity of your patch. For more information
on signal flow in Falcon see [Structure].
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MODULATION ASSIGNMENTS

A parameter can have any number of modulation
assignments. Each assignment can be enabled or
disabled with the POWER button on the left of the tab,
or deleted with the X button on the right of the tab.

Each assignment displays the node, name, and type of
the modulation source. For example, with a keygroup
DAHDSR envelope named “Amp. Env,” the assignment
will display “Keygroup > Amp. Env [DAHDSR]". To choose
a different modulation source for the assignment, press
and hold on the name and choose a different source
from the menu.

The amount that the modulation source will affect the
parameter is set by the RATIO slider. The range is
displayed as +1 to -1 for most parameters, which can also
be thought of as +100% and -100%. For pitch-related
parameters, the range is +48 to -48 semitones.

8 9
l all
| & SUB: None —1 §
| suB: MIDI CC 1 ]
| SUB: Mone
=0 Matural Vibrate -
Depth Delay Rise Smiooth
- - . Bipolar Tligger Maode .
egato
1.00 50.5 ms 2.05s 0s

To further adjust the range, you can toggle INVERT to

8
flip the range, or make detailed, custom shapes with the
MODULATION MAPPER EDITOR.

) Each modulation source also has a SUB-MODULATION

source that modulations the depth of the primary
modulation source signal. The sub-modulation source
can be enabled/disabled, removed, replaced, and its
ratio edited the same as for the primary modulation
source. One example would be an LFO assigned to an
oscillator’s pitch for vibrato, and the mod wheel assigned
as a subsource; the mod wheel would then be used to
dynamically set the depth of the vibrato.
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MODULATION MAPPER EDITOR

The modulation mapper editor sits between the
modulation source and the parameter that it’s
modulating, remapping the values of the control
signal according to the mapper shape.

13

14
When no mapper is chosen, the modulation source

is mapped to parameter with a basic 1.1 relationship,
visualized as a linear ramp from the lowest value
to the highest value.
_ 15
To enable a mapper, choose an existing mapper from the
MAPPER SELECTOR MENU or press the ADD button to
create a new one. You can also LOAD and SAVE preset
files from disk, as well as RENAME or DELETE them.

To set the size of the graph, set the horizontal axis with
the SIZE value and the vertical axis with RANGE.

Size 128 [ 12
W AR ... -
—— -

Integer Output

T ®

Create the mapper shape by clicking and dragging in the
graph; hold the Alt/Option key to draw a straight line. You
can also right-click and choose from a number of preset
shapes and functions.

When INTERPOLATED is enabled, the mapper
transitions smoothly from one value to the next; when
disabled, it transitions immediately from one value to the
next, which can create a stair-stepped effect.

Enabling INTEGER OUTPUT further constrains the
values output by the mapper to integer values only.
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MAKING MODULATION ASSIGNMENTS

To assign a modulation source, right-click the parameter
that you would like to modulate and choose from the
menu.

Choose ADD MODULATION to create a new
assignment, using either an existing modulation source
or a new one.

To edit existing modulation connections, choose

EDIT MODULATIONS to view the parameters current
assignments in a pop-up directly next to the parameter.
Choose CLEAR MODULATIONS to remove all
modulation assignments for that parameter.

Parameters can also be assigned to macros, for quick
control from the Info Tab. Choose ASSIGN TO MACRO
and assign one of the existing macros, or create a

new one. To remove the assignment, choose DELETE
MACROS assignment.

g0

[

~ 19
J(ll MODULATION
Multi Envelope 1 [Multi Env... c | SUB: Nane
= = () Multi Envelope 1 Default
Vel. amount | [ [ [ [ [ [ [ [ [ ] Speed Trigger Mode
0.0% (-0.0dB) | 1.00 Retrigger
E{Ii 100 ms 200 ms 300 ms 400 s 500 ms 600 ms 700 ms 800 ms 900 ms _'I
Vel sens | | Smooth Bioolar
75.00% 1R 0s B
| -
~
MIDI CC 1 A 4 Clear

Close

To quickly assign an MIDI CC to a parameter, choose
MIDI LEARN. You can then choose a MIDI CC from the
on-screen menu, or send the desired MIDI CC from your
MIDI keyboard controller. To remove the assignment,
choose Clear from the MIDI Learn window, or choose
MIDI UNLEARN from the modulation context menu.

20
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SAMPLE EDITOR

For sample-based oscillator types, the Sample Editor
displays a waveform editor and additional controls
specific to audio files and loops. (See [Appendix >
Oscillators > Synthesis] for details on the editor controls
available for each of the synthesis-based oscillator

types.)

The Sample Editor’s primary display is the waveform of
the loaded audio sample. If the oscillator doesn’t yet
have a sample loaded, you can load one by drag and
drop from the sidebar file browser or the Finder (Mac) /
File Explorer (Windows).

The time ruler above the waveform displays the duration
of the sample. To change the time format between
Samples, Beats, or Seconds, right-click the ruler.

By default the sample’s waveform is zoomed to fit the
display. To zoom in horizontally, hold the Alt/Option key
while scrolling with your mouse scroll wheel or trackpad
scroll gesture. Holding the Shift key while scrolling
zooms the waveform vertically.

et 4y 4
e

Allow Streaming

Default -

p090-Break Beat-04.wav

The SAMPLE INFO button displays an overlay on top
of the sample waveform with details about the loaded
sample: the sample file location, bit depth, sample rate,
number of channels, duration, and file size. If the sample
is looped, details about the file’s loop are displayed as
well.

The PARAMETERS button shows or hides the oscillator
parameters that are unique for that oscillator type. See
[Appendix > Oscillators > Sampling] for details on each
sampling oscillator type.

NOTE: Some of the sampling oscillators have a partial
subset of the full set of sample editing options described
below. The SAMPLE oscillator module has the largest
variety of sample editing operations available.

SAMPLE START/END

When a sample is loaded, you can adjust the points
where sample playback begins and ends within the file
by clicking and dragging the “S” and “E” markers.
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EDITING

To edit the sample file, click and drag to select a time
range for editing, then right-click to display a contextual
menu of editing commands.

Standard editing and selection commands are provided:
CUT. COPY, PASTE, UNDO, REDO, SELECT ALL,
DESELECT ALL

Common sample editing commands are also provided:
CROP, DELETE, NORMALIZE, SILENCE, REVERSE,
FADE IN, FADE OUT, PLAY SELECTION

APPLYING EFFECTS
You can also permanently apply Falcon’s audio effects to
a sample file. Select some audio and choose APPLY FX

from the contextual menu, and choose the desired effect.

Set the effect parameters, then press OK to apply.
If you would like to make the effect permanent,
remember to save the sample file. If not, choose Undo.

] Delay 3 Analog Filter
Reverb 3 Biquad Filter
- Reverse Modulation » Brickwall Filter
Eade In Filter ¥ Comb Filter
Fade Out Equalizer k Crossover Filter
Apply FX v Amp [ Stereo 3 LowPass 12
_ Drive [ Distortion » LowPass 24
h‘ Play Selection Y. Dynamic »  OnePole
Change Playing Direction to Reverse Miscellaneous »  Rez Filter
Set as One Shot SVF
Create Loop » UVI Filter
Vowel Filter
WahWah

Xpander Filter

LOOPING
Sample files can be played back and looped in a number
of ways.

Choose CHANGE PLAYING DIRECTION TO REVERSE
to simply play the sample in reverse; choose CHANGE
PLAYING DIRECTION TO FORWARD to change it back.

Choose SET AS ONE SHOT to play back a sample in
its entirety each time it is triggered, regardless of the
keygroup’s amplitude envelope. This is a natural fit for
drum and percussion samples. Choose DISABLE ONE
SHOT to return to standard playback.

To add a loop to the sample, make a selection in the

sample. Then choose CREATE LOOP and pick one of

the loop types:

« FORWARD LOOP: The looped section is played forward;
when playback reaches the end of the loop, playback
begins again from the loop start point.

- ALTERNATE LOOP: The looped section is played
alternately forward (from the loop start to loop end) and
reverse (from loop end to loop start).
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Once a loop is created, you can adjust the points where
the loop begins and ends within the file by clicking and
dragging the L and R markers.

You can also choose to crossfade the looped section.
This can sometimes help make a loop sound less looped.
Choose ENABLE XFADE to enable loop crossfade, or
DISABLE XFADE to disable it. When the loop crossfade
is enabled, you can adjust the loop crossfade point with
the X marker.

When a sample has a loop and a note triggering the
sample is released, there are two release playback
options:

- ENABLE LOOPED RELEASE: Sample playback will loop
in the looped section until the release phase is over.

- DISABLE LOOPED RELEASE: Sample playback will
continue past the loop end marker until the release
phase is over or the sample end marker is reached,
whichever comes first.

Lastly, to remove the loop, choose DELETE LOOP.

Allow Streaming

10

r —0 R
; Y
9 ] X
p090-Break Beat-04.wav

SAVING

The standard module preset browser controls are also
displayed (see [Module Preset Browser]). The Preset File
menu also displays these options specific to sampling
oscillators.

« SAVE PRESET: Saves the oscillator parameters

. SAVE SAMPLE: Saves the sample/file in place

- SAVE SAMPLE AS...: Saves the sample to a new file

.- SAVE SAMPLE WITH PLAYBACK OPTIONS: Saves the
sample/file in place and writes the sample and loop start/

end markers to the file

- SAVE SAMPLE AS WITH PLAYBACK OPTIONS...:
Saves the current sample to a new file and writes the
sample and loop start/end markers to the file

To reveal the sample file’s location, right-click the sample
and choose REVEAL IN FINDER (Mac) / REVEAL IN
EXPLORER (Windows) from the contextual menu.

BATCH EDITING

When multiple keygroups are selected, the Batch
menu appears. From the Batch menu, you can apply an
action to all of the selected keygroups at once, such as
normalizing samples or applying FX.
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EFFECTS TAB
The Effects tab displays all of the audio effects
processing paths, from the effects on the master output
down to effects on an individual keygroup.

Y

N# Master Ne Part1 # Mew Program

NAVIGATION

To choose which effects path you are viewing, choose

a node from the navigation breadcrumbs. Press on a
node’s name to show its effects. You can also press on
the arrow to the right of a node to view one of its child
nodes. For example, you can press the arrow to the right
of Program and choose from one of its layers.

You can also select a node in the Tree view sidebar, and
the Effects tab will show the selected node’s effects. For
more details on the Tree view, see [Interface > Tree].

ADDING EFFECTS

To add an effect, press the + button in the upper right
and choose an effect from the menu. You can also drag
and drop effects from the Preset Browser on the right.

oo TAP 12000 & ® b . | i [©g]
ah U fx
([ 2 Betay
Old Radio Analog Tape Delay
a 1-4 Tube Mono  ~ Dual Delay
DISTORTION MiX Reverb
Diffusion
Trash Dry Wet IReverb
100.00% N/ 100.00% 17.00% -
SparkVerb [ 3
Modulation
Default v Bm Filter
Analog Filter

TIP: Keygroup effects are per voice. The more voices
you play back, the more effects processing power your
computer will need. Keygroup effects are best suited for
effects that you want to be processed distinctly for each
voice.

The signal flow is top to bottom. To reorder effects, press
and hold on an effect’s header and drag it to the new
position. To replace an effect, press on the effect’s name
and choose a different effect from the menu.

For details on each of the effects included in Falcon, see
[Appendix A > Effects].

Each effect can be enabled or disabled with the POWER
button to the left of its name, or deleted with the X
button at the far right end.

TEMPO-SYNCING EFFECTS K\

Some effects, such as delay or tremolo, can sync their
time-based parameters to Falcon’s tempo. If an effect
supports tempo-syncing, a TEMPO SYNC toggle button
will appear next to the Preset File menu.
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SAVING FX PRESETS
Each effects module has a preset browser for saving,
recalling, and browsing presets for that effect type.

To save an effect preset, press the Preset File menu,
choose Save Preset, and name the preset. For more
details on the preset browser, see [User Presets >
Module Preset Browser].

MULTI FX

Multiple effects can also be saved and recalled as a
group with a Multi FX preset. This provides a way for
complex chains of effects to be recalled instantly. Multi
FX presets are saved and loaded through the Multi FX
preset menu. All effects for the current node can be
enabled or disabled together with the POWER button
to the left of its name. To clear all effects for the node,
choose Clear Multi from the Multi FX preset browser.

AUX FX
There are two aux effects sections: master aux FX and 10
program aux FX.
- The master aux FX are fed by sends on each part in
the multi. These settings are saved in the multi.

1

&# MNew Program

§ New Program

W Layer 1

Aux 1
H Aux 1 P
# Aux 2 o
# Aux 3 .
W Aux 4 LG

Analog Tape Delay

Guitar Boxes

« The program aux FX are fed by sends on each layer and
keygroup in the program. These settings are saved in the

program.

To view and add aux FX in the Effects tab, choose the
aux bus from the navigation menu on the Part or Layer
nodes. Each aux effects section has four independent

aux busses.

To adjust the aux sends to each of the aux busses, show

the aux FX nodes in the Tree view. On each node where
aux sends are present, you can set the send level, mute/
unmute the send, and toggle the send between pre/post
fader. For more details on the Tree view, see [Interface >

Tree].

You can also view the master aux FX and their sends
in the Mixer view. For more details on the Mixer, see
[Interface > Mixer].

MODULATION AND KEYBOARD SECTIONS
The Modulation and Keyboard sections can be toggled
in the Effects tab, using the buttons in the top right.

G
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The Events tab displays all of the MIDI event processing
paths, from master event processors down to event
processors on an individual layer. (Event processors
are not added to keygroups, as they generally address
events that span multiple keygroups.)

ﬁ Master ﬁ Part 1 ﬁ MNew Program

NAVIGATION

To choose which event processing path you are viewing,
choose a node from the navigation breadcrumbs. Press
on a node’s name to show its events. You can also press
on the arrow to the right of a node to view one of its child
nodes. For example, you can press the arrow to the right
of Program and choose from one of its layers.

You can also select a node in the Tree view sidebar, and
the Events tab will show the selected node’s events. For
more details on the Tree view, see [Interface > Tree].

ADDING EVENTS
To add an event processor, press the + button in the
upper right and choose one from the menu. You can also

drag and drop them from the Preset Browser on the right.

MAIN

EVENTS

Step Length

100.00%
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Analysis

The signal flow is top to bottom. To reorder event
processors, press and hold on an event processors’s
header and drag it to the new position. To replace an
event processors, press on the event processors’s name
and choose a different event processor from the menu.
For details on each of the event processors included in
Falcon, see [Appendix A > Event Processors].

Event processors can be toggled on/off with the POWER
button or deleted with the X button in their toolbar.

SAVING EVENT PRESETS
Each event processor module has a preset browser for
saving, recalling, and browsing presets.

To save an event processor preset, press the Preset
File menu and choose Save Preset. For more details on
the preset browser, see [User Presets > Module Preset
Browser].

MODULATION AND KEYBOARD SECTIONS
The Modulation and Keyboard sections can be toggled
in the Events tab, using the buttons in the top right.
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MODULATIONS TAB

The Modulations (Mods) tab displays all of the modulation
sources, from master modulation sources down to
modulation sources for a single keygroup.

N# Master Ne Part1 N# MNew Program

NAVIGATION

To choose which modulation sources you are viewing,
choose a node from the navigation breadcrumbs. Press
on a node’s name to show its modulation sources. You
can also press on the arrow to the right of a node to view
one of its child nodes.

You can also select a node in the Tree view sidebar,
and the Modulations tab will show the selected node’s
modulation sources. For more details on the Tree view,
see [Interface > Tree].

ADDING MODULATION SOURCES

To add a modulation source, press the + button in the
upper right and choose a modulation sources from the
menu. You can also drag and drop modulation sources
from the Preset Browser on the right.

| - TAP 12000 & ® »

ah L

A Default v

Rise Smooth

Trigger Mode
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- P No Retrigger *

0s

all
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LFO @
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TIP: Keygroup modulations are per voice. The more
voices you play back, the more processing power your
computer will need. Keygroup modulations are best
suited for parameters that you want to be modulated
distinctly for each voice.

NOTE: Unlike Effects and Events, the list of modulation
sources doesn’t have a top-to-bottom signal flow. Until
a modulation source is assigned to modulate other
controls, it won’t have an effect on the signal flow. See
[Interface > Main > Modulation Editor] for more details.

To replace a modulation, press on the modulation’s name
and choose a different modulation from the menu.

For details on each of the modulation sources included in
Falcon, see [Appendix A > Modulators].

Each modulation source can be enabled or disabled with
the POWER button to the left of its name, or deleted with
the X button at the far right end.
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SAVING MODULATION PRESETS

Each modulation module has a preset browser for
saving, recalling, and browsing presets for that specific
modulation type.

To save a modulation preset, press the Preset File
button, choose Save Preset, and name the preset. For
more details on the preset browser, see [User Presets >
Module Preset Browser].

RENAMING A MODULATION SOURCE

To rename a modulation source, double-click its name.
Using a descriptive name can help differentiate between
modulation sources of the same type (“Amp. Env.” and
“Filter Env.” for example).

ASSIGNING A MODULATION SOURCE

To assign a modulation source, right-click a control

and choose from the Add Modulation menu. Existing
modulation sources are listed first, or you can choose to
create a new modulation source on the spot.

For more information on modulation assignments, see
[Interface > Main > Modulation Editor].

MODULATION AND KEYBOARD SECTIONS

The Modulation and Keyboard sections can be shown or
hidden in the Modulations tab, using the buttons in the
top right.

Edit Modulations

Assign to Host automation #

MIDI Learn
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PARTS LIST

The Parts List displays controls for each of Falcon’s parts.

Each of these settings are independent from the settings
saved in the program loaded in the part. These part
settings are saved and recalled with the multi (or your
host session if you're using Falcon as a plug-in).

The program name of the currently loaded program is
displayed. If there are unsaved changes, an asterisk will
appear next to the name, for example, “Love 1.

To load a different program, double-click the name to
open the [File Browser], or Shift-double-click to open the
righthand sidebar [Preset Browser]. In either case, the
browser will be opened to the location of the currently
loaded program.

You can also use the next and previous buttons to
browse files in the same directory, or right-click and
choose an option from the contextual menu:

Empty part, Delete part, Load program, Reload program,
New program

The MIDI INPUT and AUDIO OUTPUT assignments
are displayed for each part. By default, each new

part is assigned to the Main Out, and its MIDI input is
incremented (A1, A2, A3, ...). To change the assignment,
press and hold and choose from the menu. If the MIDI
assignment is set to Omni, it will listen for MIDI input on
all ports and all channels, and display an asterisk.

OUTPUT METERS display audio levels for the part’s
output. Also, whenever a part receives MIDI on its
assigned input channel, the MIDI input indicator flashes.

VOL and PAN controls set the output level and stereo
placement for the part. Each part also has MUTE and
SOLO buttons to mute or solo the part’s output. Alt/
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*—

~J

10

1"

12
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] ] Dut 3 >~
T | |
?
072-Yes-DrmlLoop... & F o1 12
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[i] [i] Dut 2

A9A9A9
P
CI—

10 " HE
HE

Option-click a mute or solo button to mute or solo only
that channel; Command-click (Mac) or Control-click
(Windows) to mute or solo all channels except the one
you clicked.

The OCTAVE and SEMI controls transpose the part’s
incoming MIDI, in octaves and semitones.

If a loop is loaded in the part, two additional controls are

displayed:

- AUTO PLAY: When enabled, the loop will be triggered
when Falcon’s playback begins.

- PLAY: Highlights when the loop is playing, and can also
be used to manually start/stop loop playback.

The part’s color is displayed on the right side. To change

its color, click on the color bar and choose a color from
the color picker.
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The List view displays a detailed rundown of the settings
for a single part and its currently-loaded program.

It contains four sections: Part, Program, Layers, and
Keygroups.

The List view is displayed in the left sidebar, which can
be hidden or shown with its button in the Toolbar. To
resize the List view width, click/drag on its right edge.

Each section can be collapsed or expanded with the
arrow to the left of the section name.

PART
The Part section displays the part settings for the
selected part.

To choose which part is displayed, choose a part from
the PART SELECTOR MENU in the upper right.

The Part settings displayed in List view are the same as
those displayed in [Interface > Parts].

PROGRAM

The Program section displays the settings for the
program loaded in the chosen part. The Program settings
displayed in List view are the same as those displayed in
the Program section in the Edit view.

On the right side of the Program section is the
PROGRAM MENU, which contains options for creating,
loading, saving, and protecting a program. For details on
each of these options, see [User Presets].

Additionally, there are PREVIOUS PROGRAM and NEXT
PROGRAM buttons for browsing program files.

PART
MIDM In A1
MIDH Mute
Streaming W
Transpose Oct O

Transpose Semi 0

Coarse Tune 0 Semitones

Fine Tune O Cants
Valume 0.00dB

PROGRAM

Name 5 Guitars®
Memory 8.16 MB

Polyphony 16
MNote Polyphony 0
Transpose Oct O

Transpose Semi 0

Volume -8.48 dB

LAYER(S)
id color name
1 Tape A
2 Tape B
E Tape C
4 Noisas
KEYGROUP(S)
narme

Mello-Guit1 25tr-A#2-rrd2....
Mello-Guit]25tr-A#3-rr)l....
Mello-Guit]25tr-A#4-rr)l....

Mello-Guit1 25tr-A2-rrdd.w...
Mello-Guit1 25tr-A3-rr02.w...
Mello-Guit1 25tr-Ad-rr02.w...
Mello-Guit] 25tr-B2-rrld.w...
Mello-Guit125tr-B3-rrl.w...
Mello-Guit1 25tr-B4-rrl.w...

Mello-Guit]1 25tr-C&3-rr02....
Mello-Guit1 25tr-Ca4-rr02....
Mello-Guit] 25tr-C&5-rr02....

Mallo-Guit1 25tr-C3-rr2.w...

Bl ailed Wil de 78 o™ e

root
Af1
A#2
A#3
Al
A2
A3
B1
B2
B3
C#2
C#3
Ciq
c2

3

LIST
Part1
mute solo
hay
Ag1 - A®
AR2 - AF
AR3 - AF
Al Al
A2 Al
A3 A:
B1 B
B2 B
B3 B:
Ce#2 - C#
C#3 - C#
C#aq - C#
Ci

3
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LAYERS

The Layers section displays a list of all layers in the
program. The selected layer in the List view also updates
which layers are displayed in the Edit view. Using the
Layers List to view one layer at a time can be very helpful
in a large, complex program.

To select a layer, press on its name or ID; hold the
Command key (Mac) or Control key (Windows) to select
multiple layers at once. To deselect all layers, press in
the space beneath the last layer in the list. (When there
is no specific layer selected, the Edit view displays a
composite of all layers, and edits to Layer settings apply
to all layers.)

The Layer settings displayed in List view are the same as
those displayed in the Program section in the Edit view
(see [Interface > Main > Edit > Program]) or the Tree view
inspector (see [Interface > Main > Tree]).

To choose which settings are displayed in the Layers list,
right-click a column header and enable or disable the
desired columns.

On the right side of the Layers section is the LAYER
MENU, which contains options for editing layer rules, and
copying, pasting, and duplicating the selected layers. For
details on these options, see [Interface > Main > Mapping
Editor].

Additionally, there is an ADD LAYER button for quickly
adding a new layer, and a REMOVE LAYER button for
removing the selected layers.

PART
MIDM In A1
MIDH Mute
Streaming W
Transpose Oct O

Transpose Semi 0

Coarse Tune 0 Semitones

Fine Tune O Cants
Valume 0.00dB
PROGRAM
Name 5 Guitars®
Memory 816 MB
Polyphony 16

MNote Polyphony 0
Transpose Oct O

LIST

Part1

= ~ -1
TTAT TS arae o it o

Volume -8.48 dB
LAYER(S)

id color name

e T Tape A
2 Tape B
E Tape C
4 Noisas
KEYGROUP(S)
narme

Mello-Guit125tr-A#2-rm)2....
Mello-Guit1 25tr-A#3-rm)d....
Mello-Guit1 25tr-A#4-rm)d....
Mallo-Guit1 25tr-A2-rr02.w...
Mello-Guit1 25tr-A3-rr02.w...
Mello-Guit1 25tr-Ad-rr02.w...
Mello-Guit1 25tr-B2-rrl2.w...
Mello-Guit1 25tr-B3-rrdid.w...
Mello-Guit 25tr-B4-rrdid.w...
Mallo-Guit1 25tr-C#3-rr0d....
Mallo-Guit 1 25tr-C#4-rr0d....
Meallo-Guit1 25tr-C#5-rr0d....
Mello-Guit1 25tr-C3-rrdid.w...

Bl ailed Wil de 78 o™ e

root

Af1
A#2
A#3
Al
A2
A3
B1
B2
B3
C#2
C#3
Ciq
c2

3

key

AR1 -
A#2 -
A#3 -

Al
A2
A3
B1
B2
B3

L
C#3 -
e

c2

3

[T

mute solo e—1F

Auto-size this column
Auto-size all columns

v id

v color

v name

v mute

v solo
ey
volume
pan
output
MIDI mute
Audio meter
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The Keygroups section displays a list of all keygroups 1"
in the selected layers. The selected keygroup in the Auto—size this column
=5l |
List view also updates which keygroup is selected in Auto-size all columns
the Edit view. Using the Keygroups List view to select 13 ; :"““:
specific kegroups can be very helpful in a large, complex 3 T:::C
program. 12 " —— ¥ root
l v ey
10 To select a keygroup, press on its name; hold the KEYGROUP(S) v vel
Command key (Mac) or Control key (Windows) to select A root  key ® v trigger
I_lST multiple keygroups at once. To deselect all keygroups, 10 ———= Mello-Guit125tr-A#2-rr02... A#1 A#1 - A# key fade
press in the space beneath the last keygroup in the list. Mello-Guit125tr-A#3-m02... A2 AR2 - AR vel fade
(When there is no specific keygroup selected, the Edit Mallo-Cu2Ste-AM0d..  AS3  AS ° A v volume
: : : : Mello-Guit1 25tr-A2-rr02.w... A1 Al A
view displays a composite of all keygroups, and edits to eloTbuilastrAsmatw | v’ pan
) Mello-Guit125tr-A2-rr02.w... A2 A2 A trigger sync
Keygroup settings apply to all keygroups.) The Keygroup Mallo-GuitIZStr-Al-notwe A3 A3 A: s
settings displayed in Keygroup view are the same as Mello-Guit1 25tr-B2-r02.w...  B1 B1 B1 y
those displayed in other Keygroup and Mapping Editor Mello-Guit] 25tr-B3-rr02.w... B2 B2 - B ex. group
sections. Mello-Guit125tr-B4-r02.w.. B3 B3 - B: program aux send 1
Mello-Guit125tr-C#3-rr02.... C#2 C#2 - C# program aux send 2
. : : : Guf Ci#4- - rogram aux send 3
To choose which settings are displayed in the Keygroups Malls-cuinzitecremz..  C43 8 - CR prog
1" st riaht-click a column header and enable or disable th Mello-Guit1 25tr-C#5-rr02... C#4 C#4 - C# program aux send 4
ISt right-click a colu cader a a 5@ < Mello-Guit] 25tr-C3-rr02.w... c2 cz - C layer
desired columns. Pressing a column name will sort the T N T P ~a - - - output
list by the chosen column; press it again to reverse the I
sort order.
14
12 On the right side of the Keygroups section is the 1
KEYGROUP MENU, which contains options for copying,
pasting, and duplicating the selected layers. For details petune ey sUooET e E ' —— 0:00dB - Center )
: ) . Dirty 1.wav F-1 F-1 - F-1 1 127 On ¥ 0.00dB Center (1]
on these options, see [Interface > Main > Mapping Editor]. ey F41  E#-1 - E&1 1 137 ©On ¥ 0.00dB Center o
Dynamic Room.wav G-1 G-1 - G1 | 127 On ¥ 0.00dB Center [i]
T Additionally, there is an ADD KEYGROUP button Explosion 1 S.wav G#=1 G#1 - G#1 1 127 On ¥ 0.00:: Eenter 1]
. 5 Explosion 2 5.wav A-1 A-1 - A-1 1 127 On ¥ 0.00 enter 0
for quickly adding a new keygroup, and a REMOVE Fat Roomy S.wav A#1  A#-1 - A#-1 1 127 ©On ¥ 0.00dB Center 0
KEYGROUP button for removing the selected Flat Box.wav B-1  B-1 + B-1 1 127 ©On ¥ 0.00dB Center 0
keygroups. Gated S.wav co co - Co 1 127 On ¥ 0.00dB Center 1]
Hasime 1 s &N FHn « Fan 1 137 N v nnn A@ Fanbar n
" Click/drag the right edge of the column to expand its

width to accommodate large parameter sets.
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FILE BROWSER
The File Browser is a view for browsing, searching,
auditioning, and loading files in Falcon.

There are three types of file browsers:

- PROGRAM FILE BROWSER, for loading programs,
loops, and samples

- MULTI FILE BROWSER, for loading multi files

- SIDEBAR FILE BROWSER, for quick drag & drop
loading of any file type

PROGRAM FILE BROWSER

To open the program file browser, double-click a
program name or an empty part in the Parts List, Mixer,
or Performance view, or choose Load Program from the
Toolbar menu.

The program file browser has four sections in its left
sidebar:

. SEARCH

DEVICES

- PLACES

SOUNDBANKS

Each available disk or volume is listed in the DEVICES
section, including network volumes.

The PLACES section is a list of favorite folders saved for
easy recall. To add a location to Places, drag a folder in
the browser over to the Places section in the browser
sidebar. To remove a folder from Places, right-click the
folder name and choose Remove from Favorite Places.

Each mounted soundbank file is displayed in the
SOUNDBANKS section. This includes soundbanks that
you mount on-demand, and those auto-mounted on
startup. For details on auto-mounting soundbanks, see
[Preferences > Soundbanks].
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inspired by the most mythical Computer Music Instrument of the

80's

Costing upwards of $100,000, the dream machine of the 80's was

unattainable by most. Used by countless prominent artists

including: Peter Gabriel, David Bowie, Michael Jackson, Kate Bush,
Herbie Hancock, Jean Michel Jarre, Thomas Dolby and many more,

it remains a highly regarded and sought after instrument.

Version 1.0
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Some UVI soundbanks also have an additional VERIFY
SOUNDBANK INTEGRITY option, available by right-
clicking the name of the mounted soundbank. This
verifies that the soundbank file was not corrupted when it
was downloaded or moved between disks.

The SEARCH section is an alternative to choosing a
specific location and browsing its contents; instead,
a search term is entered and matching results are
displayed across all searchable locations. For more
details on Search, see below.

BROWSING AND LOADING

Choose a location from one of the sections in the sidebar
to displays its contents. Its files and subfolders are
displayed in columns extending to the right.

To load the selected program or audio file, double-click
the file name or press the OK button. You can also drag
and drop a file from the browser to the Parts List, by
dragging onto an existing part or by dragging beneath
the last part in the list to load it as a new part. To close
the browser without loading a file, press the CLOSE
button or press the Escape key. To unload the program
or sample file currently loaded in the selected part, press
the EMPTY button.

To reveal the location of a file or folder in the browser,
right-click its name and choose REVEAL IN FINDER
(Mac) or REVEAL IN EXPLORER (Windows). To delete a
file, right-click its name and choose DELETE FILE.

BROWSER OPTIONS

The program file browser has a number of options,
displayed as toggle buttons along the bottom:

AUTO LOAD will automatically load the audio file
selected in the browser into the currently selected part.
AUTO PLAY will automatically play the selected audio
file to audition the file without loading it.

5

¥ Search l

Instruments
Loops
Sounds

» Devices

¥ Places
Desktop
Documents
Sound

¥ Soundbanks

Acoustic Toys Museu

CS-M 1.5
DarkLight lix

Digital Synsations

Drumulation
EGP

EKOLOOPZ-Hip Hop PI
Electric Toys Museum

Electro Suite
Emulation 2
Emulation One
Energy

FMX-1

80's

Costing upwards of $100,000, the dream machine of the 80's was

Search snare|

name
Actarus-5D1.wav
Actarus-5D2.wav
Afro One-Rim.wav
Afro One-SD1.wav
Afro One-SD2.wav
Afro One-SD3.wav
Air Beat-SD+CLAPl.wav
Air Beat-SD+CLAP2.wav
Air Beat-SD+CLAP3.wav
Air Beat-SD+CLAP4.wav
Air Beat-SD+CLAP5.wav
Air Beat-SD+CLAP6.wav
Air Beat-SD1.wav
Air Beat-SD2.wav
Air Beat-5D3.wav
Appollo-SD1.wav
Appollo-SD2.wav
Basta Ring-SD1.wav
Basta Ring-SD2.wav
Basta Ring-SD3.wav
Big Clapping-SD.wav

i mmmmmmniri»

unattainable by most. Used by countless prominent artists

including: Peter Gabriel, David Bowie, Michael Jackson, Kate Bush,
Herbie Hancock, Jean Michel Jarre, Thomas Dolby and many more,

it remains a highly regarded and sought after instrument.

Version 1.0

Auto Load Auto Play

Original Tempo Display Info

type
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound
Sound

Sound

volume
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs
Electro Suite.ufs

Load as Layers Auto close
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Auto Load Auto Play Original Tempo Display Info Load as Layers Auto close

If an audio file’s tempo doesn’t match Falcon’s current
tempo, enabling ORIGINAL TEMPO will cause the file to
be auditioned at its original tempo. When disabled, the
audio file auditions at Falcon’s current tempo.

The DISPLAY INFO button toggles the information
panel displayed in the lower half of the browser. When
enabled, it displays information about the selected file.

To load multiple programs into a single part (for example,
for multiple articulations of a single instrument, to be
switched with layer rules), enable LOAD AS LAYERS.
This will load additional programs within the current

file as new layers (leaving the current program effects,
modulations, etc. untouched). When disabled, each
loaded program fully replaces the currently loaded
program.

To automatically close the file browser when the OK
button is pressed or a file is double-clicked, enable
AUTO CLOSE; otherwise, the browser remains open
until you press the CLOSE button or press the Escape
key.

12

13

¥ Search e Search sr'lare|
Instruments
) Loops name
Sounds Actarus-5D1.wav
»| Devices ACtaFﬁS—S?Ewav
12 13
SEARCH

Rather than navigating to a specific folder and file, you
can use search to find files that match your criteria.

To set which locations are searched, add the folder

in the Soundbank preferences. For more details, see
[Preferences > Soundbanks].

To search, begin typing in the search field and results
will appear as you type. Search results are one of three
types of files:

« INSTRUMENTS: program files

- LOOPS: looped audio samples

+ SOUNDS non-looped audio samples

To search across all types at once, highlight SEARCH

in the sidebar. To show results for one specific file type,
highlight the type name instead. You can also enter a
search term, then switch between types to view the
different results. The search results display information
about each file, such as its name and file type. To choose
which columns are displayed for the list of search results,
right-click a column header and enable or disable the
desired columns. Pressing a column name will sort the
list by the chosen column; press it again to reverse the
sort order.

Sou
Sou
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SOUNDBANKS

Each mounted soundbank file is displayed in the
SOUNDBANKS section. Press on a soundbank name to
expand it and display the soundbank’s contents; press
again to collapse the soundbank’s contents.

AUDITIONING AND LOADING FILES
The sidebar browser also has some options for quickly
auditioning samples and adding them to a program.

AUTO PLAY will automatically play audio files

The PLAY / STOP button next to it lets you manually
start and stop sample playback.

The VOLUME slider sets the playback level.

When AUTO LOAD is enabled, the sample is
automatically loaded in the selected keygroup. This is
especially useful when you have already mapped the key
range and velocity range of a keygroup, but would like to
replace the sample file.
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20

Devices
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Media
Music
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Desktop
Documents
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Soundbanks
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darkli I
ﬁf{#;f SYNSATIONS
Drumulation

EGP ELECTRIC GRAND

EKOLOOPZ-HIP HOP PLAMET
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The Preset Browsers are views for browsing and loading
preset files for specific module types, such as effects or
event processors.

The Preset Browser is displayed in the right sidebar,
which can be hidden or shown with its button in the
Toolbar. To resize the Preset Browser width, click and
drag on its left edge.

There are six Preset Browsers, each displayed as a tab in
the sidebar. From left-to-right the tabs represent:
- FILES
+ OSCILLATORS
EFFECTS
-« MULTI FX
- EVENT PROCESSORS
- MODULATION SOURCES

For details on the File Browser, see [Interface > File
Browser]; for the rest, see below.

BROWSING PRESETS

Each tab displays all of the factory and user presets for
the chosen type. Presets are organized into folders, and
can be nested as many levels as needed.

LOADING A PRESET

To load a preset from the Preset Browser, drag and drop
the preset to the desired location. For example, you can
drag an oscillator preset to the Mapping Editor, an effects
preset to a channel strip in the Mixer, or a modulation
source preset onto any control that can be modulated.
When a target can accept the preset you are dragging,
the target highlights.

5

L
{ 5pur§erh{— _———
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Delay
Analog Tape Delay
Dual Delay
Reverb
Diffusion
IReverb
SparkVerb
Modulation
Filter
Analog Filter
Biquad Filter
Brickwall Filter
Comb Filter
Crossover Filter
LowPass 12
LowPass 24
One Pole
Rez Filter
5VF
UV Filter
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PART SETTINGS

The Part settings displayed in the Mixer are the same as
in the Parts List, but displayed here in a familiar audio
mixer style. For more information on part settings, see
[Interface > Main > Parts].

Double-clicking a part name opens the file browser. You
can also right-click on a part name for additional options
from the contextual menu:

- EMPTY PART

- LOAD PROGRAM

EFFECTS

The Mixer is an intuitive view for managing audio effects.
To add an effect, press on the + button on any channel
strip and choose an effect from the menu. You can also
drag and drop effects presets from the Preset Browser
onto the + button.

After the effect is added, it will be selected and its
controls will be displayed in the effects editor above. The
effects module displayed here is the same as is shown in
the Effects Tab view.

To replace an existing effect with a different one, press
and hold on the effect’s name and choose a replacement
from the menu. You can also drag and drop an effects
preset onto it from the Preset Browser.

Effects can be bypassed temporarily by pressing the
bypass button next to its name. Alternatively, you can
bypass by Shift-clicking the effect’'s name, or with the
effect’s “power” button when the effect is selected and
displayed in the effects editor.

To remove an effect, press and hold on the effects name
and choose “Empty” from the menu. You can also use
the effect’s “X” button to remove it when the effect is
selected and displayed in the effects editor.

AUXES

The Mixer also displays the four master aux effect
busses. Each part’s channel strip has sends for the aux
busses. Each send has an enable/bypass switch on the
left, and a pre/post-fader switch on the right. The default
is post-fader; toggle to switch to pre-fader.

The aux channel strips are similar to the part channel

strips, just without the part-specific settings. Note that
the output of the aux busses are always routed to the
Main Out.

MASTER

Lastly, the Mixer displays the Master channel strip. Effects
can be added to the Master output just as with parts and
auxes, and the master fader adjusts the Global Volume.

3 5 6
Radial Jammer Aux 1 Master
——*H Tilt Gtr Bxs 3 Bnd Cmiprsse
Redux Spctrm Anlyzr
Fhaser

# # #

L
ik dk db &k

Al Main Gut
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String Machines*

Bass Funky M

Beast Box

2-Page B
PERFORMANCE

Blue Rim

Choir Boys_ MK

5 5 BA 80's Seq A
The Performance view displays a

. ) g BA FM Soft A
bird’s-eye view of all parts at once. )

This can be used as an overview AMEELAE] 2 il

when there are a large number
parts, or during a live performance
for quick and simple access to part

settings. PART SETTINGS

Each part displays the same controls as in the Parts
Editor (see [Interface > Main > Parts]). However, if the
Parts column is resized to be relatively narrow, some
controls will be hidden automatically.

Parts

PART KEY AND VELOCITY RANGE

The KEYBOARD RANGE and VELOCITY RANGE
restrict the key and velocity range for the part. These are
independent from the key and velocity range mapping
of the program’s layers and keygroups. Drag to adjust
the ends of the range, or click and drag anywhere on
the current range to move it. Holding the Option/Alt key
while dragging to apply a fade.

NOTE: Changing a part’s key or velocity range in
Performance view won’t extend a part’s key or velocity
range beyond what the program provides. These key
and velocity range settings help stack or split parts by

1]

Main Out

Out 5

Main Out

Main Out

Main Out

Main Out

Main Qut

Al

Al

A2

B10

Al

Keyboard Range Velocity Range Key Switch

A# 1
F&8 127

-2 1
D#3 127

c-2 1

None

None

None

G8 127

5 Bé k 127 \/ =

b a| BV o
e Gs i 127 Mone
c-2 o 1 127 None
2 D&7 L 127 Mone
-2 T 1 137 None
C-2 i 1 127 None

taking their existing ranges and constraining them. For
example, a mono bass synth could be mapped to the left
hand key range and a synth lead to the right hand key
range. For more information on setting key and velocity
ranges within a program, see [Mapping Editor].

KEYSWITCH

The KEYSWITCH sets a keyswitch note for the part.
When the chosen note is played, the part will be toggled
on. This is useful when toggling between multiple
articulations or styles of the same instrument, such

as staccato and legato strings. Press the checkbox to
enable a keyswitch, then double-click the note name to
edit the value and assign a note.

NOTE: Keyswitches assigned to parts in Performance
view are independent from keyswitches saved in the
program. For more information on keyswitches within a
program, see [Mapping Editor > Layer Rules].
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GENERAL CONVENTIONS

Throughout Falcon, some common
conventions are used for adjusting
and interacting with controls.

HOVER

Hovering the cursor over a control will display the
control’s current value in a pop-up help tag (sometimes
also called a “tool tip”).

N

440.00 Hz

CLICK AND DRAG

Click and drag a control to adjust its value. Hold the
Command key (Mac) or Control key (Windows) while
dragging a control for finer adjustment. You can also
hover over a control and scroll with your mouse scroll
wheel or trackpad’s scroll gesture.

DOUBLE-CLICK

Double-click a control to enter a numeric value. To
confirm a new value, press the Return key or click
outside the text field. To dismiss without changing the
value, press the Escape key.

*® LAYER(S)

1.00 dB

U

RIGHT-CLICK

Right-click (or Control-click on Mac) to display a
contextual menu if one is available. Contextual menus
are used for many useful shortcuts, such as assigning
modulation sources to a control. The menu items
available in the contextual menu vary based on the item
that you have right-clicked.

Add Modulation 3
%Edit Modulations

Assign to Host automation »

MIDI Learn
Assign To Macro k
OsC k

ALT/OPTION-CLICK
Alt/Option-click a control to return it to its default value.

ARROW KEYS
The arrow keys can be used to change the selected item
in most lists, menus, and file browsers.
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USER PRESETS

After creating or editing sounds in
Falcon, you can save the results

as presets for individual modules,
programs for a single instruments,
and multis for all parts and programs
in the entire Falcon instance.

MODULES

Each type of module — Oscillator, Modulation, Effects,
and Event Processor — supports saving and loading
presets. Numerous factory presets are included for each
module, and you can save user presets as well. Module
presets allow for easy recall and reuse of specific module
settings in different programs.

MODULE PRESET BROWSER
Each module displays a preset browser in the
upper right:

Default -

The PRESET MENU displays the name of the current
preset. Pressing the name displays a dropdown menu of
factory and user presets for the module.

The NEXT PRESET and PREVIOUS PRESET buttons
load the next or previous preset for the module.

To save a user preset, press the PRESET FILE MENU
and choose SAVE PRESET from the menu. User presets
can be organized into subfolders, as many levels deep as
you need. TIP: The Preset File menu additional options
for sample-based oscillators. For more information, see
[Interface > Main > Sample Editor].

% Load Preset
Save Preset
Save Sample
Save Sample as...
Save Sample with playback options
Save Sample as with playback options...

To load a user preset from any location on disk, press the
Preset File menu and choose LOAD PRESET from the
menu.

SIDEBAR PRESET BROWSER
The Preset Browser is displayed in the right sidebar.

fx

Delay
Analog Tape Delay

The Preset Browser displays all module presets in one
place for easy browsing. For more information, see
[Interface > Main > Preset Browsers].

PROGRAMS

A program file saves the state of everything within the
program, including all of its layers and keygroups. If it’s
displayed in the Info Tab or the Edit Tab, it's saved with
the program.

NOTE: A program does not save any part-specific
settings, such as part gain/pan, part effects, and so on.
To save part settings, use a multi (see below).

Many views throughout Falcon have options available

for managing program files, such as in the Toolbar’s main
menu and the Parts List contextual menu. Each command
is explained below.

CREATING
- NEW PROGRAM: Creates a new, empty program.

LOADING
LOAD PROGRAM: Opens the Program File Browser.

- RELOAD PROGRAM: Reloads the most recently saved
version of the program; this discards any unsaved
changes to the program.

- RECENT PROGRAMS: Lists up to ten recently loaded
programs for quick access.
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SAVING

- SAVE PROGRAM: Saves the program file only

- SAVE PROGRAM AS...: Saves the program file only,
under a new name

- SAVE PROGRAM AND SAMPLES: Saves the program
file and all sample files

- SAVE PROGRAM AND SAMPLES AS...: Saves the

program file under a new name, and all of the program’s

samples into a subfolder with the program name
- SAVE PROGRAM SAMPLES: Saves all samples only;
does not save the program file

PROTECTING

- PROTECT PROGRAM: Adds a password to the program.

This is useful for complex, scripted programs where the
topology needs to remain unchanged. Once protected,
only the Info tab is available for the program,; the Edit

view is disabled. In the Tree and List views, the program

node displays only limited settings; the layer, keygroup,
and oscillator nodes are not displayed.

- UNPROTECT PROGRAM: If the program is protected,
you must enter the program password to edit the
program.

MULTIS
A multi file saves the state of the entire Falcon instance
— all parts, programs, effects, and master settings.

Multi files are managed primarily from the Toolbar’s main
menu.

LOADING

LOAD MULTI: Opens the Multi File Browser

RECENT MULTIS: Lists up to ten recently loaded multis
for quick access.

SAVING

-« SAVE MULTI: Saves over the current multi

- SAVE MULTI AS...: Create a new file for the current multi
« SAVE MULTI AND SAMPLES AS.... Saves the multi file

under a new name, and all samples into a subfolder with
the program name

SAVE AS DEFAULT MULTI: Saves the current multi

to be the default multi. The default multi is loaded
whenever the Falcon plug-in or standalone application is
first launched. This provides a useful method for loading
a custom set of sounds, effects, event processors, and so
on every time you use Falcon.

CLEARING
« CLEAR MULTI: Clears the multi (empties all parts).

R f[k Load Multi

Recent Multis k
Save Multi 38 M
S5ave Multi as... £r3EM

Save Multi And Samples as...
Save as default Multi
Clear Multi

Mew Program
Load Program

Recent Programs b
Save Program 885
Save Program And Samples

S5ave Program as... {1 385

Save Program And Samples as...
Save Program Samples
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Falcon’s general settings are
configured in the Preferences
window. To open the Preferences,
choose Preferences from the menu
in the Toolbar.

Falcon Preferences

T

General Streaming SoundBanks 0sC
Sample drag'n'drop mode One Shot
Warn of unsaved changes V' Enabled

Part colouring scheme Grey

Use OpenGL renderer On/Off

GENERAL

When you drag and drop samples into a program, by
default the sample will play back for as long as the

note is held. Enable the One Shot option for SAMPLE
DRAG’N’DROP MODE to instead import all samples as
one shot by default. To change an individual sample to
One Shot, see [Interface > Main > Sample Editor].

Each part displays a color in multiple places throughout
Falcon. Choosing Chromatic for PART COLOURING
SCHEME will assign each new part a random color;
choosing Grey will assign all parts the same shade of

grey.

Falcon’s Ul can be rendered with OpenGL, which can
help with overall performance by offloading some of
the processing needed to draw the Ul from the CPU to
the GPU. To enable OpenGL rendering, enable the USE
OPENGL RENDERER checkbox. For best results when
using OpenGL rendering on Windows, make sure to
update to the latest drivers for your graphics card.

Falcon Preferences

e

General Streaming SoundBanks 0sC

Hard drive type V‘EI’)’ fast - SSD v
Cache Size f 40 MB
Default Apply
STREAMING

Rather than loading an entire sample into memory,
samples may be read (streamed) from disk as they

are played. This can improve overall performance by
balancing resources between your computer’s RAM
and its disk drives. That said, streaming performance is
directly affected by the speed of the disk, so the faster
the disk, the better.

The default settings are optimized for most use cases.
To adjust the settings for your computer, choose the
appropriate Hard drive type and Cache size. To confirm
your changes, press the Apply button. To revert to the
default settings, press the Default button.

For details on enabling or disable streaming for individual

parts, see [Interface > Main > Edit > Program].
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Falcon Preferences

-
=

General Streaming SoundBanks 0sC

search path indexed recursive automount

[Library/Application Support/UVISoundBanks v
fUsers/nreeves/Library/Application Support/UVISoundBanks ¥

Volumes/Projects/Sound/Samples/UVI v v
/Volumes/Projects/Sound/Samples/AcousticSamples ¥ v v
{Volumes/Projects/Sound/Samples/ViLabs v v v
{Volumes/Projects/Sound/Samples v v v
T T | S T [ e e v
SOUNDBANKS

Each SEARCH PATH is a location on your computer that
will be scanned for sound libraries. To add or change

a search path, press the “...” button and browse for the
desired folder. You can also select a path and type to
add a new path or edit an existing one. To delete a path,
select the path name, press the Delete key, then press

the Return key.

Each search path has the following options:

- INDEXED: Any supported files found in the search
path will be indexed for searching in the File Browser.
For details on searching, see [Interface > Main > File
Browser].

« RECURSIVE: The search path directory itself and any
subfolders within it will be searched. (When disabled,
only the search path directory itself will be searched.)
Note: this can significantly increase Falcon’s startup time.

« AUTO-MOUNT: Any UFS soundbanks in the search path
will be auto-mounted in the File Browser.

Falcon Preferences

General Streaming SoundBanks 0sC
Open Sound Control Server On/Off
Desired Name Falcon
Desired UDP Port 0
ZeroConf Name

UDP Port

osC

Open Sound Control (OSC) is a protocol used to
communicate between different computers and other
audio devices, optimized for use with networked devices.
Falcon can be controlled remotely by any app or device
that supports OSC.

Enabling the Open Sound Control Server will begin
broadcasting Falcon as an OSC destination. DESIRED
NAME and DESIRED UDP PORT set the preferred name
and port for the current Falcon instance. Once the OSC
server is running, ZEROCONF NAME and UDP PORT
show the actual name and port assigned to the current
Falcon instance.

For more details on using OSC in Falcon, see [Interface >
Main > Modulation Editor > Automation assignments].

For general information on OSC, see:
http://opensoundcontrol.org
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LEARNING FALCON
SYNTHESIS

The following section will illustrate
the basics of using Falcon, from
loading and saving patches to
creating a number of common
sounds and instrument setups
from scratch. It’s a perfect place to
start if you’re new to Falcon and

need some quick tips to get going.

Falcon’s synthesis engine offers
a wide range of tools for playing,
editing, and creating instruments
and samples. You can freely

mix sounds created with pure
synthesis and sample playback
even in the same program. Each

of Falcon’s oscillator types has a
different speciality; only a few of

the possibilities are explored here.

Before continuing, check that
you have your audio and MIDI
devices connected and working
properly. Additionally, some of the
following examples use programs
and samples from UVI factory
soundbanks. It’'s recommended
to have both the “Falcon Factory.
ufs” and “UVI Tutorial Set.ufs”
soundbanks available to follow
along with all of the examples.

TOPICS:

101 WORKING WITH PRESETS

 [0) SAVING A USER PROGRAM

103 SAVING A USER MULTI

104 MAKE A SIMPLE SYNTH

105 MAKE AN ARPEGGIATED SYNTH

106 MAKE AN EVOLVING PAD

107 MAKE AN INTERACTIVE WOBBLE BASS
108 MAKE A DRUM KIT FROM SAMPLES
109 MAKE A DRUM KIT FROM A LOOP

110 MAKE A DRUM KIT FROM SYNTHESIS
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@) FALCON
4 PARTS
(Z) FALCON
PARTS
Default Multi
Empty -
u1250
3 i] 1 1] Main Out uvl AP-09
UWI Electro Suite
= | 1 UV String Machines
UVl Tutorial Set
Urban Suite
Urban X
VV_BeatBox Anthology
W_CS-M
1 WW_DarkLight llx
VV_Digital Synsations

VW_Drumulation
VV_Emulation 2

LOADING AND TWEAKING A PRESET

Let’s start by loading a sound from one of Falcon’s
included soundbanks. Double-click part name
(“Empty”) in the Parts List to open the File Browser.

The factory soundbanks will appear in the
Soundbanks section of the File Browser. Select
the UVI TUTORIAL SET soundbank, then UVI
PRESETS > ELECTRIC PIANO.

Press OK or double-click the program name to load
it, and the Main view now displays the parameters
of the loaded program. The Info tab shows the
“front panel” of the program with macro controls for
commonly-used settings, and the Edit tab shows all
of the program’s parameters.

Let’'s go to the INFO tab first. Here we can see
the instrument’s macro controls and an on-screen

Loops-Rex
UVI Presets

Loops-Rex

TP 12000 @ W >
> || Analog Strings 3 INo
» | slectric piane

Jazzy Drumkit ’

Spanish Guitar ,

Synth Bass & Synth

’ Default Multi MAIN | MIXER  PERF oo TAP 12000 & | ®

N Electric Piano

LLCALAL LR

’ \
v \
v, \ /
v, N ,
7 N
’ N 4
s N ’
B e Amp. Be ~ Reverb D /
~
7 &) - ¢ - ‘
v,

“Analag Strings , i )

Electric Flamo — N 7

Jazzy Drumkit %

Spanish Guitar

Synth Bass & Synth

keyboard. Press the keys on the keyboard to trigger
a note, or play a note from your MIDI controller. You
should hear the instrument now; if not, check your
Audio and MIDI settings.

To see a description of the instrument, press the Info

9

I” button in the upper right.

Let's make some changes to the program, by
adjusting the REVERB and DRIVE macro controls.
Click a knob and drag to adjust it. You can also
hover over a control and scroll your mouse scroll
wheel, or scroll with your trackpad.

That’s a start, but to dig in a little deeper, let’s switch
to the EDIT tab. Here we can see the settings for
the major components of the instrument: program,
layer, keygroup, and oscillator. Additionally, the
Sample Editor, Mapping Editor, and Modulation

P

- N EDIT 5
¥ I PROGRAM ® fx
/
7/ ] ,
Gain - —Pan- ~ Streaming
N NS
- 1 ':D\\
U 6 \\
- AN
*® LAYER(S) N O]

¥ KEYGROUP(S) vi ®
Gain » Pan ! I_:_I:_II.:.. Dn
A OSCILLATORIS) (=)

Editor provide editing of sample files, the mapping
of the layers and keygroups, and modulation
assignments.

Let’'s make some edits to the instrument. To change

6
the program’s output level and panning, go to the
PROGRAM section and adjust the GAIN and PAN
settings.

7 Let’s also change the instrument from polyphonic to

monophonic. Go to the LAYER section and change
Play Mode mode to MONO PORTAMENTO, and
adjust GLIDE TIME to change the amount of “slide”
between notes.

N
' Play o> Glids
Mode FOIY % i “"‘% Constar
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\
Recent Multis ',
Save Multi
Save Multi as... '
Save Multi And Samples as...
@ Save as default Multj
Clear Multi

~ Mew Program

“  Load Program
Recent Programs
Save Program .
Save Program And Samples

s

Default Multi

I Electric Piano %

Empty Part |
Delete Part
Duplicate Part',

Load Program ',
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Save as default Multi
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MNew Program
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Select All

Invert Selection
¥ il MAPPING Root

Create Keygroup
Create Keygroup in New Layer

MAKE A SIMPLE SYNTH

Now that we've looked at editing existing sounds,
let’s start creating some new ones from scratch.

In an empty part, go to the Main > Edit view. In the
MAPPING EDITOR, right-click and choose CREATE
KEYGROUP > SYNTH TEMPLATE.

A new keygroup has been created, mapped to the
full key and velocity range.

Play a few notes, and you'll hear a simple sine
wave oscillator. Let’s change that to a sawtooth
wave, by clicking the WAVEFORM and choosing
SAWTOOTH from the menu.

We can continue building our sound by editing the
other synth engine parameters, such as enabling
Stereo mode and adding additional voices.

MAKE A SIMPLE SYNTH

¥ I MAPPING Root: €3 Key: C-2G8 Vel 1127 Vol: 0.00dB  Pan: Center Fine Tune: 0 Cents

ALLLLALLLLILLLLLILULLE LY LULLLILLLILILLL UL LILLLE L]
2

osc ) ANALOG
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®A Voices Stereo

7 .
Sample Template Expopéntial ¥
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A
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- \
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7 1 >
B
- T PWM

. -
~ . -~
W SN, -
AN A -

To stack multiple synth sounds, we can add a

L second synth keygroup. Let’'s choose CREATE
KEYGROUP > SYNTH TEMPLATE a second time,
and another keygroup will be stacked on top of

5 the first. For this keygroup, let’s choose one of the
oscillator’s factory presets, such as “ACCORDION.”

6 Perhaps instead of stacking these sounds, this

could be a split program instead, with one sound
for the left hand and another for the right hand. To
do that, we’ll need to adjust the key ranges of the
keygroups so they don’t overlap. Right-click in the
Mapping Editor and choose SELECT ALL, then
choose RESOLVE OVERLAPPING KEY RANGE.

The keygroups can now be easily edited separately.
For example, the key and velocity ranges could

be further adjusted by dragging the edge of the
keygroup.

80s
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Phasing saw pad
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¥ X MAPPING Root: €3 HKey: C-2G8 Vel 1127 Vol: 0.00dB  Pan: Center

Auto Reduce Key Ranges _ -
Resolve Overlapping Key Range hit i

Resolve Overlapping Velocity Range % 31 I I I I I I I I I I I I I I I I I
®F

Move Keygroups To Front
Move Keygroups To Back 1]

LLLLL

Edit Layer Rules HE

¥ I MAPPING 1127 Vel: 0.00dB  Pan: Center  FineTune: 0Cents

Root: €3 Key: -~ Vel

LLLLLLUCLL LU DL LU UULL R LU

77



@

An
2 Samka

W Synthédsis
1

~ Analog

ﬂn%lug Stack
y Drul&n

FM %__

~ Noise Tt
L

Organ N %

~ Pluck

i MAPPING

Wavetable

MAKE AN ARPEGGIATED SYNTH

Falcon has numerous synthesis options in addition

to the classic virtual analog oscillator we’ve already
seen. Let’s explore the FM (frequency modulation)

synth oscillator, using one of the factory presets as
a starting point.

Open the right-hand sidebar and choose the

1
OSCILLATORS TAB. Expand the Synthesis folder,
and drag the FM oscillator to the MAPPING
EDITOR.

2 While playing a few notes, press the next or

previous buttons in the oscillator module to browse
the presets. Let’s choose the EP HOLLOW preset
and build from there.

The FM oscillator has four operators (A, B, C, and
D), and each operator’s frequency is a ratio to the

LLLLLULCLL L TLLR)

LEARNING FALCON 105: MAKE AN ARPEGGIATED SYNTH

h M
A ] c
Hz 1 Fina Hz 1 Fine Hz 1 Fine
Oc Oc
Phase Phase a1
I 4 000 i 4/ noo f%_ FALT g
%1.00 S %1.00 S %1.00 i
Level Level Level
* 1.00 L 1.00 A 1.00

base note. For example, a ratio of 2.0 means the
frequency is doubled, or one octave up from the
base note. Whole integers and simple ratios (3/2,
4/3, etc.) create some of the more obvious harmonic
relationships, but the ratios are fully adjustable

and small changes can create interesting and
unexpected results. Let’s set OPERATOR C TO 2.17
and OPERATOR D TO 1.17 and hear the difference.

The operators can also be arranged in a variety
of topologies. Using the same ratios, different
topologies can change the sound drastically.

To change the topology, press on the topology
diagram in the lower right and choose a topology
from the menu. For example, change the
TOPOLOGY from #8 to #7.

Now that we’ve customized the sound source, let’s
make it more dynamic by adding an arpeggiator.

1 Fine

Oc

Phase
i 0.00

Snap

L 1.00

Default % -
N

Feedback

0.00%

1

-

Oy

A0-G)

N
b

N

Default
Accordion

~. BassSoft

\Eell Toybox

Ch\cﬂr\FemaIe
Chord Sine min7911
EP Express\‘\

v EP Hollow %
EP
Marimba
Organ Reggae

78



@

LEARNING FALCON 105: MAKE AN ARPEGGIATED SYNTH (PART 2)

MAIN MIXER PERF TAP 12000 & ® >

EVENTS MOD5

Switch to the EVENTS tab, press the + button, and
choose Arpeggiator.

To load one of the factory presets, press on the
PRESET MENU and choose one from the menu.
Let’'s choose one of the sequenced pitch presets,
such as ARPEGGIATOR > LINE > HIGH MUSE.

Press and hold a few keys to hear the arpeggiated
sequence. There are actually three layers to the
arpeggiator: note velocity, pitch, and MIDI CC. To
view the different layers, RIGHT-CLICK THE STEP
GRID and choose the layer from the menu.

Let’'s use the MIDI CC layer to generate a control
source for modulating the FM operators. Switch to
the MIDI CC layer, then press and drag across the
step grid to enter step values.

Dafault

~
Arp Bastco -
Arp Creative S

Chords
Line
Triplet

S
3
S
*
3

) ARPEGGIATOR

Trigger Mode Mode Octave Mode Resolution
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Pac Man Win
Pastrami
Pro Seq
Psychaotic
Symptome
Three03
Thrilled 7
3 Then choose a MIDI CC for the arpeggiator to
output; a general purpose MIDI CC such as 16 is a
good choice.
9 Switch back to the EDIT view, right-click the

FEEDBACK knob, and choose MIDI LEARN. In the
pop-up, choose MIDI CC 16 from the menu.

Press and hold a note, and you'll see the value
automating in sync with the arpeggiator sequence.
Let’s also slow the tempo down just a bit. Since the
arpeggiator is tempo-synced, it will automatically
adjust when Falcon’s tempo changes.
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L Select All =A
Invert Selection 1581
¥ i3I MAPPING
Create Keygroup
% Create Keygroup in New Layer »
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~
~
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Sample Template
Synth Templaua,%

-

I

MAKE AN EVOLVING PAD
Now let’s build a pad sound, one that evolves over
time by using modulation to create movement.

In an empty part, create a new synth keygroup.

This time, let’s use the Analog Stack synth; press on
the oscillator name and choose Analog Stack from
the menu to change the synth type.

The Analog Stack starts with the same basic options
as the Analog oscillator type, but offers a unified
bank of eight oscillators for quickly created stacked
sounds.

Press the POWER button on oscillators 2 and 3
to enable them. Each oscillator has independent
controls for its waveform shape, gain, pain, pitch
offset, and so on.

/

ANALO%
Sampling \

osc () ANALOGSTACK

~ K:_R/
n n

IRCAM Granujar

IRCAM Multi Granular ’

IRCAM Scrub ! 7

IRCAM Stretch “

Sample 1 Start Phase 1 1
Slice \

Stretch 1

] ] ] ] B ]
Synthesis " I
Analog 1

Analog Stack ] ] ]
Drum

FM

Noise
Organ
Pluck
Wavetable

Let’s change the pitch of oscillator 2’s pitch offset to
be +7 SEMITONES from oscillator 1, and oscillator 3
to be +1 OCTAVE.

We can also modulate each oscillator
independently. To add a new modulation source for
the oscillator 2 pulse width modulation, right-click its
PWM knob and choose ADD MODULATION.

We want to modulate this per-voice, so we'll
create a keygroup modulation source by choosing
INTERNAL > KEYGROUP > NEW LFO.

The new modulation source now appears in the
MODULATION EDITOR. If you don’t see the
Modulation Editor, make sure that its toggle button
is enabled at the top of the Edit view, and that it's
expanded with the arrow next to its name.

 osc1

ANALOG 5TACK

th oscz

/\/5

d Modulation

Editxh'l\odulatians
~

M osca

Default

MIDI Learn
Modulation Wheel

Velocity
Mono Velocity

Release Velocity
I Key
» Key Follow
Linear Key Follow
Poly Aftertouch

~
Assign to Ho\sthgomation »  Channel Aftertouch

MIDI Learn

Assign To Macro

0sC

~

SS External
= MIRIcC
Voice ™ ~ -
Other S S

k

Internal
Program
Layer
Keygroup

*  Amp. Env [DAHDSR]
bk
y  New AHD

= ~ _New Analog ADSR
New Attack Decay
*  New DARDSR
k New Drunk N

4 New LFO
New Multi Envelo

New Step Emvelope

v .l MODULATION
U] LFO 1[LFO)

g0 O rror = =

\\// :
0.00 0.50 Hz

— SUB: None

Depth Delay Rise Smooth

A Y / / /

100.00% 0s 0s 0s

Default v

Trigger Mode

LA Retrigger ~
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LEARNING FALCON 106: MAKE AN EVOLVING PAD (PART

Jll MODULATION

(U] LFO 1 [LFO] —I% Nnne

e~ U] h LFo1 - = ’

/\ Phase Freq 7/ Depth
’
’
b
\\\\\\mk__,rr///// - t:sr -
0.00 0,15 Hz 100.00%

Play a note and you’ll hear the LFO modulating
PWM; this LFO is modulating it too drastically,
though, so let's edit it.

Change the DEPTH TO 0.25, play a note again,
and you’ll hear that its intensity has been reduced.

We can also slow down the LFO speed, to 0.15 HZ.

Let’s do the same with oscillator 3 PWM, but with a
different LFO.

Create another LFO, and set its frequency to be
different than the first LFO. This will create a sound
that shifts and evolves over time. In this way, we
can continue to build up the sound by adding
modulation to each oscillator’s parameters, such as
pan, phase, or pitch.

ll"
(I  ANALOGSTACK
Default hd .
th osca h osc2 t osca MIDI Learn
Modulation Wheel
Triggar lods A, A, A, Velocity
it Retrigger 4 \/, 4 Mono Velocity
54 Release Velocity
[ ey 1 Key
: N - % Add Modulation ¥  Key Follow
\Ldithdodulations Linear Key Follow
A . Bag Poly Aftertouch
I I — — ﬁssign\t&H\ost automation » Channel Aftertouch
Tay ~ External
MIDI Learn S~
~ . MDCC ¥ Amp. Env [DAHDSR]
o Weicg 3
Assign To Macro 2 Other ~ <. , New AHD
S~ _  New Analog ADSR
0sC y temal ~ New Attack Decay
Program L New DAHQSR
Layer ¥ MNew Drunk > A
Keygroup ] New LFO
New Multi Enw
New Step Envelope
J4ll MODULATION all
U] LFO 2 [LFO) | E SUB: None
. . /
g0 th M Lroz2 - ,/ = Default -
//—“*\ Phase Freq /’ Depth Delay Rise Smooth
y \-.\ \ . Trigger Mode
AN / ’ % A ’ ’ ’ Bipolar Retrigger ¥
S~ 0.00 0.20 Hz 100.00% 0s 0s 0s
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¥ & LAYER(S) ® fx
2 P Glide Ui Clttai
Gain - Pan Mode Mono Retrig % I:“'_ * Constant v ,',U'I_':_' 1 'Iu; i} ' ot
0} HNALO% 4
Sampling \ MIDI Learn
Modulation Wheel
RCAM \Granaan ) ()  WAVETABLE 5c () WAVETABLE = u.:t — % Default
A7 rcam mulh Granutar T - v e UNISON Voices 1 Stereo
IRCAM Scrub - P !
IRCAM Strett‘h o . e % Sine \ evalde—= 3 ¥ -~ - E::ase Velocity Smoothing Wave Spread Sterao Spread Deatune
Sa_mple 1 - 0.00% Sawtooth \ b Carnivora Hardmonics Add Modulation E Key Follow Index
slice \ / Sina N " Edit Modulations Linear Key Faollow e ’ -
Stretch | Phase Dist Square \ " ’ Poly Aftertouch
Synthesis '| : i Triangle \\ > Chew Gum wat i % Assign to Host automation *  Channel Aftertouch e 0.00% 10.00% 10.00%
Analog “ Bend+ o Multi ‘\ M ol i B8 pipi Learn External - Exponential ¥ Standard ¥
Analog Stack 1 Phase Dist Mode \ — a1 i P MIDI CC L4 Phase Spread Spread Mode Detune Mode
Drum . Analog \ = ~ ¥ Classic Talking Kurde Assign To Macro »  Voice b
M \ Bass %’ » Other 3
Noise ‘| 3 Dist ’ i , Internal
Organ \ Imaaes » Cute growl Licker Hard P—— X
Pluck | 1 Layer »
Wavetable % Keygroup >
MAKE AN INTERACTIVE WOBBLE BASS SOUND Play and hold a note to audition the wavetable.
Falcon’s modulation engine provides endless While holding the note, adjust the WAVE INDEX to
opportunities for customizing and modifying sounds. change the active waveform within the wavetable.
Let’s create a wobble bass that we can tweak in This is a good control to adjust in realtime while = p = — s — ——
realtime from our MIDI controller. playing, so let’s assign the Mod Wheel as a
modulator. e
1 As with the previous examples start with a clean “IIIIII“III“III“I"I“II”III“III“III“III“III'
patch, create a new Synth Template keygroup and 4 Right-click the Wave Index knob and choose ADD | :
Jll MODULATION ol
change the Analog oscillator to WAVETABLE. MODULATION > MODULATION WHEEL. o MIDI CC 1 = SUB: ) None
2 We also want this sound to be monophonic, so in 5 The new modulation assignment now appears in the 5 D CC 1
the Layers section, change the Play Mode from Poly Modulation Editor. (If you don’t see the Modulation
to MONO RETRIGGER. Editor, make sure that its toggle button is enabled at
the top of the Edit view, and that it's expanded with
To change the wavetable, press on the menu above the arrow next to its name.)
3 :
the waveform and choose from the menu. Let’s

choose MULTI > BASS > INSECT.



LEARNING FALCON 107: MAKE AN INTERACTIVE WOBBLE BASS (PART 2)

LLLLLUUCLL DU L) UL

v Jll MODULATION
0] MIDI CC 1 (] — %

MIDICC 1

Each modulation assignment has a ratio slider that
defines how the modulation source maps to its
assigned parameter. By default the full range of the
mod wheel will map to the full range of the Wave
Index knob, but in this case we'd like the mod wheel
to sweep over only half of the Wave Index range.
So, to halve the range, adjust the MIDI CC 1 RATIO
SLIDER TO 0.5.

Now let's add a low pass filter. To add a filter, go to
the KEYGROUP > EFFECTS LANE and press the +
button, and choose FILTER > LOWPASS 12.

To create the wobbling effect, we can modulate
the cutoff frequency with an LFO. Set the CUTOFF
FREQUENCY near the upper end of the its range,
then right-click, choose ADD MODULATION, and
add a new LFO.

MODULATION WHEEL.

Play a note now, and you won’t hear the LFO
applied any more. As you raise the mod wheel, the
LFO modulation will be increasingly applied, along
with the Wave Index modulation we assigned to the
mod wheel earlier.

¥ & KEYGROUP(S) ¥ 5 KEYGROUP(S)
Gain - Pan ! Gain - Pan '
F 2 FX { LowPASS12
¥ M DS%L ~ Reverb »
S~ o Analog Filter
S~ o : . Cutoff
] it ch = - _Biquad Filter
it o — " Brickwall Filter Add Modularion
' Equalizer k TS  Edit Modulations
th Amp / Stereo . Comb Filters Rar
Drive / Distortion » Crossover Filte® ﬁssign\thgst automation b
: LowPass 12 Tay
Dynamic 3 -
LowPass 24 R S
Miscellaneous 3 One ije Assign To Macro
Legacy FX . Rez Filter
SVF A
UVI Filter
7 Vowel Filter
LELTED
Xpander Filter
9 On the new LFO, uncheck its BIPOLAR option, then
set its modulation ratio to -0.5. A unipolar LFO will -
modulate in only one direction, and a negative ratio
means that direction will be downward. 9
Play a note, and you’ll hear the cutoff frequency
sweeping downward with the LFO. The LFO is
applied as a constant modulation, however. To apply
the LFO modulation selectively with the modulation
wheel, add the mod wheel as a sub-modulation
% source. Right-click on the SUB menu and choose

Tu-:;-|-.- On

MIDI Learn
Maodulation Wheel
Velocity

Mono Velocity
Release Velocity
Key

Key Follow

Linear Key Follow
Poly Aftertouch
Channel Aftertouch

External
~ . MDICC ¥ Amp. Env [DAHDSR]
p Vol " New AHD
Other  ~ < _ C o
S~ MNew Analog ADSR
¥ Internal = New Attack Decay
Program » New DhHQSR
Layer b New Drunk > A
Keygroup »  MNew LFO 8
New Multi Enw
New Step Emvelope
||"
= %— _______ SUB None
T = Default -
Freq Depth Delay Rise Smooth TS ~
~
N
1 i S Trigger Mode
\ ; 7 ; Blpﬂla% 99 -
Retrigger -
0.50 Hz 100.00% Os 0s Os
MIDI Learn
Modulation Wheel
Velocity _ - <
Mono Valotity
_ . - Release Velocity
SUB: None ¥ N------~—"" Key
Add Modulation ¥ Key Follow
Edit Modulations Linear Key Follow
Poly Aftertouch
Assign to Host automation » Channel Aftertouch
MIDI Learn External
10 MIDI CC 3
Assign To Macro b Voice [
Other b
0SC » Internal
Program 2
Layer 2
Keygroup 2
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LEARNING FALCON 103: MAKE A DRUM KIT FROM SAMPLES

\ DEVSND Bent 808
DEVSND Broken Santur 1

\ DEVSND Cwejman Kits
\ DEVSND Modded 2600

\ Driven Machine Drums Chi-Jack Kit 2
% Driven Machine Drums MD
N

Driven Machii

i MAPPING
~ gr'wen Machii ‘
GlitchMachin

-~ -

Hiss and a Ro:

—————————— 1

Ignatius

NASA

M CnB-BreakBeat-04.wav

MAKE A DRUM KIT FROM SAMPLES

Creating new programs from samples is just as easy
as creating a synth-based program. Most of Falcon’s
controls are used in the same way whether you're
using synth oscillators or sample files. Let’s create a
drum kit from sample files.

Open the right-hand sidebar and use the
BROWSER tab to locate a folder containing some
drum samples on your system.

Select the drum samples you want to use and drag
them onto the MAPPING EDITOR.

Now let’s set the imported samples to be “one shot”
samples, so that the entire sample will be played
back when the note is triggered.

¥ i MAPPING Root: €3 Key: C€3-€C3 Vel 1127 Vol: o0.00d - 1127 Vol: o0.00d

% - veigle J>eeuvieud neyyroup e
~
~

~
-~

Move Ke;grBuTJ 0. _

LILL st LU LU

Invert Selection S

N
Create Keygroup S »

Create Kevaroup in New Laver Sh

. _
-

! %'ﬂ&t'&h‘ T =/ Appy-to-all .g_sc_ill_ators

SAMPLE (12}

2 . DCnB-BreakBeat-01.wav -

! I I I I l I I I I ! I I I Il lﬂ 'EnB—Bmgk_B_a_at_—E!!.wav . 3
IR Impulses hﬂ“t-ﬂ A wav v

MNormalize samples
Truncate samples
Reverse samples

Print samples crossfade
Set playback type
Apply FX

3 Choose SELECT ALL from the MAPPING EDITOR
MENU, then press the BATCH button and choose

(@) FALCON ’

SET PLAYBACK TYPE > SET AS ONE SHOT. ol =®:

..........

We might also want to adjust the settings of
individual samples. For example, if a sample needs —
to be panned or have its pitch adjusted, select the
keygroup and then edit the value in the Mapping

Editor’s toolbar.

Lastly, let’s set an exclusive group for the hi-hat ade
sounds. This will mimic the natural behavior of hi- Sync
hat sounds cutting each other off, such as a hi-hat

closing and cutting off a ringing open hi-hat.

Immediate

4 Select the hi-hat keygroups, then set EX. GROUP
to 1in the Keygroup section.

=

F ~ Remqve loop/Disable one shot

Set forward lobp N

Set alternate loop

~

» Set as one shot %

Set reversed
Set forward

oo ™ 100 & m >

sssaEd »

.........

Immediste v

Ex.
Group
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LEARNING FALCON 109: MAKE A DRUM KIT FROM A LOOP
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MAKE A DRUM KIT FROM A LOOP

Drum loops often provide great source material

for building a drum Kit, especially if the loop has
distinct hits where the different kit elements aren’t
overlapped. By slicing and mapping the hits in the
loop, we can easily take a single loop and turn it into
a full kit.

Let’s start by loading a drum loop into an empty
part. Navigate to the UVI TUTORIAL SET
soundbank and double-click LOOPS-REX > 100-
HIP HOP BEAT.RX2.

You'll see that the sample is loaded within the
SLICE oscillator, with slices marked at each
transient. Press Play in Falcon, and the slices are
played back in sync with Falcon’s tempo.

096-DrumLoop.rx2
100-Funk Bass.rx2
100-Hip Hop Beat.rx2
1Dﬂ—Shaker£xL =
Ircam Prepared Piano = ~ — = — — _ _ _ - 110-Irmdidh Voice.rx2

0

Start

/

SLICE

R

P—Ppp——r—+={BFALCON

PLAYBACK TREE

Speed Map

INSTRUMENT Part1 ¥

1 3 fx 1
% WF Master

® Automation

0 0.00% Auto Play A e os
% SIGNATURE: 4/4 * BARS: 2 BEATS: © BPM: MIDICCy
MIDI CC 10
MIDI €C 11

# 100-Hip Hop Beat.rx2
Pitch Bend
¥ Layer [t ] s
4 ¥ Mapped % (M ] s ]

You can convert these slices to separate
keygroups, in order that each slice can be triggered
independently. Press the MAP button, and a new
layer will be created with the slices mapped to
individual keys.

The original keygroup containing the loop will still
be present in a muted layer. To hide it, open the
TREE view and select only the “MAPPED” layer.

Play a few notes on your keyboard to trigger

the new sliced keygroups. You can now easily
rearrange the slices to the mapping of your choice,
such as a standard drum mapping.

Each slice from the mapped loop is actually referring
back to the original sample, with custom start and
end markers to define the slice within the larger
sample.

) SAMPLE

MAPPING

G3

G3 G3 / 1127

3 S
\\ C N
N ut N

\ Copy

\ Select All \
Deselect All \

Crop \

Delete \
Normalize \
Silence 1

0.0C G3-G3

Fade Out
Apply FX

Play Selection

6 Set as One Shot
Create Loop

To adjust the slice boundaries, select a KEYGROUP
to toggle the Sample oscillator view and then grab
the “S” (start) or “E” (end) markers and drag them as
desired.

DOUBLE-CLICK THE SAMPLE WAVEFORM
between the start and end markers to select it, from
here you can RIGHT-CLICK to reveal a number of
common wave editor commands such as reverse,
normalize, fade in/out and silence. Changes made
here still reference the original file so they will effect
all slices.

Slices can be tweaked and tuned in limitless ways.
Try changing the sample oscillator type to Stretch
and adjusting the Tempo Factor, or adding effects to
a specific keygroup to effect only one slice, or at the
layer level to effect them all.

Reverse
Fade In

Change Playing Direction to Reverse

®X

n
(2]

BA

*®D

.
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MAKE A DRUM KIT WITH SYNTHESIS

Instead of starting with a looped sample or a
collection of sampled drum hits, we can also create
entirely new drum sounds from scratch with Falcon’s
Drum synth oscillator.

Open the right-hand sidebar and choose the
Oscillators tab. Expand the SYNTHESIS > DRUM
folders, and you'll see all of the drum synth oscillator
presets.

Before we get started zoom in a bit in the MAPPING
EDITOR to see the key range we're going to focus
on in greater detail. Click the + button on the bottom
right of the editor to zoom in.

Let’s start by adding the BD preset ‘BD SAVING’
to cover the range BO to C1. As you drag-and-drop,
the vertical position within the Mapping Editor

N

determines the key range of the keygroup, with
wider ranges set near the top and narrower ranges
near the bottom.

The Drum oscillator consists of two sound
generators, a pitched oscillator and a noise
generator. The two can be independently edited,
then the mix between the two is set the with the
Mixer. The Master section adjusts the combined
signal, with EQ, distortion, and other settings.

To give the kick a little more edge, let’s change the
Oscillator waveform from sine to TRIANGLE, and

move the OSC/NOISE SLIDER to add a little noise.

Now let’s import the ‘SD MANIAC’ preset from
the SD folder to D1, and play a few notes to see
how the kick and snare sound. Let’'s bump up the
DISTORTION, and lower the Q on the noise filter.

e

() DRUM BD Saving v
0sc MIXER NOISE MASTER
Waveform Pitch Modulation A MNoise Filter Amp Vel Sens Output
/‘\ Exponential ¥ Y l\\- EQGain |
(h DRUM
OsC MIXER
4 Wavefarm Pitch Modulation Amp Moise
N —
N Exponential ¥
“u =
- - - A N e
e ol T
-
| =
Frequency Rate Depth A D 05C
SD Low Acoustic
SD Low TR
i MAPPING D1 D1-D1 SD Mall
SD Maniac /]
= -
_SD Matic
| T -7 =< SD Mocrate
- - SD New Wave
k SD O Nine
| . I I ! . I SD Otian
SD Ruff
SD Sand
SD Smoke
5
5D Maniac b
MNOISE MASTER
¥ Amp Vel Sens Output
T EQ Gain - -1
EQ Freq |

Volume I
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[EARNING FALCON 110: MAKE A DRUM KIT WITH SYNTHESIS (PART 2)

6 Electric Tom

ElecTom 1H
- ElecTom 2M
i1 MAPPING F1 F1-F1

ElecTom 3L

Hypra Tom

Kitch Tommy

Large Tom
_____ MNoisyTam™ ~

Plastic Tom
Raymmons Tom
Slam Tom High

Slam Tom Low

For toms, let’s drag over a preset from the Electric
Tom folder, ‘LARGE TOM’, to F1.

We can then tune the tom with the oscillator
FREQUENCY SLIDER.

To use this customized tom as the starting point for
additional toms, right-click the keygroup and choose
“DUPLICATE SELECTED KEYGROUP.”

The duplicated keygroup will initially appear stacked
on top of the existing one; grab the new keygroup
and drag it over to G1, then adjust its frequency to
change the tom’s pitch.

To change the length of time the toms ring out let’s
tweak their amplitude envelope. If it’s not already
displayed, toggle visibility of the Modulation Editor
with its button in the upper right of the Edit view.

F1

(h DRUM

Waveform Fi

P
ST

10

1"

12

'--..\\_/..--

N
auency

F1-F1

Llw e :
Exl 1 SelectAll eA

Then click and drag a selection over each of the
tom keygroups, then click on the “AMP. ENV” tab

in the MODULATION EDITOR. When you adjust
the envelope’s RELEASE knob, you'll be editing the
release time for all of the selected keygroups.

We can also use the Drum oscillator for synth lead
or bass sounds. For example, drag in a preset
from the Synth folder, such as ‘CLEAN SYNTH’, to
cover the range C2 TO C3. Moving this keygroup
to a separate layer will give us more flexibility with
effects routing and other program settings, so let’s
move the keygroup.

Right-click the synth keygroup in the Mapping Editor
and choose MOVE KEYGROUP TO > NEW LAYER.

Undo: Oscillator Drag'n'Drop xz

Duplicate Selected Keygroup > o%xD
Cut Selected Keygroup PN
-

Copy Selected Keygroup . ®C
Pt G1

_Appky

Delete Selected Keygroup o, B

9

Deselect All D
Invert Selection i3]

v i MAPPING - — 1127 0.00dB

10
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Synth
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I
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1
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NN
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all
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Default -

1 Dynamic Trigger Made
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1

1 Trigger
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Undo: Keygroup Resize *z
Duplicate Selected Keygroup %D
Cut Selected Keygroup X
Copy Selected Keygroup =C
Paste Keygroup v
Apply Keygroup Template T
Delete Selected Keygroup a®
Paste Keygroup to »
Move Keygroup to »

New Layer Select All =A
Deselect All #D
Invert Selection ol

Create Keygroup
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LEARNING FALCON 200):
EFFECTS + MODULATION

Falcon has an extensive selection
of audio effects and modulation
sources that can be configured

in both simple and extremely
complex ways to achieve powerful
effects. The majority of these
modules all function based on

a similar set of principles and
interactions.

If you’ve followed the examples in
the previous chapter you should
already be familiar with the basic
concepts and use of effects and
modulators in Falcon. Here we'll
build on that experience and
explore some ways to further
enhance your ability to both
design sound and get hands-on
with your patches.

For a detailed overview of each
effect module and modulation
source please consult:
Appendix: Modules > Effects, and

Appendix: Modules > Modulations.

TOPICS:

201 USING DUAL DELAY

202 USING SPARKVERB

203 USING EFFECTS RACKS
204 USING MACROS

205 USING HOST AUTOMATION
206 USING STEP ENVELOPES
207 USING MULTI ENVELOPES
208 USING OSC
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LEARNING FALCON 207: USING DUAL DELAY

EFFECTS EFFECTS
1 loiey De od N Master ¥ Part1 Y] Re:rVL:a% &9 Master N Part1 N# Retro Lead
I M Multi FX _ M Multi Fx
Obese Lead ® ANALOGTAPERELAY- - - - - _ _ _ () DUAL DELAY
Philicorlead Delavlﬁ s~~~ L ~ Alter Echo
Reduce Solo Reverb Analog Tape Delay » Basic Stereg
Modulatiol Dual Delay 4 Delta Trail %
Retro Lead Filter » Default Dub Utility 4
Sample&Hold Lead % Equalizer L 1 Stereo Delay ¥  HPLand Eight
Saw Classic A"_ﬂp / St‘?mo _ L 2 Mono Delay »  Long Four
Drive / Distortion 3 Short - Reverbish »  LP Eight Dot Stereo
Sine Equanone Dynamic , 4 Mods »  Magic B .
Analysis » 5 Special FX » DELAY MODULATION FILTERS
2 Miscellaneous L Time LR Feedback LR Fr Depth Low cut Hin]h/m’t
Legacy FX ’ — == 7 7|\ 1.00Cents - 7
RETRCT re= QG
e XOS0 p0gn, MW '%”-W“Z 1.60kHz 20,00 kHz
317
USING DUAL DELAY 4 The Stereo and Phase graphs are the centerpiece
Dual Delay is a delay effects module that is capable of the Dual Delay interface. As you adjust the
of a wide range of time-based effects, from classic parameters below, the graphs are updated in
delays to reverb-like decays to more unusual realtime. Let’s turn the DELAY > FEEDBACK knob
effects, with an immersive interface to visualize the up to 70%, you will see both the number of delay
stereo and phase adjustments being made. taps and their magnitude increase.
Let’s start with a LEAD preset from the FALCON 5 Time and Feedback can be the same for the left
FACTORY soundbank, find and double-click and right channels, or one channel can be shifted
‘RETRO LEAD’ to load it. relative to the other. Turn the TIME L/R knob
counter-clockwise to “L X 0.50” and you will see
Switch to the EFFECTS tab, right-click the Analog the left channel delay taps are half the duration of
Tape Delay effect header and choose the DUAL the right channel delay taps.
DELAY > BASIC STEREO preset.
6 Let's add some gentle pitch modulation to our

First lets increase DELAY > TIME to “1/4“ for a more
pronounced delay effect. The delay time can be
specified in milliseconds, or in bars/beats if tempo-
sync is enabled (as it is here).

sound to give it a chorusing effect. Change
MODULATION > DEPTH to “1.00 CENTS" and
MODULATION > RATE to “0.1 HZ".

Feedback

]

]
i
Default 7.4 %
= -
A % 5 My Preset g W Delay™ \
W T == e e e == T
’ Analog Tapge Delay
/ Dual Delay
7 \
, 1 Stereo Pelay
; / 2 Mono Delay
/ 3 Short - Rdverbish
Ve \
4 Mods \
Phase 5 Special FX \ 9
\
User Presets N
ROTATION WIDTH MIX My Preset
v Input Input Dry [ Wet Reverb [:g
0.00% rJ o 100.00% 1 Modulation
1 Output Output 1ET
0.00% */ 100.00%

0.00

50.00% Equalizer

Now let’s adjust the filter to clean up the low
frequency content, set FILTERS > LOW CUT to
“1.6 KHZ”.

Once you have the effect where you like it you
can save it’s state as a preset. In the upper right of
the effect module, press the Preset File menu and
choose SAVE PRESET, and enter a name for the
preset, here we'll title it “MY PRESET”.

You'll now see your custom presets in the Browser,
within a User Presets folder alongside the factory
presets for the module.
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USING SPARKVERB

SparkVerb is a unique and versatile reverb with

an extraordinarily light CPU footprint. A single Size
parameter emulates room reflections from 4m to
50m while Decay can be shaped globally and with
independent low and high frequency multipliers,
each with adjustable crossovers.

Let’s create a quick set of loops using the UVI
TUTORIAL SET soundbank. Navigate to it and

create new parts for 096-DRUMLOOP, 100-FUNK

BASS and 100-SHAKER by dragging them over to

the parts list. If the loops aren’t playing automatically
hit Play in Falcon’s header or in your DAWSs transport

if you're using Falcon as a plugin.

Now that we have some loops let’s put SparkVerb
on an Aux channel. This will allow us to use 1
instance of SparkVerb for as many parts as we

MAIN MIKEl] PERF

2
Aux
- Delay =
N
Modulation
Filter
Equalizer

Amp [ Stereo
Drive [ Distortion
Dynamic
Analysis
Miscellaneous
Legacy FX

096-DrumLoopurx2  100-Funk Bass.rx2 | 100-Shaker.rx2

i

|

I

|
AAANA

|

i |

|

I

I
AMAA

- %
.
s

¥ = Biffusion _ Default Ambience Ro«
IReverb »~ DI Mak — - _ _ _ _ » _ Drum-Roor -
SparkVerb » 02 - Plate

03 - Large to Endless

04 - Vocal

L Drunken Room
»
»
05 - Room »
»
»
»
»

Hi Room
Large Room
Machine Room
06 - Drums - Percussions .

Medium Room
07 - Ensemble - Chorus

08 - FX - Sound Design

09 - Shimmer

Metal Room

* v ¥ *r v v v v v |w

like. Click the MIXER button in Falcon’s header to
change the current view. Now we can see our 3
instrument parts on the left and 4 aux channels and
the master on the right.

Click the + button at the top of the AUX1 channel
and select REVERB > SPARKVERB > 05 - ROOM
> AMBIENCE ROOM, you should now see the
SparkVerb interface at the top.

At the center of the SparkVerb interface is the
spectral display. frequency is mapped across the X
axis (low to high) and decay time along the Y axis.

Since we’ve instanced SparkVerb on an effect bus
let’s turn the MIX amount up to “100%”, as we’ll
control the wet amount with individual track sends.

(), SPARKVERB

%Roou

’ Size
1839m

+" Shape
68.00%

Pre-delay

- 0 ms

High ¥ Density

MODULATION
Depth Rate Mode
) - Bright ¥

0,00 Cents  %0.34

Ambience Room v

SPECTRAL DECAY OUTPUT
Mix
4 100.00%
v Width
54.80%
& Rolloff
4.75 kHz
| e— =
DECAY DIFFUSION
LoDecay Crossover Decay Crossover HiDecay
. & ’ \ 1
X082  28.58 Hz 3.693 526kHz  x0.90

Let’'s send some signal from our 3 loops over to
SparkVerb. Set the Aux1 sends for them as “-“16DB”,
“-60DB” and “-30DB”, respectively. We can now
hear all three tracks effected by the reverb.

Now, finally, lets toggle SparkVerb’s POWER
button on/off to A/B the results. From here, we can
continue exploring SparkVerb’s settings and if we
find one that works well that we want to save, we
can make a preset to recall later.

You can also create interesting textures from
SparVerb’s decay with its Freeze function. For
example, while a drum loop is playing, press the
Freeze button just after a snare hit — the decay will
hold indefinitely, even if the drum loop stops. That
decay will be held until Freeze is disabled.
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= Layer1 Add FX » S~ Align bottom T

Align Horlzontally

Assign To Effect Rack Macro Ty »%Add new Macro

- = AStreetLight

- Copy Layout fHHC
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DisplayMame ,, Style LowPass 24 (!J
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USING EFFECT RACKS

Delay %

Let’s add a delay and a filter to chain 1,

If you want to change the layout of the Macro panel

The Effect Rack is a special kind of effect module 2 ANALOG TAPE DELAY and LOWPASS 24. hit ctrl-e (cmnd-e on OS X) to enter EDIT MODE.
that creates a new effects path inline where the Select both macro knobs and right-click over the
Effect Rack module is added, similar to patching in Enable the Modulation Editor by clicking the background for helpful layout options. You can also
an external rack of effects from a mixing console. 3 VISIBILITY TOGGLE in the EDIT TOOLBAR. add a custom background by dragging an image
Macros can then be added for “front-panel” control onto the panel. Hit ctrl-e (cmnd-e) again to exit Edit
of the effects in the Effect Rack’s FX chain. 4 Now right-click the DELAY knob in the Analog Tape mode when your changes are complete.
Delay effect and select ‘ASSIGN EFFECT RACK
To see it in action load a program, then switch the MACRO > ADD NEW MACRO’. In the Editor below To set the overall level of the FX chain, adjust the
EFFECTS Tab and add an EFFECT RACK. you will see the Macro modulator we just created FX Chain’s VOLUME SLIDER in the Tree view.
along with all of its editable parameters. Locate
When the Effect Rack is added, it doesn’t add any a field titled ‘DISPLAYNAME’, double-click and We can even add whole additional FX chains to a
audio processing on its own; instead, it creates rename it to ‘Delay’. Do the same for the filter cutoff, single Effect Rack for parallel processing. To do this
a new FX chain. Navigate to the TREE tab and renaming it CUTOFF’. right-click the Effect Rack in Tree view and select
toggle open the our new Effect Rack. Inside we see ‘ADD FX CHAIN’.
‘Chain?’, can right-click this chain to add as many 5 Now let's head back to the Effect Rack “front panel”

effects as we like.

by selecting the Effect Rack in the Tree view. Now
we see our two macros and the names we set for
them.

If you save an Effect Rack preset, the settings for all
of its loaded effects will also be saved along with all
macro assignments and customizations.
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¥ 2 PROGRAM

The Step Envelope is a programmable envelope
for creating time-based effects, and makes a great
programmable pattern sequencer.

A good way to understand the Step Envelope

is to use it to modulate keygroup gain. Load the
ANALOG STRINGS from the UVI TUTORIAL SETS
soundbank.

Right-click the KEYGROUP GAIN knob and choose
ADD MODULATION > KEYGROUP > STEP
ENVELOPE. Play a few notes, and you'll hear the
signal gated on the empty steps, and full volume on
the steps with full bars.

Each step doesn’t have to be fully on or fully off,

EDIT

Pan

Pan

Gain " i !
% ‘Add Modulation

Edit Modulations — - —

Clear Modulations

Assign to Host automation

MIDI Learn

Assign To Macro

0sC

[
UV Tutorial Set Gain J
L -R =
e ¥ ¥ LAYER(S)
BB UVIPresets
Analog Strings Gain -
Electric Piano % :
Jazzy Drumkit ¥ ¥ KEYGROUP(S)
1 Spanish Guitar
Synth Bass & Synth
¥ M OSCILL
52 Pitch
USING STEP ENVELOPES

however — you can continuously adjust the value of

each step between the two.

Linear Key Follow

Channel Aftertouch

External

MIDI CC
Voice
Other

Internal

- Program

Layer™ =

Keygroup

Freq

Amp. Env [DAHDSR]
Filter Env [DAHDSR]
Pitch Env [DAHDSR]

, LFO1[LFO) Steps
LFO2 [LFO) =L

b 3
New AHD =) Freq

New Analog ADSR L

New Attack Decay
=~ - _ "  NewDAHDSR
P NewDwnk
New LFO < Steps
i = 8 16
MNew Multi Envelope N

p New Step Envelope %

Freg
1/18

Adjust the value of a few steps to be HALF or
QUARTER, and you’ll hear an effect similar to
delay feedback taps. You can also apply smoothing
between steps to avoid transitions that are too
abrupt, pop/click, and so on.

You can also configure the number of steps, as well
as the length (in Hertz, or in bars/beats when the
module is tempo-synced). When the Step Envelope
is tempo-synced, the number of steps is often set
to a multiple of the number of beats in the current
time signature. However, non-multiples can result
in interesting, shifting patterns that don’t obviously
loop.

To enable TEMO-SYNC for the Step Envelope click
the sync icon in the MODULATION HEADER.

: O Filtert 0 : M vFo (UL () StepEnvi %Efk i
A s ipola - %
4 16
Smo
Poly Aftertouch 1716 A0S
= Trigger Mode

Bipolar
_ No Retrigger ¥
RN Smoaath Interpolation Mode
% /) os Hold v

i Tri Maod
Bipolar N\~ 2o 2oc8
Ho\natrigger b

N
Smoath Interpolation Mode

| Spline ‘% v

Tempo-syncing can be especially helpful if the
envelope is modulating pitch, as can be the Bipolar
option. Enabling Bipolar mode puts zero in the
center and values can step above to +1 or below

to -1. To set the pitch range for the envelope, adjust
the modulation ratio. For example, with a ratio of +12
and the Bipolar option enabled, the envelope with
modulate +1 octave (12 semitones).

You can also create LFO-like patterns that glide
smoothly from step to step. With Interpolation Mode
set to SPLINE, a continuous line is interpolated from
the individual bars, creating a continuously variable
modulation source that’s suited for pitch sweeps,
wobbles, and so on.

Be sure to explore the Step Envelope preset folders,
as they contain over 1,000 ready-to-use patterns.
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LEARNING FALCON 300):

EVENTS

We've looked at ways to create
and effect sounds and we’ve

looked at ways to modulate them,

now lets take a look at Event
Processors.

Event modules can generally

be thought of as MIDI effects,
processing incoming MIDI signals
or generating them, though with
the Scipt Processor it's possible
to extend that paradigm to
include extremely sophisticated
creative devices and interface
customization.

The most commonly used Event
processors are the Arpeggiator,
MicroTuner and MIDI filters like the
Chorder, Harmonizer and Strum.
These are easily mastered devices

providing great performance utility.

In the following chapter we’ll take
a look at a few of these devices
and some of the ways that we can
effectively implement them in our
own projects.

TOPICS:

301 USING THE ARPEGGIATOR

302 USING THE MICROTUNER

303 USING THE SCRIPT PROCESSOR
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USING THE ARPEGGIATOR

The Arpeggiator is a classic synthesizer effect
which modifies the incoming notes and plays them
in @ programmable pattern to create a dynamic
sequence.

Let’s start by loading the ELECTRIC PIANO
program from the UVI TUTORIAL SET soundbank.

In EDIT mode change the play mode to POLY
PORTAMENTO.

Switch over to the EVENTS tab, hit the + button
and select the ARPEGGIATOR > ARP BASIC > 2
OCTAVE UP preset.

Since the Arpeggiator is always tempo-synced,
the number of steps is often set to a multiple of
the number of beats in the current time signature.

EFFECTS EVENTS EFFECTS EVENTS )\ MODS all B
Electric Piano k V= = e ’%
S e e S S S S
U] \ U]
(b ARPEGGIATOR
Play I - Glic

Mode Poly S Tim Trigger Mode Mode Octave Mode Resolution

Poly S~ Legato ¥ Up ¥  RepeatPattern ¥ 1/8
~

Pn'y Poriaments [ & Arp/Vel. Blend ; Octave ‘JH—\'} Step Length
Mono Retrigger \ 26.87% 2 \ ~/ 100.00%

Mono Portamento
Mono Portamento Slide

1 Fine 1 i
Gain

However, especially when layered, non-multiples
can result in interesting patterns without obviously
loop points.

Let’s slow the SPEED down to 1/8 and add a few
more steps to this pattern. Change NUMSTEPS to 9
and enable step 9 by clicking the STEP STATE box
underneath it, so that steps 1, 2, 3, 4, 6, 8, and 9 are
On and steps 5 and 7 are Off.

Now let’s customize the value of these steps, adjust
the VELOCITY amount by click-dragging in the
graph, and modify the GATE by shift-click-dragging.

To give the pattern a more defined groove let's
change NUM STRIKE to 2 and shift-click the STEP
STATE button on step 7 to merge it with the step
before it.

Num Strike

0 0 0 0 0 0 0 0
= = = = [m] = [m] =

2 Octave Up - 4
Repeat bottom MIDI CC
Repeat top Off ¥
~
e NumSteps Groove Amnt
- 9 ¥ 0.00%
!
1
7
/
7
& ARPEGGIATOR
Trigger Mode Mode Octave Mode Resolution
Legato ¥ Up ¥ RepeatPattern ¥ 1/8
{ & Arp/Vel. Blend 2" Octave (= \ Step Length Num Strike

\ ~/ 100.00% ¢ 1

\ 26.87% 2

\
0 0 0 0 0 0 0 0 0
N
~
~
~
~
~
~

N |

= = = = O = a = EI%

¢ ARPEGGIATOR

Trigger Mode Mode Octave Mode Resolution
Legato ¥ Up ¥ RepeatPattern ¥ 1/8 v
(< Arp/Vel. Blend 2| Octave . \"& Step Length (= Nurm Strike
\ 26.87% -] \ ./ 100.00% t 2
0 0 0 0 0 o 0 0 0,
1
/
/
/
’
] o |
[ ,
= = = O = E% = =

Hold
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7 () ARPEGGIATOR 2 Octave Up -
Trigger Mode Mode Octave Mode Resolution Hold Repeat bottom MIDICC
Legato ¥ Up ¥  RepeatPattern ¥ 1/8 Repeat top off v
F Arp/Vel, Blend » ) Octave Step Length F Nurn Strike NumSteps Groove Amnt
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k/ Velocity
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. ] MR
= CT} [ [ O [ = =] =
The number of notes played is a combination of 7 The Arpeggiator has three layers: Velocity and Pitch

the Octave, Repeat Top, Repeat Bottom, and Num
Strike parameters. The Octave parameter takes
each triggered note and adds octaves of the same
note above or below it. Repeat Top and Repeat
Bottom will repeat the lowest or highest played note
an additional time. Num Strike sets the number of
consecutive strikes for every note.

The play mode determines how the arpeggiator
cycles through the played notes (and any repeated
notes and octaves). For example, if the play mode

is “Up & Down”, the lowest note will be played first
and cycle up to the highest, then cycle down to

the lowest. So if C2, F2, and G2 are held, they will
be played as C2, F2, G2, F2, C2, F2, and so on.

The “Chord” play mode is notable because all held
notes are played at once, rather than cycled; the on/
off state, velocity, and pitch values are still applied.

for notes, and MIDI CC for generating a MIDI CC as
an additional control signal. Right-click the step grid
to change which layer is displayed. The step state
(on, off, or merged) is shared between the three
layers, but the velocity, pitch, and MIDI CC value for
the step is independent.

The Pitch layer has a range of +48 semitones (4
octaves), with zero in the center. The pitch value
of each step is also displayed above the step grid,
as is always visible regardless of the layer you're
currently viewing.

The MIDI CC layer is useful for generating an
additional modulation source, especially one that
is also cyclical. For example, you could modulate
the cutoff frequency of a filter in sync with the note
pattern of the arpeggiator; in this way, the MIDI CC

layer can be thought of as a kind of user-defined
LFO. To choose which MIDI CC is generated by the
Arpeggiator, set the MIDI CC menu.
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& Part1 S ; ® Automation _ 1 item, §
Add Madulation Source » MIDI Player -2 0.00 114 2.04 2.94 4.08 4.98 6.12 7.02 8.16 9.06 9.96  11.10 =
MIDI S . Micro T Micro Tuner o -1 12.00 13.14 1404 1494 16.08 1698 1812  19.02  20.16 2106 21.96  23.10
MIDI D cro_tuner - % ¢ Part1 % BE 0 2400 2514 2604 2694 28.08 2898 3012  3L02 3216 3306  33.96  35.10 pyth_12.scl
MID| Script Processo M ces 1 36.00 3704 3804 3894  40.08 4098 4212  43.02 4416 4506 _ 4596— —470 | '
MiDIcc 10 2 4800 49.4 5004 50.94 5208 5298 5412 55.02 5616 — S.06  57.96  59.10
MIDi CC 11 3 60.00 6114 6204 6294 64.08 64.98 6612 6702 “68.16  69.06  69.96 7110
2 4 72.00 73.14 74.04 74.94 76.08 76.98 78.12 J9.02 80.16 81.06 81.96 83.10
5 84.00 85.14 B6.04 B6.94 88.08 B8.98 90.12 %.02 92.16 93.06 93.96 95.10
6 96.00 57.14 98.04 98.94 100.08 100.98 102.12 103.02 104.16 105.06 105.96 107.10
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5
USING THE MICRO TUNER 2 Double-click the new MicroTuner to reveal it in the 4 Save this document as “pyth_12.scl” (UTF-8
The Micro Tuner allows the exploration of many EVENTS editor to the right. In it’s default state the encoding) and drag the resulting file onto your
unique and interesting temperaments, both modern MicroTuner doesn’t do anything. From here we MicroTuner. You can save this as a MicroTuner
and classical. It also allows ethnic instruments to be could load an existing preset, but for this example preset and it will be available for future projects.
played in their natural tuning. we're going to use a custom Scala file.
5 Now change the GLOBAL TUNE in Falcon’s header
For this example we’re going to create an instance Let’s create a new Scala file to describe 12-tone to 430.5 HZ. With A4 tuned to 430.5 Hz, C4 will
of Falcon in 12-tone Pythagorean temperament with Pythagorean temperament. Create a new text be at 256 Hz. This would be a good time to save
C4 at 256Hz. Pythagorean tuning is based on a document and paste in the following: out the Multi if you wanted to create a template or
stack of intervals called perfect fifths, each tuned in even ‘Save as Default Multi’ if you consistently use a
the ratio 3:2, and creates exceptional harmonics. . ! pyth_12.scl particular tuning.
1
12-tone Pythagorean scale
Navigate to the TREE tab, right-click the MASTER ,12 Now lets load a patch to hear the results, something
node and select ADD EVENT PROCESSOR > 3}887/2048 with a long release, try PADS > BEAUTY IS SIMPLE
MICROTUNER. Placing the MicroTuner at the 32/27 2 from the FALCON FACTORY soundbank.
Master level means that all parts in Falcon will be 2%64
effected, this is a great way to ensure that any and ;72/512 There are many MicroTuner presets that come
all instruments loaded or created from here on out 6561/4096 with Falcon, and that can be expanded easily with
. : 27/16 ,
will be in tune. 1579 custom Scala files.
243/128
2/1
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function onNotele)
if printe
print("0n
end
postEvent{e)

end

function onRe

if printer.va

print("0ff:

end
postEvent{e)
end

USING THE SCRIPT PROCESSOR

The Script Processor module provides custom
event processing capabilities, using the Lua-based
scripting language UVIScript.

The Script Processor module has two primary sets
of controls: the standard controls for interacting
with the script itself, and the controls defined by the
loaded script (knobs, buttons, menus, and so on).

Let’s load the Spanish Guitar program from the UVI
Tutorial Set soundbank. Then go to the MAIN >
EVENTS tab, add the Script Processor module, then
load the PERFORMANCE > STRUM preset.

This script has one parameter, Lag, with a value
range of 1to 200 ms. Adjust LAG and play a chord,
and you’ll hear the notes played in succession as if
strummed rather than triggered all at once.

%) printer.lua

printer = OnOffButton("Print", true)

- -

L]
= 0]

Strum = T
Strum.lua k

57 GE available

* printerlua

Falcon includes numerous factory preset scripts
for a variety of purposes, such as automatic
harmonization, unison voice generation, MIDI CC
filtering, and more. You can also write your own
scripts to further customize Falcon.

Let’s start with a simple script that prints some
information about each note to the Script
Proccessor console. Enter the following code into a
text editor and save the file as “printer.lua”:

printer = OnOffButton(“Print”, true)

function onNote(e)

if printer.value == true then
print(“on : «, e)

end

postEvent(e)

end

function onRelease(e)

if printer.value == true then
print(“off: «, e)

end

postEvent(e)

end

- OFF:

4 OfF:

Master ]
SCRIPT PROCESSOR

Part 1 Y]

EVENTS a1

Spanish Guitar
Strum -

printer.ua =

Print ’——_,‘% %

-

type=144
type=ldd
type=128
type=128
type=144
type=ldd
type=128
type=128

tune=8 vol=1
tune=@ vol=l
tune=8 vol=1
tune=@ vol=l
tune=8 vol=1
tune=@ vol=l
tune=8 vol=1
tune=@ vol=l

velocity=1 pan=@ channel=l input=1 id=userdata: @x1lebfl@c8 note=73 5
velocity=17 pan=@ chonnel=1l input=1 id=userdata: Bx1lec2@c68 note=67
velocity=@ paon=8 channel=l input=1 id=userdata: @xllec2®ct8 note=67
velocity=@ pan=@ channels=l input=1 id=userdata: @x1lebfl@c8 note=73
velocity=1 pan=@ channel=1l input=1 id=userdata: @xllebfe568 note=76
velocity=29 pan=@ chonnel=1l input=1 id=userdata: @x1lebffa@8 note=88
velocity=@ pan=8 channel=1 input=1 id=userdata: @xllebffa@8 note=88
velocity=@ pon=@ channels=l input=1 id=userdata: @x1llebfe568 note=76

In the Script Processor module, press the LOAD

4 SCRIPT button on the left and choose the “printer.
lua” file.
5 Then enable the “SHOW CONSOLE OUTPUT”

option, which is generally used for displaying debug
messages, and play a few notes—you will see that
as each note is triggered and released, a line of
information about the note is printed to the console
so long as the script’s PRINT button is enabled.

If you disable the Print button, the messages no
longer print to the console.
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SAMPLE

The Sample oscillator uses the
traditional method of audio sample
playback. When a sample is
triggered at a pitch higher than its
base note, the sample is played
back more quickly; when below its
base note, the sample is played
back more slowly.

O

©

SAMPLE

Sample Start Interpolation Mode

Standard - Allow Streaming

SAMPLE START sets the starting point for playback
when the sample is triggered, as a percentage of the
time between the Sample Start and Sample End markers

in the sample file (see: [Interface > Main > Sample Editor]).

The INTERPOLATION MODE sets the quality of the
transposition. Choosing Lo-fi will reduce the amount
of processing needed to transpose the file compared
to Standard mode, and likewise choosing Best will
increase the processing overhead. (For other styles of
transposition, try the other sampling oscillators as well.)

When ALLOW STREAMING is enabled, the sample will
be streamed from disk if the program has Streaming
enabled. When disabled, the sample will always be
played from memory and not streamed from disk, even if
Streaming is enabled for the program.

Default

bridge rain seed.wav
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SLICE

The Slice oscillator is ideal for
percussive or strongly rhythmic
samples which can be sliced into
discrete sections. Slices of the
sample can be played back in the
original order, or rearranged to
create new sounds.

¢

SLICE 3, Default -

b

Start

!

(1]

SIGMATURE:

s Il»- F F “__ﬂb ::cid Beat 5

PLAYBACK DETECTION EXTENSION ENVELOPE
Speed Map Audition Maode

Imported v
Amount

Sensitivity
#ync Time

0.00% Auto Play position ¥ I

4/4 ¥ BARS: 1 BEATS: O BPM: 113.61 ®l v Drag & Drop:

TEMPO

To set the loop’s tempo, choose its TIME SIGNATURE
and enter the loop’s duration in BARS and BEATS. The
BPM field will update as you change the other tempo
parameters.

If you'd like to playback the loop at a multiple of its
original tempo, use the TEMPO FACTOR parameter for
coarse speed adjustments (up to 4x faster or slower).

DETECTION

The MARKERS setting determines whether to use slices
already saved in the file (imported) or the slices you've
defined (user markers). Loops in UVI soundbanks will
have imported slices, as will common loop formats such
as REX and Apple Loop files.

If you choose to create your own slices, use the
SENSITIVITY slider to automatically detect and create
slices. At the far left, slices will be created only by very
prominent beats and there will be a small number of
slices; at the far right, slices will be created by more

Export

subtle variations in the sample and there will be a larger
number of slices.

To add a slice manually, double-click in the space
between the sample’s waveform and the time ruler. You
can also add multiple slices at once on divisions of the
musical grid by right-clicking, choosing ADD MARKERS
WITH GRID SETTING, and choosing a beat division
such as eighth note.

Existing slices can be moved by clicking and dragging
anywhere along the slice. To protect a slice from being
edited, right-click the slice and choose LOCK. The slice
can be ignored by right-clicking it and choosing MUTE,
or it can be removed entirely with DELETE.

PLAYBACK

A single slice can be auditioned by clicking anywhere
on its waveform. When a slice is selected, you can also
use the forward/back AUDITION buttons to audition
the next/previous slice. The Audition play and stop
buttons can be used to playback the entire file. When
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SLICE

AUTOPLAY is enabled, the loop will be triggered when
Falcon’s playback begins. (This button is the same as the
AutoPlay button in the Parts List.)

SYNC determines how the loop interacts with Falcon’s
tempo and playback position. When set to “position,”
the sample is played back at Falcon’s tempo and also
locks to its playback position; in “tempo” mode, only the
tempo is matched. When set to “off,” Falcon’s tempo and
playback position are ignored and the sample is played
back at its original tempo.

In all Sync modes, the START control sets the slice
where playback begins when the loop is triggered,

with zero being the first slice in the loop. The SPEED
parameter adjusts the loop’s playback tempo, up to 50%
faster or slower.

For MAP, see: Exporting and converting the loop.

EXTENSION

When the loop’s playback tempo is slower than its
original tempo, you can choose to extend the slices so
that the loop is still continuous. With SLICE EXTENSION
set to AUTO, extension of the slices will be configured
automatically. When disabled, use the AMOUNT

and TIME parameters to fine-tune how the slices are
extended.

ENVELOPE

You can also optionally enable a slice envelope. When
enabled with the ENVELOPE button, the ATTACK,
HOLD, DECAY, SUSTAIN parameters adjust an
amplitude envelope that is applied to each slice as it is
triggered.

EXPORTING AND CONVERTING THE LOOP

The entire loop can be exported as a new audio file

with the WAV button. When you press on it and drag, it
creates a new audio file that can be dragged to your host
application or desktop. The new audio file is created with
all of the current settings applied: tempo, envelope, etc.

Or, to export the slices with each as an individual audio
file, choose EXPORT and specify the folder where the
samples will be saved. To save a program with the slices
mapped to individual keys, press on the PART button
and drag it to the Parts List or to the desktop or other
folder.

If you would prefer to create a new layer in the current
program rather than a separate program, press the MAP
button in the Playback section. This will Mute and MIDI
Mute the original layer, and create a new layer with the
slices mapped to individual keys.

This will also change the audio drag & drop button to a
MIDI button. When you press on it and drag, it creates a
MIDI file that can be dragged to your host application or
desktop. The MIDI file triggers the slices in their original
order and timing, which you can then edit for new
arrangements of the slices.
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osc {1} STRETCH o

STRETCH

The Stretch oscillator pitch-shifts
the sample when triggered above
or below its root key, but keeps

the speed of the sample constant.

Default -

lamentation.wav

PLAYBACK SAMPLE TEMPO ANALYSIS
Tempo Factor Tempo Fine - Graln Slza
118.00 =

Sample Start ] ] o

; 0.00% Legato Solo Mode P
Sync Sensitvity

#
tempo b 1.00 0,00% 1.00

The Stretch oscillator will pitch-shift the sample +2
octaves from its root key. Beyond that range the pitch
will be constant, even if the keygroup’s key range
extends further.

PLAYBACK

SAMPLE START sets the starting point for playback
when the sample is triggered, as a percentage of the
time between the Sample Start and Sample End markers
in the sample file (see: [Interface > Main > Sample Editor]).

Additionally, when LEGATO MODE is enabled, if a new
note re-triggers the sample, playback will continue from
the current sample position but at the new pitch. With
Legato mode disabled, playback will always begin from
the sample’s start position.

SAMPLE TEMPO

Although the speed of sample playback is constant
across its key range, setting the SYNC mode to
“TEMPO” will sync the sample’s playback speed to
Falcon’s tempo. Set the sample’s base tempo with the

TEMPO field, which can be modified with the TEMPO
FACTOR (£ 400%) and TEMPO FINE (+ 50%) controls.

ANALYSIS

To fine-tune the pitch-shifting, adjust the GRAIN SIZE
and SENSITIVITY parameters. For highly rhythmic or
percussive material, try increasing Sensitivity for better
transient preservation. Additionally, if a sample contains
a solo instrument, try enabling SOLO MODE for the best
pitch-shifting; for polyphonic samples, turn off

Solo Mode.
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IRCAM GRANULAR

The IRCAM Granular oscillator
uses granular synthesis to create
a wide range of sounds. The audio
sample is divided into small grains
which are then re-combined and
played back in new ways to create
realistic pitch shifting or as the
basis for a textured soundscape.

SIEe
v/ 500ms

Window
Triangle

w
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{) IRCAM GRANULAR

GRAIN
Dansity i Jitter Pitch Variation
*/ 10.00 51.09% 4 0.00 Cents ¢
Fade 1 Symimetry Pitch Correction o
- 100,00 % 30.00% Period ¥

The GRAIN section configures the shape of the grains.

SIZE sets the duration of the grains. DENSITY
determines how many grains will be played at once,
with 1.00 representing standard playback. With values
less than 1.00, there will be silence between the grains
with a rhythmic result similar to tremolo; with values over
1.00, there is increasingly more overlap of grains with

a harmonic result similar to a chorus or sometimes a

ring modulator. JITTER varies the consistency of grain
playback timing.

FADE sets the amount of the grain affected by the

fades of the grain envelope’s attack and decay, as a
percentage of the full grain size. At the default 100%, the
full grain can be faded, which results in a triangle-shaped
envelope. At less than 100%, there is a plateau in the
middle, resulting in @ more trapezoidal envelope.

a4, Dense slow .. =
E
- =5
084-Vinyl 7
POSITION
Position Variation Loop Mode
0.00% * / 107 ms Mone v
Speed Direction
0.25 *J 1.0

SYMMETRY changes the skew of the grain window

by balancing the grain envelope attack and decay, as

percentages of the grain size:

« 0% sets an attack of 0% and decay of 100%, this results
in more percussive grains

« 50% sets an attack of 50% and decay of 50%; this is the
standard, balanced window

+ 100% sets an attack of 100% and decay of 0% means;
this results in reversed grains

WINDOW sets the shape of the window (an envelope
applied to the signal when creating grains); choose from
Triangle, Hanning or Welch curves, or Square.

PITCH VARIATION adds randomization to the pitch of
each grain, from minor variations of a few cents to an
entire octave.

PITCH CORRECTION sets how grains will be
transposed. The Grain Size option keeps grain size
constant, while the Period option adjusts the size of
the grain.
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IRCAM GRANULAR

POSITION
The POSITION section controls determine the playback
position in the sample file.

POSITION determines the starting point for playback, as
a percentage of the duration between the sample start
and end markers. With Speed set at or near zero, this
can be used to manually scrub to any location within the
file. POSITION VARIATION adds randomization to the
current position, with a range of zero to 500 ms from the
current position.

SPEED sets the scrubbing speed factor, with 1.00 as
normal speed, zero as staying in place on the current
grain, and 10.00 as 10x faster. DIRECTION sets the
direction of scrubbing, from +1.0 for fully forward to -1.0
for fully reverse.

If there is a loop in the audio file, the Loop Mode sets

how it will be handled:
NONE: The loop will be ignored

- FORWARD: The looped section is played forward; when
playback reaches the end of the loop, playback begins
again from the loop start point
FORWARD-BACKWARD: The looped section is played
alternately forward (from the loop start to loop end) and
reverse (from loop end to loop start)
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(h  IRCAM MULTI GRANULAR 3, Default -

e —] E
|

IRCAM MULTI GRANULAR

The IRCAM Multi Granular
oscillator is @ multi-voice variant
of the IRCAM Granular oscillator.
Each voice can be varied in
multiple ways to achieve a range
of unison effects.

The VOICES section set the voice-specific settings.
VOICES sets the number of unison voices. With a single
voice, the result will be similar to the standard IRCAM
Granular oscillator.

The other Voice controls set relative variations for each
voice; TIME SPREAD adjusts the timing of each voice’s
trigger, and POSITION SPREAD sets the position within
the sample file.

GRAIN
The GRAIN section shapes the grains themselves. Most

of the GRAIN parameters are the same for the IRCAM

Multi Granular oscillator as the IRCAM Granular oscillator;

for details, see: [Appendix A: Modules > Oscillators >
IRCAM Granular].

. SIZE

- DENSITY

- JITTER

- WINDOW

- FADE

VOICES GRAIN POSITION
¥ Voices 8 Size # Dansity R Pitch Variation ~ Pasition \ Randam

5 14.0 ms 2.26 sibdiking " . 0.69 Cents 37.76% 11.2ms
[ Position Spread @ Jitter F Duration Variation Pitch Correction Speed Direction

-

36.4 ms 73.02% 25.34% Period ¥ 0.01 - 1.00

Time Spread Window Fade 1 Symmetry

B.30% Welch v v/ 100.00% 50.00% v

VOICES - SYMMETRY

- PITCH VARIATION
+ PITCH CORRECTION

This module also has additional Grain settings not found
in IRCAM Granular:

DURATION VARIATION sets the amount of grain size
variation. Enable Reverse will reverse the individual
grains (not the overall playback direction, which is
controlled with Direction).

POSITION

The POSITION parameters are the same for the IRCAM
Multi Granular oscillator as the IRCAM Granular oscillator;
for details, see: [Appendix A: Modules > Oscillators >
IRCAM Granular].

. POSITION

- VARIATION

. SPEED

- DIRECTION

- LOOP MODE
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IRCAM SCRUB

The IRCAM Scrub oscillator is
similar in usage to IRCAM Granular,
with random-access scrubbing and
speed/direction control, but uses
the same top-quality algorithm as
the IRCAM Stretch oscillator. As
with IRCAM Stretch, this requires
more processing power than the
standard granular oscillator.

0

IRCAM SCRUB

Speed
1.00

PLAYBACK
Position Direction
- 0.00% - 1.00
PLAYBACK

The Playback parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Granular oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Granular > Position].

. SPEED

. POSITION

- DIRECTION

ANALYSIS

The Analysis parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Stretch > Analysis].

- WINDOW

- PADDING

. OVERLAP

AMALYSIS

Window

92.0 ms

Dafault -

—

perlencé.wav

OPTIONS
Padding Transiemnts
|
Envelope
Owerlap i
i Shape
OPTIONS

The Options parameters are the same for the IRCAM
Scrub oscillator as the IRCAM Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > IRCAM
Stretch > Options].

. TRANSIENTS

. SHAPE

. ENVELOPE

. STEREO
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¢h  IRCAM STRETCH o, Default -

1274A#-25teps Mix

IRCAM STRETCH

The IRCAM Stretch oscillator is
similar to the standard Stretch
oscillator, but uses very high
quality PhaseVocoder time-stretch
and pitch-shifting with transient
and envelope preservation. This
requires more processing power
than the standard pitch-shifting
used in other oscillators, so it

is best used when the source

SPEED sets the scrubbing speed factor, with 1.00 as
normal speed, zero as staying in place on the current
grain, and 10.00 as 10x faster.

SAMPLE START sets the starting point for playback
when the sample is triggered, as a percentage of the
time between the Sample Start and Sample End markers.

SAMPLE TEMPO

The tempo parameters are the same for the IRCAM
Stretch oscillator as the standard Stretch oscillator; for
details, see: [Appendix A: Modules > Oscillators > Stretch
> Sample Tempo].

PLAYBACK SAMPLE TEMPO AMALYSIS OPTIONS

127.79 1 Tempao Factor Window - Padding L —

1.00 x1
| Speed SampleStart o Envelope
' L
e ot Sync ] Tempo Fine 8 Overlap Stereo
tempo . 0.00% 92.0ms 4 Shape
PLAYBACK the fundamental note of the sample, with grain size twice

the duration of the fundamental.

PADDING sets the amount of oversampling, to x1 (no
oversampling), X2, or x4. As oversampling is processor
intensive, it's recommended to apply oversampling as
little as is necessary to reduce unwanted artifacts. Often,
no oversampling will be needed. OVERLAP sets the
relative amount of grain overlap. As with oversampling,
higher values are more processor intensive.

OPTIONS
There are four modes that can be toggled on or off to
best tailor the oscillator to the source sample:

SYNC - TRANSIENTS: Transient preservation; helpful for highly
material requires the highest TEMPO rhythmic or percussive samples, or any sample with
quality pitch shifting. TEMPO FACTOR strong transients

TEMPO FINE -« SHAPE: Shape preservation; helpful for preserving the

character of voices and other monophonic sounds

ANALYSIS - ENVELOPE: Envelope preservation; helpful for avoiding

WINDOW sets the size of the sampling window for grain
size. Grain size is optimally set to a size proportional to

unwanted pitch artifacts with some samples
- STEREO: Phase locks between stereo channels
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{h ANALOG

Waveform

ANALOG

The Analog oscillator is a classic
virtual analog synthesizer.

WM Start Phase Paolarity SynRc Shift

ANALDG HARDSYMNC

Voices Stereo

]

Uniform v

Phase Spread

The Analog section contains the primary oscillator
controls. WAVEFORM sets the shape of the waveform;
choose from saw, square, triangle, sine, noise, or pulse.
PWM (pulse width modulation) modifies the shape of the
waveform, and is often modulated with an LFO. START
PHASE adjusts the point in the waveform at which
playback will begin, and POLARITY reverses the polarity
of the waveform.

The Hard Sync section determines the phase sync
between voices. When SYNC is enabled, voices are
phase-synced to a control oscillator that is not displayed
or heard; SHIFT sets the amount of drift from the control
oscillator.

The Unison section sets the number of voices and

how they will be modified. VOICES sets the number of
simultaneous voices, and STEREO toggles between
mono and stereo. PHASE SPREAD sets the style of
phase spread for the voices. When stereo is enabled, the
STEREO SPREAD knob controls the amount of stereo
spread and the menu chooses the style of stereo spread.

UMISON

Uniform ~

Stereo Spread

Lead Unison.. =

Standard ¥

Detune

The DETUNE knob and menu adjust the amount and
style of pitch adjustment to each voice.
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h DRUM
0sC

Waveform

/\/ Sine

Freguency Rate

DRUM

The Drum oscillator is designed for
creating percussive sounds. There
are two sound sources: a pitched
oscillator and a noise generator.

Depth A

MIXER NOISE

iy N

05C Freguency Q Env

OSCILLATOR

The pitched oscillator begins with a WAVEFORM
SHAPE; choose from sine, triangle, saw, or pulse. Set
the base pitch of the oscillator with FREQUENCY, and
then use the PITCH MODULATION controls to further
adjust it. DEPTH sets the amount of modulation in
semitones, and RATE determines how quickly that pitch
range is modulated. The SHAPE of the modulation
can be exponential (a rapidly decaying envelope), sine
(traditional up and down LFO), or noise (semi-random
walk).

The AMPLITUDE ENVELOPE is a simple AD envelope,
with ATTACK and DECAY parameters.

NOISE

The Noise generator provides a FILTER. The Filter TYPE
can be set to low-pass, band-pass, or high-pass, and
both CUTOFF FREQUENCY and Q can be adjusted.

Pitch Modulation Amp MNoise Filter Amp

L |

o —i

Vel Sens

Drone Verse b
MASTER

Output
EQ Gain |
EQ Freq =]
Distortion ——I|

M Valume —

The AMPLITUDE ENVELOPE offers ATTACK and
DECAY, same as the pitched oscillator. Additionally, you
can choose a DECAY STYLE of exponential or linear;
exponential decay is more rapid at first, while linear
decay is a constant rate.

MIXER

The MIXER sets the relative levels for the oscillator and
noise generators. When centered, the two are mixed
together in equal amounts; drag the slider up or down for
relatively more or less of each sound source.

MASTER

The Master section provides overall adjustment and
effects for the oscillator: EQ GAIN, EQ FREQUENCY,
DISTORTION, and VOLUME.

VELOCITY SENSITIVITY levels can also be set

independently for Oscillator Volume, Oscillator Pitch
Modulation, and Noise Volume.
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Hz

¥ 1.0:0

FM

The FM oscillator is an FM
(frequency modulation) synth.

FM synthesis uses multiple signals
with frequencies in the audible
range to modulate each other

and create unique and complex
sounds.

FM
A

1 Fing
Oc
Phase

* 0,00

Snap

Lewvel

b 1.00

B c
Hz 1 Fina Hz 1 Fina
0c Oc
Phase Phase
/ ¢ | 000 / ¢ 000
x 1.00 Snap x 1.00 Snap
Lewvel Lawvel
* 1.00 b 1.00
OPERATORS

There are four operators. Each operator has a

RATIO which defines its frequency relative to the base
frequency. At 1.0, the frequencies are the same; at

2.0, the frequency of the operator is double the base
frequency; and so on.

The HZ toggle changes the operator from a relative ratio
frequency to an explicit frequency set in Hz.

The FINE control provides fine tune adjustment of
+/-1200 cents. If HZ mode is enabled the functionality
changes to a FREQUENCY MULTIPLIER, allowing
oscillator frequencies from 0.001 Hz to 20 kHz.

The PHASE control sets the start phase for the operator.

The SNAP toggle locks RATIO to harmonic intervals (e.g.

x1, x2, x3 etc.). In HZ mode this control is disabled.

Hz

x 1.00

Default -
D
? Feedback

] Fine
e Y, 0.00%
Phase

* 0,00

Snap q g

Leweal

# 1.00

The LEVEL control sets the output level for each
operator. Depending on the topology chosen, this control
will instead adjust the modulation index for operators, B,
C, and D.

MASTER

The relationship between the operators and how they
modulate each other is chosen with the TOPOLOGY
menu. Additionally, operator D can be fed back into itself,
with the FEEDBACK knob setting the amount.
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PLUCK

Pluck is a physically inspired
string synthesis module, aimed
toward synthetic sounds with a
natural decay. A short excitation
waveform is triggered and fed
through a filtered delay line; the
characteristics of the decay are
determined by the waveform, filter
style, and other adjustments.

osc ()  PLUCK

EXCITATION
SAMPLE MIXER

Sample Synth Nokse

Dulcimer

WY S p o+ —  —

3

G B o o -

FINGER

Harmonic Ratio
1.00

Harmonic Damp

100,00 %
Start i Dhetune KeyFollow
! 0.00% 0.00 Cents ¥ . 0.00%
Interpolation Mode  Standard b
SYNTH NOISE * PICK FILTER CONTOUR
Decay
Brightness Position Depth Shape Rolloff Dynamics 60,00 5
H (] (]
# Sustaln \ LY " Release
1.00 s
0,13 50,009 0.0:0 20,00 kHz 20,00 dB

There are three sources for the initial excitation: a
pitched oscillator, a noise oscillator, and an audio sample.
You can blend the levels of each sound source with the
MIXER section’s SAMPLE, SYNTH and NOISE sliders.

SAMPLE

To load an AUDIO SAMPLE, press on the menu above
the waveform image and choose from the menu of
factory preset samples. Alternatively, you can load your
own audio file by dragging and dropping it onto the
sample area. NEXT and PREVIOUS buttons are also
present, for browsing samples. START sets the sample
start time. DETUNE provides sample pitch control of
+/- 48 cents. KEYFOLLOW sets the amount of influence
of key position over filtering. INTERPOLATION MODE
chooses the quality of sample playback. Standard is ideal
for most scenarios.

SYNTH

EXCITATION BRIGHTNESS adjusts the brightness of
the excitation sources by changing the duty cycle of the
source, similar to pulse width modulation.

Default -

STRING Stefen

TUNING & COUPLING

Strings

Bridge

Inharmanicity
f ) 0.00%
DECAY
Brightness Bridge Loss
90.00% * ./ 0.a0dB

Decay Cutoff Decay Type
20,00 kHz LP1 v

PICK

The Pick parameters adjust the character of the
plucking point. Enable the PICK FILTER to add a picked
simulation to the string excitation; set the position on
the string with PICK POSITION and the intensity of the
picking with PICK DEPTH.

CONTOUR

SHAPE adjusts the relative roundness or thinness of
the excitation sources; negative values are rounder, and
positive values are thinner. ROLLOFF is a lowpass filter
of the excitation sources.

DYNAMICS sets the range of high frequency attenuation
(in dB) between the minimum and maximum note-

on velocity. At lower velocities, more high frequency
attenuation is applied.

FINGER

With a HARMONIC RATIO of 1.00, the fundamental of

the triggered note is played; above 1.00, a harmonic

note above the base note is played. The value is a ratio

relative to the base note: 2.00 is one octave higher

than the fundamental, and so on. Just as with a physical 120
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PLUCK

string, not all ratios will produce a clear harmonic tone.
Some more commonly used ratios include whole integer
values (1.0, 2.0, etc.) and simple integer ratios such as 1.5
(3/2),1.33 (4/3), and 1.25 (5/4). Additionally, a ratio of 1.01
is useful for simulating a palm-muted string. To dampen
the harmonic, increase HARMONIC DAMP.

When STRETCH is enabled, each sample is either
processed through the delay and filter or passed through
unprocessed. Increasing the Stretch value will increase
the likelihood of samples passing through unprocessed.
With more unprocessed samples, there result is a slight
buzzing sound which is useful for noise or drum sounds.

TUNING & COUPLING

By default, one plucked string is simulated; for two

strings, change the STRINGS value. When there are two

strings, the COUPLING MODE determines how they

interact and the COUPLING amount sets the amount of

interaction.

- SERIAL: The two strings are in series, with the first
feeding the second. With Coupling at zero, only the
first string is heard; at 1.00, the first string is not directly
heard, and only the second string (excited by the first) is
heard. A Coupling of 1.00 results in a slower attack time,
similar to a cello.
BRIDGE: A small amount of the first string’s energy is fed
to the bridge and excites the other string through cross
feedback.
BEATING: Strings are coupled trough a rotation matrix,
causing the sound to beat at a few Hz. As Coupling
increases, the beating will be faster. Detuning the second
string also has an impact on the depth and complexity of
this beating.
INHARMONIC: Similar to Beating, but the beating
frequency is in the audible range. This can result in bell-
like or plate-like sounds, similar to a ring modulator.

To tune the second string relative to the first, set
COARSE TUNE to the interval in semitones (up to +2
octaves) and FINE TUNE in cents (up to 20 cents).

Some string materials, such as steel piano strings, are
more inharmonic than others, such as nylon guitar
strings. INHARMONICITY controls the amount of stretch
of the string partials from the harmonic series.

DECAY

DECAY and RELEASE set the durations for the
amplitude envelope decay time. BRIGHTNESS highlights
or attenuates a high frequency shelf for the decay, and
DECAY CUTOFF sets the cutoff for a lowpass filter.

BRIDGE LOSS sets an amount of additional high
frequency dampening applied. On physical strings,
high frequencies dampen more quickly than lower
frequencies; applying some additional dampening can
help make the decay sound more natural.

DECAY TYPE chooses the filter type used to dampen

the decay:

MA: The classic damping mode as used in the
pioneering Karplus-Strong paper on plucked-string
synthesis.

MAZ2: A linear phase damping filter that is more
controllable than the MA filter.

LP1: The MA and MA2 have a gentle dampening

and may be too bright for some uses. LP1is a more
progressive filter that dampens high frequencies more
than MA or MA2. Conversely, LP1 may dampen too much
for some sources, but is a good fit for sounds like muted
basses.

« SHELF: Compromises between MA and LP1; high
frequencies are not dampened as much as with LP1, but
the filter curve is more progressive than the MA or MA2
filters.
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() WAVETABLE

:’O'-r Wave Index
Wt 100.00%

Phase Dist
! 0.00%

Bend+ v

Phase Dist Mode

WAVETABLE

The WaveTable oscillator uses a
table containing multiple waveform
shapes. While a single waveform

is played at any given time,
modulation between the different
waveforms produces distinct and
unigue sounds.

@ APPENDIXA: SYNTRESIS OSCILLATORS » WAVETABLE

WAVETABLE
Resine A Smoothing
T ' Index
Octaves
Start Phase
7

First, a wave is chosen. Press on the waveform menu to
choose from one of the many factory preset waves or
use the next/previous buttons to browse. Additionally,

you can load your own audio files (or even image files) by

dragging and dropping them onto the waveform area.

Audio files are imported with one slice per channel.
Slices will also be imported if slices are arranged one
after the other within an audio file, and the number of
slices is specified the end of the file name following an
underscore (e.g. “MySweep_128.wav”). Image files are
imported with each row of pixels as the wave cycle,
with one slice per row. (Very large image files may be
resampled or cropped.)

If the wave has multiple slices, the WAVE INDEX
determines which slice in the wavetable will be played.
Commonly, this is modulated to sweep through slices
while playing.

UNISOMN

Wawve Spread

!
0.00%

Exponential ¥

Phase Spread

Default v
Vaolces 1 Stereo
Stereo Spread Detune
L &
10000% 10.00%
Standard ¥

Spread Mode Detune Mode

Depending on the wavetable, transitioning from slice to
slice has the potential to be abrupt. There are therefore
two smoothing options: SMOOTH WAVE INDEX and
SMOOTH OCTAVES.

PHASE DISTORTION MODE chooses the style of the
phase distortion, and PHASE DISTORTION AMOUNT
sets the amount.

To set the point within the waveform cycle where it
will begin when triggered, change the START PHASE
control. For simple waveforms, the image of the
waveform will update to show the result of the phase
change.

The majority of the UNISON controls for the WaveTable
module are the same as found on the Analog module;
for details, see: [Appendix A > Oscillators > Analog >
Unison]. There is one additional Unison parameter for
the WaveTable oscillator, WAVE SPREAD, which sets the
range of Wave Index values for each voice.
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() ANALOG TAPE DELAY

X\ TEMPO SYNC

Fl

ANALOG TAPE DELAY

Analog Tape Delay is inspired by
classic analog delays using reel-
to-reel tape loops.

DELAY DISTORTION
Feedback ! Ef:."!d.d Distartion Mode - Trazh
20.00% T Tape e 25.00%
DELAY

DELAY sets the length of delay, in ms or bars/

beats (if tempo-synced), and FEEDBACK chooses
the percentage of signal fed back into the module.
SPREAD sets the amount of stereo spread, from zero
percent (mono) or 100 percent (full stereo).

DISTORTION

DISTORTION MODE set the style of distortion (Tape,
Tape/Tube, and Analog), and TRASH set the amount
of distortion.

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output.

Default

Dy
50.00%

MiIX

Wt
50.00%
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() DUAL DELAY

X\ TEMPO SYNC
Time

7.85 ms

DUAL DELAY

Dual Delay is a delay module with
multiple controls for modifying

one or both channels to produce

a rich array of time-based effects,
with an immersive interface to help
visualize the stereo and phase
adjustments being made.

DELAY

L/'R

Lx 066

Feedback

100.00%

Sterao Phase
MODULATION FILTERS ROTATION
LR Depth Low cut High cut Feedback Input
20,00 Cents - -100.00%
¥ L. .
% %
w  Rate Output
Lt 2.14Hz 97.48Hz  20.00 kHz 52.74 100.00%
»]W.\'

TIME sets the length of delay, in ms or bars/beats (if
tempo-synced). FEEDBACK chooses the percentage
of signal fed back into the module. Both Time and
Feedback have L/R controls to adjust the value for
one channel or the other as a percentage of the main
value.

MODULATION
DEPTH chooses a detune amount for the delay taps,
and RATE sets the speed of modulation.

FILTERS

The filters affect only the wet signal; the dry signal is
not filtered. LOW CUT rolls off lower frequencies, and
HIGH CUT rolls off higher frequencies.

ROTATION
The Rotation section adjusts the phase of the INPUT,
OUTPUT, and FEEDBACK signals.

| -,—\_\ e

Reverberus b

fl-1

WIDTH MIX

Input Dry | Wet

* 100.00% 1
Dutput

o 100.00% 50, 00%

WIDTH

INPUT adjusts the stereo spread of the signal input
to the effect, and OUTPUT adjust the spread of the
output signal.

MIX

DRY/WET knob sets the balance between the dry
(unaffected) and wet (affected) signal sent to the
module’s output.

DISPLAY

The display shows a visual representation of how the
controls will affect the STEREO and PHASE output of
the module.
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¢) DIFFUSION

~ DIFFUSION
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() IREVERB
IMPULSE REVERE

01 Cathedral 33m Tirme
b TR0 0%

Pre Delay
d 0 ms

1 Width
000 %

If there is audio passing through the IReverb while
|REVERB parameters are being adjusted, the dry signal will be

heard momentarily. This is because convolution is

a processor-intensive effect and briefly muting the

processing signal is necessary to avoid pops/clicks or

IReverb is a convolution reverb. other artifacts.

Given an impulse response for a

physical space or a piece of gear, IMPULSE

IReverb can accurately reproduce To load an IMPULSE RESPONSE, drag and drop an
what the input source would audio file to the sample area, or load one of the factory
sound like if it were actually in that presets.

space or played through that piece

of hardware. REVERB

TIME sets the duration of the wet signal, specified as
a percentage of the impulse response’s duration. PRE
DELAY sets the amount of delay before the wet signal
is heard.

WIDTH adjusts the stereo width of the impulse
response. At negative values, the left an right channels
are swapped.

01 Cathedral 33m
DAMP MIX

Diry Wet

b

100.00% 30.00%

DAMP
To filter the output, use LOW DAMP and HIGH DAMP
to dampen the low or high frequencies, respectively.

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output.

IMPULSE FILES

To save the currently loaded impulse, choose SAVE
IMPULSE to save the current file or SAVE IMPULSE
AS to save as a new file.
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SPARKVERB

SparkVerb is a unique and
versatile algorithmic reverb,
centered around a frequency-
based spectral display.

The sound can be shaped with
separate frequency bands, or
adjusted globally.

() SPARKVERB

ROOM SPECTRAL DECAY
R Size
2927 m
- Shape
\ 19.60%
Pre-delay
- 0 ms
== A
MODULATION DECAY
Depth Rate Maode Lo Decay Crossover Decay Crossover
D@ mm ¢ @@ =@ G
( \ \ - \
6.64 Cents x0.56 x0.20 191.62 Hz 12.97 3 16.21 kHz
(»]Jed.\ §

The central DECAY parameter controls the duration
of the reverb decay. Low and Hi frequency bands can
further tailor the decay response across frequencies.
Choose frequency for each band with LO XOVER and
HI XOVER, and set the decay ratio (relative to the
main Decay time) with LO DECAY and HI DECAY. If
you would rather cut the Low or Hi bands instead, use
DECAY LOW-CUT and DECAY HI-CUT.

ROOM

ROOM SIZE sets the size of the simulated space, from
small rooms (4 meters) to very large rooms (50 meters).
SHAPE sets the delay distribution and distortion of the
room, from zero (highest echo density) to 1.00 (highest
spectral mode density). PRE DELAY sets the amount
of delay before the wet signal is heard. DENSITY
changes how dense the reflections will be; lower
values will be more like distinct echoes.

MODULATION
DEPTH chooses the depth of the decay modulation,
in cents. RATE chooses a relative ratio, from 1/4 to

Abyss -

OUTPUT

- Mix
70.00%
Width

- 100.00%

5 Rolloff
10.99 kHz

Freeze

DIFFUSION

4x, for each delay line. MODE sets the modulation
interpolation style; choose from Dark (default; some
high-frequency decay damping), Lo-Fi (more high
frequency diffusion), or Bright (more precise high-
frequency response, but more processor intensive).

DIFFUSION

DIFFUSION ON/OFF toggles the short-term diffusion
option. When enabled, DIFFUSION START sets the
delay time until the diffusion is heard, and DIFFUSION
AMOUNT sets how much diffusion will be applied.

OUTPUT

MIX sets the balance between the dry (unaffected)
and wet (affected) signal sent to the module’s output.
WIDTH adjusts the stereo spread of the module’s
output. ROLLOFF sets the cutoff frequency of an
overall lowpass filter to adjust the brightness of the
wet signal. Enabling FREEZE will hold the current
decay infinitely, until Freeze is disabled.
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@) ANALOG CHORUS

@
1.98 Hz

~ ANALOG CHORUS
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() ANALOG FLANGER = 4 » SubtleGuitar ~ X

Q- @ @ @

~ ANALOG FLANGER
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¢ CHORUS

X\ TtEMPO sYNC =\ Spesd
4 J 031Hz

- CHORUS
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&) CROSS PHASER L = 4 b StereoPhase = X

X\ TEMPO SYNC =\ TEnaet = | =\ Feedback
“J 0.70H: - H Wy 80.00%

~ CROSS PHASER
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¢y ENSEMBLE 505

s (7)) M

~ ENSEMBLE 505
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¢ FLANGER B = 4 » CoolFlange - X

K\ TEMPO SYNC @ Speed o\ Dalay Time @ Depth @ Fesdback S Mix
1M1 250 ms 4.50% 68,009 Ti.00%:

~ FLANGER
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&) PHASER

X\ TtEMPO sYNC @ Speed

0.80 Hz

~ PHASER
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¢ ROTARY
!/ 0.00% v/ Tremolo

0 Mic Distance 1, MicAngle
1.00 m a0.00

~ ROTARY
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=2 ,“___.__‘u:_-_._
\

\
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S
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e

Edge
-~
71.70%

~ THORUS
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() ANALOG FILTER

Mode o8 Y Cutoff =\ Resonance
w v 1.00 iz B4 *) ooox

~ ANALOG FILTER
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() BIQUAD FILTER

Mode o8 Y Cutoff =\ Resonance
w v 1.00 iz B4 *) ooox

~ BIQUAD FILTER
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() BRICKWALL FILTER

5 Cutoff (;) Type
1.00 kHz (B4) ¥ LP

~ BRICKWALL FILTER
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() COMBFILTER

Mode o8 Y Cutoff =\ Resonance
Pus v 1.00 iz B4 *) ooox

~ COMBFILTER
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() CROSSOVERFILTER

~ CROSSOVER FILTER
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¢ LOWPASS 12

o Cutoff = % Resonance
1.00 kHz (B4) ¥ 0.00%

~ LOWPASS 12
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¢ LOWPASS 24

o Cutoff = % Resonance
1.00 kHz (B4) ¥ 0.00%

~ LOWPASS 24
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() ONEPOLE

& Y Cutoff = Key Tracking
1.00 kHz (B4) ¥ 0.00%

~ ONEPOLE
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¢ REZFILTER

Cutaoff ~ ' Resonance

Mode .
v 100 e 84 20.00%

~ REZFILTER
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¢ UVIFILTER

Q) Q)

- UVIFILTER
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&) VOWELFILTER

.1-. Merph @ﬁ (;) Num Formants
s | poo ¢ | 1000 3

Mode Filter A Filter B

~ VOWEL FILTER
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¢ WAHWAH

Q) -

~ WAHWAH
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() XPANDER FILTER

¥

KPANDER FILTER

A multimode (37) variant on a 4th
order ladder filter with built-in
saturation and oversampling.

1.00 kHz (B4)

LP4

0040 % - U005 — \ 0.00 dB

Resonance Kay Tracking | Drrive

CUTOFF sets the frequency for the filter; the note name
corresponding to the frequency is also displayed, for
example, 2.00 KHZ (B5). RESONANCE adjusts how
much the cutoff frequency is emphasized.

KEY TRACKING adjusts how the cutoff frequency is
adjusted relative to the note played.

FILTER MODE is displayed with a visual representation
of the filter shape. Press on the image and choose a filter
mode from the menu. The filter types are low pass (LP),
high pass (HP), band pass (BP), all pass (AP), peak filter
(PK), and twin filter (T), with multiple combinations of each
provided. The number indicates the order of the filter,
e.g. LP1 has a 6 dB/octave slope.

DRIVE sets the amount of overdrive applied, and
DISTORTION TYPE chooses the style of overdrive: Soft
Sat, Hard Clip, or Linear.

Default

Dhstortion Type

Soft Sat
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() 3 BAND SHELF = 4 » Default

% | MidHigh Freq 1 GainHigh
4.00 kHz 0.00 dB

3 BAND SHELF
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& 8BANDEQ

¢ POP-OUT EDITOR

® . ™.® .® .
& 2. 0 . 0 >
® .

~ 8BANDEQ
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¢ BIGPI TONE

A Tone
5.00

~ BIGPITONE
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() CONVOLVER

CONVOLVER

Convolver is a simple convolution
processor, ideally suited for
emulating EQs, cabinets, and so
on. For reverb, the IReverb effect
is recommended; see:
[APPENDIX A > Effects > Reverb >
IReverb]

IMPULSE

American Transistor

IMPULSE
To load an IMPULSE RESPONSE, drag and drop an
audio file to the sample area.

MIX

DRY and WET knobs set the balance between the
dry (unaffected) and wet (affected) signal sent to the
module’s output.

IMPULSE FILES

To save the currently loaded impulse, use the Preset File
menu and choose SAVE IMPULSE to save the current
file or SAVE IMPULSE AS to save as a new file.

American Transi...™

MIX
Dy Wet
r %
0.00% 100.00%:
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() TONESTACK

~ TONE STACK



@ APPENDIX A: EFFECTS » AMP & STEREQ » AUTOPAN

¢ AUTOPAN

X\ TtEMPO SYNC (;) it

3.00H=z

~ AUTOPAN
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X\ TtEMPO sYNC @ Freq
5.00Hz

- TREMOLO
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¢ UVIWIDE

o) Q) -

~ UVIWIDE
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() ANALOG CRUNCH

) Q) Q)

~ ANALOG CRUNCH
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() DOUBLE DRIVE

@ Pre Drive (;) High Freq @ Low Freg @ Post Drive
¥ 0.00% ¥ Off S OoF ¥ 0.00%

~ DOUBLE DRIVE
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- DRIVE



@ APPENDIX A: EFFECTS » DRIVE & DISTORTION » EXCITER

¢ EXCITER

- EXCITER
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&) GUITAR BOXES

=) Mix @ Separation @ Spread Model
v/ 100.00% Oms v/ 100.00% - A : i

~ GUITAR BOXES
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() OVERDRIVE

) Q) Q)

~ OVERDRIVE
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¢ UVIDRIVE

Q) Q) Q)
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() WAVE SHAPER

] Input Gain
0.00 dB

Pre Freg
‘J 20.00kHz

Oversampling

Mone v

WAVE SHAPER

Wave Shaper distorts the input
signal by transforming the shape
of the waveform, which often
results in heavily distorted sounds.

sine

Amount
- 0.00%

INPUT GAIN sets the gain adjustment into the module,
and PRE FREQ sets the frequency of lowpass filter
applied before any waveshaping.

Choose the WAVE SHAPE by clicking the waveform
selecting a wave from the menu, then use AMOUNT and
KNEE to adjust characteristics of the wave shape.

Use OVERSAMPLING to set the amount of oversampling
applied (if any), from 2x to 16x. As oversampling

is processor intensive, it's recommended to apply
oversampling as little as is necessary to reduce
unwanted aliasing. Often, no oversampling will be
needed.

POST FREQ sets the frequency of a highpass filter
applied after waveshaping. OUTPUT GAIN sets the gain
adjustment, after waveshaping is applied.

MIX sets the balance between the clean and overdriven
signals.

Default

Dutput Gain
0.00 dB

Post Freg
20,00 Hx

Mix
1. L0 %0
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3 BAND COMPRESSOR

@ APPENDIX A: EFFECTS » DYNAMICS » 3 BAND COMPRESSOR

The 3 Band Compressor has Low, Mid, and High bands.
The crossover points between the bands are set with the
LOW/MID FREQ and MID/HIGH FREQ controls.

Each of the three bands have standard compressor

() 3 BAND COMPRESSOR Default

Threshold Low Ratio Low Attack Low Release Low Makeup Low
0.00 dB 1000 ’ 10,0 ms ’ 100 ms 0.00 dB
Threshaold Mid Ratia Mid Attack Mid Release Mid Makeup Mid
0.00 dB 1000 ’ 100 mis ! 100 mis 0.00 dB
Threshald High Ratio High Attack High Release High Makeup High
0.00 dB 1000 # 100 mis 4 100 ms 0.00 dié

Low !/ Mid Freq # Mid/High Freg

250.00 Hz 2.00 kHz

The 3 Band Compressor is a multi-
band version of the compressor,
with adjustable crossover

controls: THRESHOLD, RATIO, ATTACK, RELEASE,
MAKEUP. For more information on compressor settings,
see: [Appendix A: Modules > Effects > Dynamic >
frequencies. Compressor Expander]
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() 3 BAND LIMITER
(7 esotaion
v/ o.00dB

% Margin Low
) 0.00dB

@) ?nnh::m

~ 3 BAND LIMITER
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() COMPRESSOR EXPANDER

L

I

COMPRESSOR EXPANDER

Compressor Expander is a dual
dynamics processor — the
compressor tames signal peaks
over a chosen threshold, and the
expander gates the signal below a
second, independent threshold.

Comp Threshold
0.00 dB

Gate Threshold
-130.00 dB

Auto MakeUp

- Lomp Ratio 5 Comp Attack |
1000 10.0 ms
Gate Ratio % Gate Attack ]
¥ 1.00 10.0 ms
1 MakeUp Gain Mix
0.00 dB - 100.00%

Both the compressor and gate have Threshold, Ratio,
Attack, and Release controls. THRESHOLD sets the
level at which the compressor or gate will be applied.
RATIO sets the ratio between input gain and output
gain. ATTACK and RELEASE set the speed at which
the compressor or gate begins or stops processing the
signal after it has crossed the threshold.

MAKEUP GAIN applies a manual gain adjustment to
compensate for the gain reduction of the compressor. Or,
to have makeup gain applied dynamically, enable AUTO
MAKEUP.

MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.

Lastly, the INPUT METER on the left side of the module
displays the level of the input signal, and the GAIN
REDUCTION METER on the right side of the module
displays the amount of gain reduction applied. Note that
the righthand meter is not an output meter.

Default

Comp Release
100 ms

Gate Release
100 mis
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~ GATE
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(h MAXIMIZER

% Threshaold
-24.54 dB

MAXIMIZER

Maximizer is a look-ahead limiter
with a graphical timeline to
visualize the dynamic range of the
input and output.

Cailing Leokahead
\J -0.0de - 2.00 ms

THRESHOLD sets the level at which limiting will be
applied, and CEILING sets the maximum output level.

LOOKAHEAD sets the amount of time the module will
lookahead at the input signal; longer lookahead times
can achieve a better response for transients and other
sudden changes in amplitude.

RELEASE sets the speed at which the limiter stops
processing the signal after it has fallen below the
threshold.

The INPUT METER on the left side of the module
displays the level of the input signal, and the GAIN
REDUCTION METER on the right side of the module
displays the amount of gain reduction applied. Note that
the righthand meter is not an output meter.

Default -

1 Release
T ms

The TIMELINE displays the input signal and gain
reduction over time. The blue graph rises from the
bottom of the timeline and indicates the amplitude of the
input signal; the red graph grows downward from the top
of the timeline and indicates gain reduction.
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() STUDIO LIMITER

=% Threshold
A J ooode

~ STUDIO LIMITER
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¢) PHASE METER

€ POP-OUTEDITOR

~ PHASE METER
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() SPECTRUM ANALYZER Default ol

© POP-OUT EDITOR M. H

FFT size Windaw type _ " MaxdB [:'—; dB range 8 Refresh X scale Draw Type
2048 *  Blackman-Harris * | -6.60 dB 123.03 dB \, 72.9 ms Log *  Bands ¥
FFT SIZE defines the length of the frequency sampling To view a larger graph, drag the bottom edge of the

SPECTRU M ANALYZER window; larger sizes are more precise, but require more module to resize it.

processing power. WINDOW TYPE chooses the function

used for sampling. Press the EXTERNAL WINDOW button in
the module title bar to open the graph in a
The Spectrum Analyzer displays MAX DB sets the maximum value that can be displayed separate window to view it even larger.
the frequency content of the in the analyzer (the very top of the graph), and DB
signal. Frequencies are displayed RANGE sets the range below the maximum value that
on the X-axis, increasing from left will be displayed. X SCALE chooses the scale used for
to right, and amplitude is displayed the horizontal axis: Linear, Log, Semitones, or 3rd Octave.
on the Y-axis, increasing from The labels on the left and top sides of the graph update
bottom to top. as you adjust the Max dB, dB range, and X scale settings.

DRAW TYPE chooses how the frequency response
will be drawn on the graph: as a single continuous line
(Line), as multiple thin lines (Bin), or thick bars (Bands).
REFRESH sets how quickly the graph is re-drawn.
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@ APPENDIX A: EFFECTS » ANALYSIS » TUNER

€ POP-OUT EDITOR

262.2 Hz % cants

~ TUNER



@ APPENDIX A: EFFECTS » MISC» EFFECT RACK

() EFFECT RACK

EFFECT RACK

The Effect Rack creates a new
effects path inline where the Effect
Rack module is added. Macros are
added for front-panel control of
the effects that are added to the
Effect Rack’s FX chain.

When the Effect Rack is added, it creates eight MACROS
and one FX CHAIN. To view the FX chain, choose

the FX chain in the Tree view or via the Effects Tab’s
navigation nodes. You can then add the desired effects
to the FX chain.

The Effect Rack macros can be used as FRONT PANEL
controls for parameters on effects in the FX chain. To
assign a macro, right-click a parameter on an effect in
the FX Chain and choose ASSIGN TO EFFECT RACK
MACRO. To change a macro’s name, double-click the
macro’s name on the Effect Rack and enter a new name.

Add Modulation b
Edit Modulations
Clear Modulations

Assign to Host automation b

MID{ Learn

Assign To Macro b

Assign To Effect Rack Macro ¥ Add new Macro

0sC 2

M-comp_S-delay -

The overall level of the FX chain can be adjusted in the
Tree view, or the chain can be disabled with the POWER
button. You can also create additional FX chains under
the same Effect Rack module, by right-clicking its node in
the Tree view and choosing ADD FX CHAIN.

TREE

INSTRUMENT Part1 ¥
fx 11 ah
Effect Rack
Chain1 —
Gain Matrix
Tilt
Compressor Expander
Gain Matrix

Chain2 —

FCCCC GG
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@ APPENDIX A: EFFECTS » MISC » REDUX

& REDUX
Fregquency
~ J 27.00kHz

Jitter
¥ 0.00%

REDUX

Redux is a resampler for creating
lo-fi effects such as extreme bit
reduction.

RESAMPLIMNG

Ty

Bits Decimate v Filter Position

]
DQuantize Law Pﬂ'ﬁt

MuLaw hd
Dither Filter Mode
~ 0.00% Antialiasing LP

RESAMPLING

FREQUENCY sets the resampling frequency, with
JITTER introducing time variations to the resampling.
BITS sets the bit depth, and DITHER sets the amount
of dither (a type of low-level randomized noise).

TYPE chooses the style of resampling: DECIMATE
inserts zeroes in between sampled values, and
BLOCKER holds a sampled value until the next
sampled value.

QUANTIZE LAW sets the type of quantization to one of
two common algorithms: linear or mu-law (also known as
L-law).

The ANTIALIASING toggle sets whether an anti-aliasing
filter is enabled. When disabled, frequencies over the
sampling rate may WRAP AROUND when resampled
and cause unusual harmonics.

Emulator-Bbits 2...»

QUTPUT
Yo
Filter Freg
13.50 kHz
i1
Filter Res
u-uﬂ".-.. .I{”-I.l:.:lul-'l:
FILTER

FILTER POSITION chooses whether the filter is off,
before resampling (pre), or after (post). FILTER MODE
chooses the type of filter: low pass (LP), high pass (HP),
or band pass (BP).

FILTER FREQUENCY sets the frequency for the filter,
and FILTER RESONANCE adjusts how much the cutoff
frequency is emphasized.

OUTPUT
MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.
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@ APPENDIX A: EFFECTS » MISC» UVINYL

SN L = 4 »  MaxiVinyl * X
BC L

A 60 6@ =
-24.23 dB -20.38 dB 0.00% -45.62 dB 18.15%

-10.77 dB

e

' 34.77%

~ UVINYL






@ APPENDIX A: LEGACY EFFECTS » DELAY » FX DELAY

¢ FXDELAY

K\ TeEmPO sYNC =\ Delay Time (;) Feedback @ Cutoff | Speed
- 1.00s ¢ 0.00% off ’ 0.50 Hz

© FXDELAY



@ APPENDIX A: LEGACY EFFECTS » DELAY » FAT DELAY

¢ FATDELAY

X\ TEMPO SYNC (;) Feedback
’ ’ 0.00%

~ FATDELAY



@ APPENDIX A: LEGACY EFFECTS » DELAY » PING PONG DELAY

() PING PONG DELAY

X\ TEMPO SYNC Delay Time
# 100 ms

PING PONG DELAY

Ping Pong Delay is a standard
delay with additional stereo
processing.

Feedback ] Cutalf 5prl'.d|:|
50.00% Off - -100.00%

DELAY TIME sets the length of delay, in ms or bars/
beats (if tempo-synced), and FEEDBACK chooses the
percentage of signal fed back into the module.

CUTOFF sets the type and amount of filter. At the center
position, no filter is applied. To the right of center, a high-
pass filter is applied, and further to the right raises the
cutoff frequency. Likewise, further left of center applies a
low-pass filter and drops the cutoff frequency.

SPREAD controls the stereo spread of the module’s
output. At zero, the output is mono; negative values feed
the input to the left channel first, and positive values to
the right channel first.

MIX sets the balance between the dry (unaffected) and
wet (affected) signal sent to the module’s output.

%

Default

s
100.0:0%
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@ APPENDIX A: LEGACY EFFECTS » DELAY » SIMPLE DELAY

() SIMPLE DELAY

X\ TtEMPO sYNC '\ Feedback 4 Cutoff
- 3 ’ 0.00% off

~ SIMPLE DELAY



@ APPENDIX A: LEGACY EFFECTS » DELAY » STEREQ DELAY

() STEREO DELAY

X\ TEMPO SYNC

~ STEREO DELAY



@ APPENDIX A: LEGACY EFFECTS » REVERB » GATE REVERB

() GATE REVERB

X\ TEMPO SYNC =\ PreDalay _ ' Decay Time ~ | GateTime
e 200s

L0 ms

~ GATE REVERB



@ APPENDIX A: LEGACY EFFECTS » REVERB » PLAIN REVERB

() PLAIN REVERB

@ Decay Time (.;) High Damp
2.00s ’ 0.00%

~ PLAINREVERB



@ APPENDIX A: LEGACY EFFECTS » REVERB » PREDELAY VERB

() PREDELAY VERB

K\ TEMPO SYNC =\ PreDalay (;.) Decay Time @ High Damp 0\ Mix
L 50.0 ms 2.00s ! 0.00% 50.00%

© PREDELAY VERB



@ APPENDIX A: LEGACY EFFECTS » REVERB » SIMPLE REVERB

¢ SIMPLE REVERB

@ Cutaff @ Decay Time @ High Damp 0\ Mix
Off 2.00s ! 0.00% 50.00%

~ SIMPLE REVERB



@ APPENDIX A: LEGACY EFFECTS » FILTER » AUTO WAH

¢ AUTO WAH

A Gain () Sensitivity @ a
0.00 dB 0.6 LY 1.00

~ AUTO WAH



@ APPENDIX A: LEGACY EFFECTS » FILTER » FX FILTER

¢ FXFILTER

~ FXFILTER



@ APPENDIX A: LEGACY EFFECTS » FILTER » TALKBOX

¢ TALKBOX

- TALKBOX



@ APPENDIX A LEGACY EFFECTS » EQUALIZER » 2 BAND EQ

() 2BANDEQ

~ 2BANDEQ



@ APPENDIX A LEGACY EFFECTS » EQUALIZER » 3 BAND EQ

() 3BANDEQ

I LowGain
0.00 dB

~ 3BANDEQ



@ APPENDIX A: LEGACY EFFECTS » AMP & STEREQ » ROTARY SIMPLE

() ROTARY SIMPLE

Q..
- 157 Hz

~ ROTARY SIMPLE



@ APPENDIX A: LEGACY EFFECTS » AMP & STEREQ » ROTARY SPEAKER

() ROTARY SPEAKER

~ ROTARY SPEAKER



@ APPENDIX A: LEGACY EFFECTS » DYNAMICS » COMPRESSOR

¢ COMPRESSOR

Q)

~ COMPRESSOR



@ APPENDIX A: LEGACY EFFECTS » DYNAMICS » LIMITER

¢ LIMITER

o Gain
0.00 dB

~ LIMITER



@ APPENDIX A: LEGACY EFFECTS » DYNAMICS » UVI MASTERING

(Y UVI MASTERING

#

UVI MASTERING

UVI Mastering is a mastering
processor for stereo mixes, such
as Falcon’s main outs. It provides
multiband compression, a limiter,
and tube saturation.

Low Velume
0.00 dB

Comp Attack
10.0 ms

Low/Mid Freg [ Medium Valume >
250.0:0 Hz 0.00 dB

Comp Threshaold
.00 dB *

UVI Mastering has Low, Mid, and High bands. The
crossover points between the bands are set with the
LOW/MID FREQ and MID/HIGH FREQ controls.

Each band has a VOLUME control, which sets the gain

of the band before the combined signal is fed to the
compressor, limiter, and tube saturator. COMP ATTACK
and COMP THRESHOLD set the compressor attack time
and threshold, followed by the LIMITER THRESHOLD,
and finally, TUBE AMOUNT.

Default
Mid/High Freg ! High Velume
2.00 kHz 0.00 dB
Limiter Threshold Tube Amount
0.00 dB : 000
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@ APPENDIX A: LEGACY EFFECTS » MISC » BEAT REPEAT

() BEAT REPEAT

X\ TEmMPO syNC AR (™) Time
125 ms

© BEATREPEAT



@ APPENDIX A: LEGACY EFFECTS » MISC » RING MODULATOR

¢) RING MODULATOR

Q) -

~ RING MODULATOR



@ APPENDIX A: LEGACY EFFECTS » MISC » ROBOTIZER

¢ ROBOTIZER

o\ Frag
1.00 kHz

~ ROBOTIZER



@ APPENDIX A: LEGACY EFFECTS » MISC» UVI DESTRUCTOR

¢ UVIDESTRUCTOR

O

~ UVIDESTRUCTOR






@ APPENDIXA: EVENT PROCESSORS » ARPEGGIATOR

ARPEGGIATOR

The Arpeggiator is a classic
synthesizer effect which modifies
incoming notes and plays them
in programmable pattern to
create a dynamic sequence.
Falcon’s arpeggiator provides
many advanced controls such as
per step length, gate, pitch and
velocity as well as 27 different
performance modes.

() ARPEGGIATOR DUST3D1 -
Trigger Mode Mode Octave Mode Resolution Hold Repeatbottom  yypycc
Legato ¥ Spiralin&Out ¥ RepeatKeys ¥ 1/16 v Repeat top Off v
1 Arp/Vel. Blend I Octave Step Length MNum Strike 2 MumSteps Groove Amnt
50.00% 0 */ 100.00% s & 32 N 14.54%
0o 0 0 0O 0O 0O O O O O 0 O 0 0O O O O 0O O O 0O O O O O O O O O O O O
m E O N N O O E6 B @ € N F O 66 N © N [ © &6 &6 @6 @ @© @©§ © @ @@ & @§5 @

TRIGGER MODE determines how the arpeggiator is

triggered:

- NOTE: Each note resets the arpeggiator position to the
first step

- LEGATO: When multiple notes are played
simultaneously, each new note continues from the
current step

- SONG POSITION: The arpeggiator continually cycles,
and any notes played are triggered at the current step

MODE chooses the pattern of how notes will be
triggered, from a simple upward progression to zig
zags, spirals, and more. OCTAVE chooses the number
of octaves triggered in addition to the actual notes that
were played. When Octave is not zero, OCTAVE MODE
sets whether the pattern of notes will be repeated
individually within each octave (Repeat Pattern) or
whether the pattern will be completed once in total
across all notes in all octaves (Repeat Keys).

NUM STEPS sets the number of steps in the grid, and
RESOLUTION sets the beat value of each step, from 32

bars down to 64th note triplet. STEP LENGTH sets the
duration of the trigger within the step duration; the lower
the Step Length value, the more staccato each step will
be. A Step Length Value >100% will result in each note
slightly overlapping the next note. GROOVE AMOUNT
chooses the amount of swing applied to the grid.

NUM STRIKE chooses how many times each note will be
triggered before moving to the next note in the pattern.
REPEAT BOTTOM and REPEAT TOP selectively repeat
the bottom-most or top-most note in the pattern.

Enabling HOLD will latch all notes as they are played as if
they were being held down; to release the notes, disable
Hold.

ARP/VEL. BLEND sets the blend of the arpeggiator
velocity value and the original note-on velocity values.
At zero percent, the resulting velocity is fully controlled
by the arpeggiator; at 100%, the resulting velocity is
fully controlled by the note velocity and the arpeggiator
velocity values are ignored.
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@ APPENDIX A: EVENT PROCESSORS » ARPEGGIATOR (CONTINUED)

ARPEGGIATOR

MIDI CC sets which MIDI CC is output by the MIDI CC
layer of the arpeggiator, if any (see below). Choose off to
disable, or 0-127 to set the desired MIDI CC.

STEP GRID

The STEP GRID sets and displays the values for each
step. There are three independent layers to the step grid:
VELOCITY, PITCH, and MIDI CC.

4 vEIm:Iw To change which layer is displayed,
Pitch right-click and choose a layer from
MIDI CC the contextual menu.

- STEP VALUE
The size of the vertical bar within the step determines
the step’s value. The larger the bar, the higher the value.

Note that when viewing the Pitch layer, the bar is bipolar,

with zero displayed in the vertical center of the step. To
change the duration of the step, hold the Shift key while
dragging the bar horizontally within its step.

- STEP STATE

Beneath each step is a toggle that can pressed to set the

step’s state. When enabled, the step outputs the value

displayed in the bar above; when disabled, the step does

not output any value. Additionally, you can merge a step
with the one before it to create steps than are longer

than one step of the grid. To merge a step, hold the Shift
key when pressing the step’s state button. The step state

button for merged states is red. Alternatively, you can tie
a step to the one before it; the second step will still have
a unique value, but it will be triggered in a legato style.
To tie a step, hold the Alt/Option key when pressing the
step’s state button. The step state button for merged
states is blue.

PITCH OFFSET

The values of the Pitch Layer are displayed as text above
each step. You can also edit these values directly for
more precise control.
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(2) APPENDIX A:

MIDI PLAYER

The MIDI Player module plays
back a Standard MIDI File, tempo-

synced with Falcon.

EVENT PROCESSORS » MIDI PLAYER

(h MIDI PLAYER

Sequenceiame BaseMote

Browsea Transpose Loop

To load a MIDI file, press the BROWSE button and
choose a Standard MIDI File using the standard file
browser. When a MIDI file is loaded, its name is displayed
next to SEQUENCE NAME.

The BASE NOTE chooses which note will trigger
playback of the MIDI sequence. Other notes will play
back as usual. When TRANSPOSE is enabled, every
note will trigger playback of the MIDI sequence,
transposed relative to the Base Note. When disabled,
only the Base Note will trigger playback.

When the MIDI file is triggered, it will play back once.

If LOOP is enabled, the MIDI file will be looped
continuously. Additionally, AUTOPLAY can be enabled
to automatically begin MIDI file playback when Falcon
begins playing.

By default, the MIDI Player will play back all sixteen
channels saved in the MIDI file. Press a channel’s
BYPASS button to bypass it.

Default

AutoPlay

14

12

16
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APPENDIX A: EVENT PROCESSORS » MICRO TUNER

¢ MICRO TUNER

C c# [} D# E F F# G G# A
0.00 0.00 3.52 3.54 4.98 5.05 5.15 7.02 7.02 7.02
12.00 12.00 15.52 15.54 16.98 17.05 17.15 18.02 19.02 19.02
24.00 24.00 27.52 27.54 28.98 29.05 29.15 31.02 3l.02 31.02
36.00 36.00 39.52 39.54 40.98 41.05 41.15 43.02 43.02 43.02
48.00 48.00 51.52 51.54 52.98 53.05 53.15 55.02 55.02 55.02
60.00 60.00 63.52 63.54 64.98 65.05 65.15 67.02 67.02 67.02
72.00 72.00 75.52 75.54 76.98 77.05 77.15 79.02 79.02 79.02
84.00 84.00 B7.52 B7.54 88.98 89.05 89.15 91.02 91.02 91.02
96.00 96.00 99.52 95.54 10098 101.05 101.15 103.02 103.02 103.02
108.00 10800 111.52 111.54 11298 113.05 113.15 115.02 115.02 115.02

0
1
2
3
4
5
B
7

MICRO TUNER
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@ APPENDIX A: EVENT PROCESSORS » SCRIPT PROCESSOR

Step Line -

(% SCRIPT PROCESSOR
Step Line.dua

Mum Steps  Resolution Gate Groove Record skip
i 16 116 v N 1.00 / 0.00 Random
e IIIIIlIIIlIl — IIIII ||||||Illll|II||| ||I|I

0 i 0 0 0 0 0 0 0 2 0 O 1 0 0 0

Vel *

link link link link link link link link link link link link link link link link

This module has some standard controls at the top, with
SCR' PT PROCESSOR the script-defined controls below.
STANDARD CONTROLS
To load a script, press the LOAD A SCRIPT button and
choose a UVIScript file from the standard file browser.
When a script file is loaded, the SCRIPT NAME is
displayed in the center of the script module title bar, and
its script-defined controls will be displayed below.

The Script Processor module
provides general event processing
capabilities beyond the specific
event processors described
earlier.

To edit the script file, press the EDIT SCRIPT IN
EXTERNAL EDITOR button and the script file will be
opened in your default text editor application.

If you would like to add a password to the current
script, press the PROTECT SCRIPT button and enter a
password. After a script is protected, you must enter the
script password to open the script for editing.

Press the RELOAD CURRENT SCRIPT button to reload
the current script from disk, and reset its parameters
to their default values. Hold the Alt/Option key while

' ScriptProcessor.lua

T % :.-’private.«"tmpf&criptPrr.\c-:ssr.\r.Iua

4 ¢ |9 ScriptProcessorlua + (no symbol selected) =

17a
171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189

¥ | function arpeg(arpId_}
local index = @

local theoricalPosInBeat = @ == non g

ed beat pos

local beatTime = @
while arpld_ == arpId do
local e = heldNotes [#heldNotes]
local p = PhraserResolutions [PhraserResolution.value]
local numSteps = PhraserMNumSteps.wvalue
local stepSize = 1

for

end

i=1, 16 do == check for linked
local pos = (index i) % numSteps
if linked[pos+1].value == true then
stepSize = stepSize + 1
else
break
end

local e_ = {}
e_.note = e.note + pitchOffsets[index+1].value

Line 1 Col 1 Lua

4/ Unicode (UTF-B] 3 Windows (CALF) =/ o'| [ 7.048 /862 /254 | ...

reloading to keep the current state of the script
parameters. The WATCH FOR SCRIPT CHANGES
option will automatically reload the script whenever the
script file is modified; this can be useful while developing
a script and making repeated changes.

The script console displays debug and print messages
and is useful for debugging scripts. Toggle the SHOW/
HIDE CONSOLE OUTPUT button to show or hide the
script console. Press the CLEAR CONSOLE OUTPUT
button to clear the current console messages.

SCRIPT-DEFINED CONTROLS

The script itself defines what sort of controls will be
displayed. This includes knobs, buttons, menus, and
other controls similar to those seen in other Falcon
modules.

MORE INFORMATION
For more information on UVIScript, see:
[Appendix B: Scripting]

pAK]
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@ APPENDIX A: MODULATORS » ANALOG ADSR

() Analog ADSR 1
Attack
AD

ADSR
1.00 ms

ANALOG ADSR

The Analog ADSR envelope
(attack, decay, sustain, and
release) is an envelope with decay
characteristics similar to classic
analog envelopes, providing a
more vintage feel than a precise
digital ADSR.

i ]
Decay Sustain Release Vel > Attack
1 . Vel = Decay
b Key = Attack
Key = Deca
50.0 ms 100.00% 10.0 ms ¥ ¥

The ATTACK, DECAY, SUSTAIN, and RELEASE controls
set the basic envelope shape, and DYNAMIC RANGE
controls the amount of the output range controlled by the
trigger velocity.

Two modes alter how the envelope is triggered and
processed. If the ATTACK/DECAY mode is set to AD,
only the attack and decay phases of the envelope are
used; sustain and release will have no effect. When set
to ADSR, all phases of the envelope can be configured.
The Analog ADSR’s TRIGGER MODES are the same as
for the LFO module; for details, see: [LFO>Trigger mode].

You can choose how velocity affects the envelope’s
attack and decay with the VEL > ATTACK and VEL

> DECAY controls. Additionally, you can INVERT
VELOCITY to invert the velocity values as they affect
they envelope from the actual played velocity.

Likewise, you can choose how key follow affects the
envelope’s attack and decay with the KEY > ATTACK
and KEY > DECAY controls.

Default v
Dynamic Trigger Mode

L Retrigger ¥

Trigger
0,00 dB

The manual TRIGGER button allows for the envelope to
be triggered on-demand, and can be controlled remotely
via automation or modulation.
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@ APPENDIX A: MODULATORS » ATTACK DECAY

M Attack Dn::q_r 1

- Decay Time
- 10.00% 300 ms

~ ATTACK DECAY



@ APPENDIX A: MODULATORS » DAHDSR

() DAHDSR 1

DAHDSR

The DAHDSR envelope (delay,
attack, hold, decay, sustain, and
release) is a classic synthesis
envelope style. It is an extension
of the common ADSR envelope,
with an additional delay phase at
the beginning and a hold phase
between attack and decay.

Vil, amount

0.0% (-0.0dB)

Vel sens
15.00%:

The DELAY, ATTACK, HOLD,
DECAY, SUSTAIN, and RELEASE
values can be set by the sliders,
or edited graphically by using the
envelope editor.

To choose if velocity will affect
the envelope, use the VELOCITY
AMOUNT control. At zero percent,
velocity will have no effect.
VELOCITY SENSITIVITY remaps
the velocity input curve; values
between zero and 100% use a
progressively more exponential
curve, and values between -100%
and zero use an increasingly
logarithmic curve.

The ENVELOPE EDITOR is a
graphical, interactive display
of the envelope shape. Each
point represents a phase of the

| 10 s 15 ms

envelope. Points can be adjusted
by dragging or double-clicking,
and the curve of ramps can be
changed by dragging the line
itself.

When dragging points, you can

hold different modifier keys to

adjust the result:

- Shift: fine control

.« Command (Mac) » Control
(Windows): constrain to vertical
movement only

- Alt/Option: constrain to horizontal
movement only

- Shift+Command (Mac) »
Shift+Control (Windows):
temporarily change absolute/
relative mode (see below)

When a point is adjusted, it will
affect the values on both sides

Default -

of the point while keeping the
shape of the overall envelope
constant. For example, when the
Hold point is moved, both the
Hold time before the point and the
Decay time after the point will be
adjusted, but the total envelope
time will remain the same. If you
would like to adjust the value of
only one envelope segment at a
time, enable RELATIVE MODE
under the Envelope Editor’'s menu.
The menu can be opened by right-
clicking anywhere in the envelope
display.

While a note is held, the envelope
loops on the sustain phase

by default. However, you can
change the looped portion of the
envelope by right-clicking a point
and choosing SET AS LOOP

START or SET AS LOOP END.
Loop endpoints are highlighted
orange.

Scrolling up and down with your
mouse or trackpad will zoom the
editor’s display in and out, and the
Auto Zoom to Fit option snaps the
display to the current size of the
envelope.
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@ APPENDIX A: MODULATORS » DRUNK




® LFO1
X\ TEMPO SYNC

€ POP-OUT EDITOR |

LFO

The LFO, or low frequency
oscillator, is an oscillator that
generates a cyclical modulation

signal below the audible threshold.

@ APPENDIX A: MODULATORS » LFQ

Phase Freq Depth
|
L L
0.50 19.94 Hz 1.0:0

The LFO WAVEFORM can be one
of the classic LFO shapes (Sine,
Square, Triangle, Ramp Up, Ramp
Down), or one of these additional
shapes:

+ ANALOG SQUARE

+ RANDOM SAMPLE & HOLD
+ CHAOS LORENZ

- CHAOS ROSSIER

- USER

The FREQUENCY control sets the
duration of one cycle of the LFO.
When TEMPO SYNC is enabled,
the cycle duration ranges from

32 bars down to 64th-note triplet,
synced to Falcon’s tempo. When
TEMPO SYNC is disabled, the
cycle duration is in Hz (cycles per
second).

Dralay Rise Smooth
r f r
s 0s s

To set the point within the LFO
cycle where it will begin when
triggered, change the PHASE
control. The image of the
waveform will update to show the
result of the phase change (except
for random/chaos waveforms, as
the images are approximations of
randomly-generated waveforms).
The User waveform is a custom,
editable waveform shape. To edit
the waveform, right-click to open
itin a large overlay view. Click and
drag to draw a waveform shape,
or right-click and choose RESET
TO DEFAULT to start over. Press
anywhere outside the overlay to
close it.

DELAY TIME is a time delay
between when the LFO is
triggered and when LFO playback

Randomizer -

; Trigger Maode
Bipolar
P Mo Retrigger =

begins. DEPTH controls the
vertical value range of the

LFO’s cycle, and RISE TIME is

a time period during which the
Depth ramps up to its full range.
SMOOTH sets a time value that
smooths out transitions between
values in the LFO’s cycles. These
adjustments can be used to
create more varied and nuanced
modulations, such as a subtle
vibrato that occurs only while a
note is sustaining after its initial
attack and decay.

The default range of the LFO cycle
is from -1to +1 (bipolar). For a range
of zero to +1 (unipolar), disable
BIPOLAR mode.

TRIGGER MODE determines how

the LFO is triggered:

- RETRIGGER: Each trigger of the
LFO starts from the beginning of
the LFO’s cycle.

« LEGATO: Any simultaneous
triggers of the LFO will not trigger
the LFO again, and will start at the
same place as any other triggers
currently. All triggers will be
released together when the last
one is released.

« NO RETRIGGER: The LFO runs
continuously, triggering from the
beginning when Falcon’s playback
starts or stops.
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@ APPENDIX A: MODULATORS » MACRO

() Macro 1

DisplayName

Macro 1

MACRO

Macros are a special type of
internal modulation. When a macro
is added, a corresponding control
appears on the Info tab. When this
macro control is adjusted, so is the
control assigned to it.

sStyle
Continuous v

A control can be assigned one-to-one to @ macro, as a
shortcut for a commonly used control in the program, or
multiple controls can be assigned to a single macro, for
complex transformations of multiple controls by adjusting
a single knob or button.

NOTE: Although macros can be assigned to any
control in a program that can be modulated, the macros
themselves are only added to the Program node.

The default range of a macro is from zero to 100%
(unipolar). For a range of -100% to +100%, enable
Bipolar mode.

VALUE is the actual value sent when the macro is
adjusted, either directly via this knob or via the macro’s
control on the Info tab.

STYLE chooses the style of control that will appear on
the Info tab for the macro. CONTINUOUS displays a
continuously-variable knob, and ON/OFF displays a
toggle button with only two states.

Bipolar

Default -

Value
- 0.00%

To change a macro’s name, double-click the macro’s
DISPLAY NAME and enter a new name. This will change
the macro’s displayed name on the Info tab and in the
modulation assignment menu.
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MULTI ENVELOPE

The Multi Envelope is an envelope
with a user-defined shape,

consisting of any number of points.

This allows for more expressive
and unique envelopes than a
classic DAHDSR envelope, such
as sweeps that evolve over a long
period of time or looped LFO-
like shapes. The Multi Envelope
can be tempo-synced or set to
discrete time values.

Because there can be any number
of points in the Multi Envelope,
unlike the other envelope modules
in Falcon, there are no knobs or
sliders for setting the values of
each envelope phase. All editing
is done in the graphical Envelope
Editor. In addition to the Envelope
Editor’s basic usage described

in [DAHDSR > Envelope Editor],
the Envelope Editor for the

Multi Envelope has a number of
additional features:

- Shift-click or double-click: Add
point a new point

« Shift-right-click an existing point:
Remove the point

« Right-click an existing point:
Contextual menu, with options to
remove the point or set it as the
loop start/end

« Alt/Option-click-drag: Draw line to

create two new points

The Multi Envelope has two loop
options. By default, the envelope
is looped, but the loop can be
removed via the REMOVE LOOP
option in envelope editor’s
contextual menu. If you wish to
add the loop back, choose Add
Loop. The envelope release is not
looped by default, but you can
change this via the SET RELEASE
LOOPED option in the menu.

To change it back, choose SET
RELEASE NOT LOOPED.

When TEMPO SYNC is enabled
for the Multi Envelope, the GRID
option in the Envelope Editor
menu becomes available and sets

the metric division of the grid.

SPEED sets the time factor for
the envelope. At 1.0, the time is
as shown on the grid. At larger
values, the speed is multiplied
and the envelope plays back
more quickly; at smaller values,
the opposite. For an example
value of 200 ms between points,
with Speed = 1.0 the transition will
be 200 ms, Speed = 0.10 will be
2000 ms, and Speed =10 will be
20 ms. SMOOTH sets the amount

of smoothing applied to each step.

The Multi Envelope’s TRIGGER
MODE determines how the
envelope is triggered. The trigger
modes are the same as for the
LFO module; for details, see [LFO
> Trigger mode].

To choose if and how velocity

will affect the envelope, use

the VELOCITY AMOUNT and
VELOCITY SENSITIVITY controls,
as described in [DAHDSR >
Velocity Amount and Sensitivity].
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STEP ENVELOPE

The Step Envelope is a
programmable pattern sequencer.
The Step Envelope can be tempo-
synced for steps of musical
divisions, or set to discrete time
values.

The value of each step can be set by clicking and
dragging vertically. You can also click and drag
horizontally to draw a shape over multiple steps. To clear
all steps, right-click and choose RESET TO DEFAULT.
To view the step editor in finer detail, choose edit button
in the module header to open it in a large overlay view.
Press anywhere outside the overlay to dismiss it.

The number of steps in the grid is set with STEPS
control, from 1 step up to 128 steps. The FREQUENCY
control sets the duration of each step. When TEMPO
SYNC is enabled, step duration ranges from 32 bars
down to 64th-note triplet, synced to Falcon’s tempo.
When tempo sync is disabled, step durations are in Hz
(steps per second).

The default range of each step is from zero to +1
(unipolar). For a range of -1to +1, enable BIPOLAR mode,
which is useful for LFO-like patterns.

Spleenex -

Trigger Mode

Bipolar
Legato ¥
Smoath Ir'ltl,‘:'rpqlatinn Mada
0s Hold v

The Step Envelope’s INTERPOLATION MODE
determines how each step’s value transitions to the next.
With the default Hold mode, each value is held for the
duration of the step, then immediately jumps to the next
step’s value; with the alternate Spline mode, each value
transitions to the next with a continuous spline curve.

ol .
I i I-I lll SPLINE MODE OFF

SPLINE MODE ON

The Step Envelope’s TRIGGER MODE determines how
the envelope is triggered. The trigger modes are the
same as for the LFO module; for details, see [LFO >
Trigger mode].

SMOOTH sets the amount of smoothing for each step.
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SCRIPTING IN LUA

Scripting in Falcon uses UVIScript,
a domain-specific scripting
language built on top of the Lua
scripting language. Scripts in
Falcon are essentially MIDI effects
with advanced capabilities, with
access to all of Falcon’s synthesis
engine modules. Scripts can also
define their own interface, so that
you can interact with the script in
realtime.

‘ Center Pitch
60

UVIScripts are saved as text documents with a ".lua’
extension, and loaded with Falcon’s Script Processor
module. For general information on using the Script
Processor module, see [Interface > Main > Events Tab]
and [Appendix A > Event Processors].

EXAMPLE

To help demonstrate UVIScript, here’s a simple example
script for a pitch inverter (available in the Script Processor
module as a factory preset, under Utilities > Invert Pitch).

CenterPitch = Knob(“Center Pitch”, 60,
0, 127, true)
function onNote(e)
local center = CenterPitch.value
local delta = e.note-center
local note = center - delta
if note>=0 and note<=127 then
playNote(note, e.velocity)
end
end
function onRelease()

end

Invert pitch.lua

Here’s what this script looks like in Falcon’s script
Processor.

This script creates one knob, which sets the script’s
center pitch value (line 1). When a Note On event occurs
(line 3), the note’s pitch value is evaluated and modified
relative to the center pitch value (lines 4-6), and then the
note is played with its modified pitch value (lines 7-8).
For example, if the center pitch is set to C3, when a C2 is
triggered a C4 would be played instead.

FULL DOCUMENTATION

For more information on writing your own UVIScripts,
please refer to the latest online documentation at:
http://www.uvi.net/uviscript/

For more information on the underlying Lua scripting
language, see http://www.lua.org/docs.html

225


http://www.uvi.net/uviscript/
http://www.lua.org/docs.html



http://www.uvi.net/
http://www.uvi.net/downloads
http://www.uvi.net/my-products
http://www.uvi.net/faq
http://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.uvi.net/uviscript
http://www.lua.org/docs.html
http://opensoundcontrol.org
http://www.huygens-fokker.org/scala
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!support

UVI SOUNDS & SOFTWARE

UVINET


http://www.uvi.net

